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ABSTRACT OF THE DISSERTATION 

 

Preparation, Conjugation, and Stabilization of Amyloid-β Peptides 
 

by 

Sheng Zhang 

Doctor of Philosophy in Chemistry 

University of California, Irvine 

2021 

Professor James S. Nowick, Chair 

 

Chapter 1 presents the development of an efficient method for the expression and 

purification of aggregation-prone amyloid-β (Aβ) peptides, including Aβ(M1-42), 15N-labeled Aβ(M1-

42), and Aβ(M1-42) familial mutants.  

Aβ peptides are central to the pathogenesis of Alzheimer’s disease. Aβ peptides are highly 

aggregation-prone, making them challenging to prepare and purify. Advances in amyloid research 

rely on improved access to Aβ peptides. Chemical synthesis of Aβ can lead to impurities, such as 

amino acid deletion products, that are difficult to eliminate during purification. Expression of Aβ(1-

42) peptide requires the generation of fusion protein and cleavage by protease to remove the N-

terminal methionine group that originates from the translational start codon, which can make the 

preparation of Aβ costly and time-intensive.  
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In this chapter, I collaborated with fellow graduate student Stan Yoo to express Aβ(M1-42), 

a widely used form of Aβ with properties comparable to those of the native Aβ(1−42) peptide. 

Expression of Aβ(M1−42) is simple to execute and avoids the expensive and difficult enzymatic 

cleavage step associated with expression and isolation of Aβ(1−42). We then developed an efficient 

method to afford Aβ(M1-42) and 15N-labeled Aβ(M1-42) at around 19 mg per liter of bacterial culture 

with high purity using simple and inexpensive steps in three days. This method relies on the 

combination of protein biology tools such as bacterial expression and inclusion body 

solubilization, as well as peptide chemistry tools such as preparative HPLC purification of the 

solubilized inclusion bodies. This chapter also describes a simple method for the construction of 

recombinant plasmids and the preparation of Aβ peptides containing familial mutations. These 

methods may enable experiments that would otherwise be hindered by insufficient access to Aβ, 

such as NMR experiments with 15N-labeled Aβ. We anticipate that this method can be adjusted 

for the expression and purification of other amyloidogenic proteins. 

Chapter 2 presents the preparation of Aβ peptide with an N‑terminal cysteine [Aβ(C1–42)], 

the development of tailored chemical reaction conditions for the conjugation of aggregation-prone 

Aβ(C1–42) peptide with fluorophores or biotin, and the biophysical studies of labeled Aβ peptides. 

N-terminally functionalized Aβ peptides are important in amyloid and Alzheimer’s disease 

research. Site-specific labeling on the N-terminus of Aβ minimizes perturbation in the structure 

and function of the peptide, as the central and C-terminal regions of Aβ are more involved in fibril 

and oligomer formation. Although synthetic N-terminally functionalized Aβ peptides are 

commercially available, these peptides are expensive and limited to biotin and a few common 

fluorophores. Expressed Aβ peptides offer advantages over synthetic Aβ because they are free 

from amino acid deletions and epimeric contaminants, and they have been found to be more 
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biological relevant because they aggregate more quickly and are more neurotoxic than synthetic 

Aβ.  

The method of preparing Aβ(C1–42) relies on the hitherto unrecognized observation that the 

expression of the Aβ(MC1-42) gene yields the Aβ(C1–42) peptide, because the N-terminal methionine 

is endogenously excised by E. coli. This observation is significant, because it allows the 

preparation of a useful Aβ(C1–42) peptide without the additional N-terminal methionine that 

originates from the translational start codon. The Aβ(C1–42) peptide represents a minimal 

modification of native Aβ(1–42), and the addition of a single cysteine residue at the N-terminus 

enables labeling of the expressed Aβ with complete site specificity using widely available 

maleimide-based reagents. 

The Aβ peptide is challenging to handle and label because of its strong propensity to 

aggregate. This chapter details the development of tailored chemical reaction conditions for 

handling and labeling of this aggregation-prone peptide. The labeling chemistry was optimized to 

be performed at pH 9 in HPLC fractions Aβ(C1–42), where Aβ remains mostly monomeric. 

Biophysical studies show that the labeled Aβ peptides behave like unlabeled Aβ and suggest that 

labeling of the N-terminus does not substantially alter the properties of the Aβ. This chapter also 

goes on to demonstrate the utility of the labeled Aβ peptides through fluorescence microscopy to 

visualize their interactions with mammalian cells and bacteria. Ready access to labeled Aβ bearing 

fluorophores will advance amyloid and Alzheimer’s disease research by enabling experiments for 

investigating the pathogenic mechanism, transport, and clearance of Aβ, as well as for screening 

anti-Aβ antibodies. 
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Chapter 3 presents the introduction of intramolecular disulfide bonds to Aβ peptides that 

stabilizes Aβ into oligomeric state and the discovery of a disulfide-stapled peptide, AβC18C33, that 

forms homogeneous dimers and does not fibrilize.  

Aβ aggregates rapidly and exists as three different forms in equilibria: monomers, 

oligomers, and fibrils. Although Aβ fibrils are the most commonly found species in the brain tissue 

of patients with Alzheimer’s disease, soluble Aβ oligomers are the toxic contributors to 

neurodegeneration. Aβ oligomers are heterogenous and metastable: they can rapidly aggregate into 

more thermodynamically stable fibrils, which makes it challenging to isolate them and study their 

structures and biological properties. No high-resolution structures of Aβ oligomers have been 

reported thus far. Filling this gap is necessary for an enhanced understanding of the molecular 

basis of Alzheimer’s disease. 

In this chapter, we aimed to generate stable, non-covalent Aβ oligomers by introducing 

intramolecular disulfide linkages to Aβ. The intramolecular linkages were designed to enforce a 

β-hairpin conformation, the key conformation that favors Aβ oligomer formation and disfavors 

fibrilization. We have designed, prepared, and studied a variety of mutant Aβ peptides containing 

intramolecular linkages. Among these mutant peptides, we discovered AβC18C33, an Aβ peptide 

containing a disulfide bond between positions 18 and 33, that forms stable, homogeneous dimers 

and does not fibrilize, as evidenced by the results of a series of biophysical studies.  

The Aβ dimer has been proposed to be the basic building block of many larger Aβ 

oligomers and is thought to be one of the most neurotoxic and pathologically relevant species in 

Alzheimer’s disease. We thereby anticipate that the AβC18C33 peptide to serve as a stable, non-

fibrilizing, and noncovalent Aβ dimer model for the exploration of the structure and pathogenesis 

of Aβ dimers, the generation of Aβ-specific antibodies, and the screening of Aβ-targeted drugs. 
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Our laboratory is exploring ways to obtain high-resolution structures of this dimeric Aβ model 

peptide, using techniques including cryo-EM, NMR, and X-ray crystallography.   

Chapter 4 presents the structure-based design of a cyclic peptide inhibitor towards SARS-

CoV-2 using free molecular modeling and docking software and publicly available X-ray 

crystallographic structures. When the COVID-19 pandemic forced the temporary closure of our 

laboratory in March 2020, we began working on the structure-based drug design of inhibitors 

against the SARS-CoV-2 virus main protease. These efforts resulted in the design of a cyclic 

peptide inhibitor, UCI-1. Working with other group members, I published a tutorial paper based 

to describe the structure-based drug design process and teach others how to do it using the publicly 

available software UCSF Chimera and AutoDock Vina. 

SARS-CoV-2 is a highly infectious virus that causes COVID-19, a serious respiratory 

infection that has caused over 178 million infections and over 3.8 million deaths worldwide as of 

June 2021. Main protease is a crucial enzyme that SARS-CoV-2 utilizes for site-specifically 

cleaving the polyprotein that is translated from viral mRNA and generating mature proteins that 

are necessary for replication and infection. The essential role of main protease, as well as the 

success of HIV protease inhibitors in the treatment of AIDS, make main protease an attractive 

therapeutic target in the treatment of COVID-19. 

This chapter begins with the analysis of the X-ray crystallographic structure of the main 

protease of the SARS coronavirus (SARS-CoV) bound to a peptide substrate. This chapter then 

describes the structural modification of the peptide substrate using the UCSF Chimera molecular 

modeling software to create a cyclic peptide inhibitor. Finally, this chapter presents the use of 

molecular docking software AutoDock Vina to show the interaction of the cyclic peptide inhibitor 

with both SARS-CoV main protease and the highly homologous SARS-CoV-2 main protease. 
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The supporting information section of this chapter provides an illustrated step-by-step 

protocol showing the inhibitor design process. These and other molecular modeling studies helped 

our laboratory decide to pursue the synthesis of the cyclic peptide and experimentally evaluate its 

promise as an inhibitor of SARS-CoV-2 main protease. The molecular modeling studies presented 

in this chapter may help students and scientists design their own drug candidates for COVID-19 

and the coronaviruses that may cause future pandemics.
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Chapter 1a 

 

An Efficient Method for the Expression and 

Purification of Aβ(M1−42) 

 
Introduction  

 
Amyloid-β (Aβ) peptides, which include the highly neurotoxic 42-amino acid alloform 

Aβ42, are central to the pathology of Alzheimer’s disease.1−4 Ready access to experimental-scale 

quantities of pure Aβ peptides, including isotopically labeled Aβ and mutants associated with 

familial Alzheimer’s disease, is essential to progress in research in Alzheimer’s disease. Aβ 

peptides are highly aggregation-prone, making them challenging to prepare and purify. Expressing 

Aβ peptides overcomes the challenge of purification that arises as a result of chemical synthesis – 

elimination of amino acid deletion, addition, and epimerization byproducts – leading to products 

with superior fidelity and purity. Expressed Aβ peptides have also been reported to aggregate faster 

and be significantly more toxic toward neuronal cells than synthetic Aβ.5 Expression of Aβ(1-42) 

peptide requires the generation of fusion protein and cleavage by protease to remove the N-

terminal methionine group that originates from the translational start codon (Figure 1.1). This 

 
a This chapter is adapted from Yoo, S.‡, Zhang, S.‡, Kreutzer, A. G., and Nowick, J. S. Biochemistry 2018 57 (26), 
3861−3866. Stan Yoo and I co-wrote the paper and published the paper as co-first authors. Stan Yoo has also included 
this chapter in his Ph.D. dissertation. 
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approach requires expression and purification of the protease and an affinity purification step, 

which can make the preparation of Aβ(1-42) costly and time-intensive.5−7  

Walsh and co-workers expressed Aβ(1−42) as the Aβ(M1−42) variants bearing the N-terminal 

methionine residue from the start codon (Figure 1.1).8 Aβ(M1−42) is a widely used form of Aβ with 

properties comparable to those of the native Aβ(1−42) peptide. The additional N-terminal methionine 

has little impact on aggregation properties, fibril structure, and neurotoxicity. 9−16 The expression 

of Aβ(M1−42) negates the need for the expensive and time-consuming protease cleavage and affinity 

purification steps, but the expression system reported by Walsh and co-workers only affords 

Aβ(M1−42) with a yield of 1.7 mg per liter of bacterial culture.8 

 

Figure 1.1. Sequences of Aβ(1–42) and Aβ(M1–42). 
 

In this chapter, we report an efficient method for the expression and purification of 

Aβ(M1−42) peptide and associated homologues, including the uniformly 15N-labeled peptide and 

familial mutants. This method relies on the combination of protein biology tools, such as bacterial 

expression and inclusion body solubilization, and peptide chemistry tools, such as preparative 

HPLC purification of the solubilized inclusion bodies. Our method bypasses cumbersome steps in 

previously reported Aβ preparation procedures and affords pure Aβ peptides in three days at ca. 

19 mg/L of bacterial culture through simple and inexpensive steps. This chapter also reports a 

simple method for the construction of recombinant plasmids for the preparation of Aβ peptides 

containing familial mutations. 
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Results and Discussion 

Expression of Aβ(M1−42). To express Aβ(M1−42), the pET-Sac-Aβ(M1−42) plasmid is 

transformed into BL21(DE3)-pLysS competent E. coli. Expression is induced with isopropyl β-D-

1-thiogalactopyranoside (IPTG). The expressed peptide is pelleted with the inclusion bodies, 

which are washed several times and then solubilized with 8 M urea. The yield of Aβ(M1−42) depends 

on the extent of cell growth prior to IPTG induction, with an OD600 of ca. 0.45 proving optimal for 

wild-type Aβ(M1−42) production. Growth to substantially higher or lower OD600 values gives lower 

yields of peptide. 

Purification of Aβ(M1−42). At this point in the procedure, the expressed peptide is handled 

like a synthetic peptide, and preparative HPLC is used to purify it. The solution of the inclusion 

bodies in 8 M urea is filtered to prevent damaging the HPLC column. Initially, a 0.22 μm nylon 

syringe filter was used, but doing so resulted in a substantial loss of peptide. The hydrophobicity 

and propensity of Aβ to aggregate appear to make Aβ particularly prone to loss in filters. We 

screened several types of syringe filters to optimize peptide recovery, monitoring the relative 

concentrations of peptide by UV absorbance at 280 nm (Table 1.1).17 We found that a 0.22 μm 

hydrophilic filter, such as hydrophilic polyvinylidene fluoride (PVDF) or poly(ether sulfone) 

(PES), provided satisfactory peptide recovery. 
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Table 1.1. Effect of different syringe filters on Aβ(M1−42) recovery. 

 

A typical HPLC trace of unpurified Aβ(M1−42) shows three major peaks (Figure 1.2A). The 

first peak is the largest and contains mostly monomer, and the second and the third peaks appear 

to be oligomers (Figure 1.S1). For preparative HPLC, a reverse-phase silica-based C8 column is 

used as the stationary phase, and a gradient of water and acetonitrile containing 0.1% 

trifluoroacetic acid is used as the mobile phase. To enhance resolution and reduce peak tailing, it 

was necessary to heat the column. Without heating, the resolution and yield of the peptide are 

substantially lower. The Aβ(M1−42) peptide monomer generally elutes at around 34% acetonitrile 

when the C8 column is heated to 80 °C in a water bath. HPLC fractions containing pure peptide 

were combined, and the purity was confirmed by analytical HPLC (Figure 1.2B). Acetonitrile was 

removed by rotary evaporation, and the aqueous solution of pure peptide was then frozen and 

lyophilized. These procedures typically yield ca. 19 mg of Aβ(M1−42) as the trifluoroacetate salt per 

liter of bacterial culture. 

This purification procedure does not require specialized equipment or costly reagents and 

is not time-consuming. It avoids the use of specialized and costly columns, such as cation exchange 

chromatography columns and size-exclusion chromatography columns. Another advantage of this 
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procedure is that it yields lyophilized powder as the final peptide product. Working with 

lyophilized peptide is convenient for subsequent studies as it can be dissolved in any appropriate 

buffer at a desired concentration. 

The purity and composition of the Aβ(M1−42) peptide were further assessed via MALDI-MS 

and SDS-PAGE with silver staining. MALDI-MS confirms that the observed mass of Aβ(M1−42) 

matches the expected mass (Figure 1.2C). The silver-stained SDS-PAGE gel shows that at low 

concentrations, the Aβ(M1−42) peptide exists as a monomer. At higher concentrations, Aβ(M1−42) 

begins to form oligomers with molecular weights consistent with trimers and tetramers (Figure 

1.2D). 
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Figure 1.2. Purification and characterization of Aβ(M1−42). (A) Typical analytical HPLC trace of a 
filtered crude Aβ(M1−42) sample. (B) Typical analytical HPLC trace of purified Aβ(M1−42). (C) 
MALDI mass spectrum of purified Aβ(M1−42). (D) Silver-stained SDS-PAGE gel (16% 
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polyacrylamide) of increasing concentrations of Aβ(M1−42) from 0.5 to 125 μM. A 12 μL aliquot 
was loaded in each lane of the gel. 

Sample Preparation for Biophysical and Biological Studies. The propensity of Aβ to 

aggregate necessitates the preparation of monomeric Aβ for subsequent studies.18 Without any 

sample preparation, studies are reported to be irreproducible.19 Fezoui and co-workers reported 

that treatment of Aβ with NaOH disrupts aggregates and generates Aβ that is monomeric or nearly 

monomeric.20 This NaOH-treated Aβ is widely used in subsequent aggregation studies.18 We 

applied this procedure to each batch of expressed Aβ to generate aliquots for further studies. Thus, 

the lyophilized powder was dissolved in 2 mM NaOH, and the pH was adjusted, if necessary, by 

addition of 0.1 M NaOH, to give a pH 10.5 solution. The solution was sonicated for 1 min; the 

concentration was determined by UV absorbance at 280 nm, and the yield of Aβ(M1−42) was 

calculated. The solution was then aliquoted in 0.0055 or 0.020 μmol portions into small tubes, and 

these samples were frozen and lyophilized. The lyophilized aliquots were stored in a desiccator at 

−20 °C. 

Expression of 15N-Labeled Aβ(M1−42). 15N-labeled Aβ peptides are useful tools for NMR 

structural studies and for studying binding profiles of Aβ. For expression of 15N-labeled Aβ(M1−42), 

E. coli cells are grown to an OD600 of ca. 0.45 in LB medium, and then the LB medium is 

exchanged with M9 minimal medium containing 15NH4Cl. Expression is induced in the 15N-

enriched M9 medium for 16 h with IPTG. Purification and sample preparation of 15N-labeled 

Aβ(M1−42) are identical to those of unlabeled Aβ(M1−42). The composition of 15N-labeled Aβ(M1−42) 

was assessed by MALDI-MS (Figure 1.3A). A 1H−15N HSQC NMR spectrum of 160 μM 15N-

labeled Aβ(M1−42) in 50 mM potassium phosphate buffer in 10% D2O was recorded at 5 °C with a 

500 MHz NMR spectrometer equipped with a cryogenic probe (Figure 1.3B). This spectrum 

matches the NMR spectrum reported by Macao and co-workers.9 The yield of the 15N-labeled 
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Aβ(M1−42) peptide is comparable to that of the unlabeled Aβ(M1−42) peptide, at ca. 19 mg/L of 

bacterial culture. Access to such amounts of the 15N-labeled peptide at low cost enables the 

performance of SAR by NMR experiments.21 

 

Figure 1.3. MALDI mass spectra and NMR spectra of unlabeled and 15N-labeled Aβ(M1−42). (A) 
MALDI spectra of unlabeled Aβ(M1−42) and 15N-labeled Aβ(M1−42) peptides. (B) 1H−15N HSQC 
NMR spectrum of 160 μM 15N-labeled Aβ(M1−42) peptide at 5 °C at 500 MHz equipped with a 
cryogenic probe. 
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Figure 1.4. Molecular cloning strategy for constructing recombinant plasmids of Aβ(M1−42) 
containing familial mutations. 
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Figure 1.5. MALDI mass spectra and typical yields of Aβ peptides. (A) MALDI mass spectra of Aβ(M1−42) 
peptides with A21G, E22G, E22K, and D23N mutations. (B) Typical yields of Aβ(M1−42), 15N-labeled 
Aβ(M1−42), and mutant Aβ(M1−42) peptides. 

 

Construction of Recombinant Plasmids for Expression of Mutant Aβ(M1−42) Peptides. 

To express Aβ(M1−42) peptides containing familial mutations, we construct recombinant plasmids 

by ligating enzymatically digested pETSac-Aβ(M1−42) and DNA sequences that encode Aβ(M1−42) 
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mutants (Figure 1.4). In this procedure, pET-Sac-Aβ(M1−42) is first digested with NdeI and SacI 

restriction enzymes to remove the wild-type Aβ(M1−42) sequence. Next, the digested pET-Sac vector 

is treated with shrimp alkaline phosphatase (rSAP) to remove the terminal phosphate groups. The 

digested vector is isolated by agarose gel electrophoresis purification using a commercially 

available kit. Synthetic DNA encoding each mutant Aβ(M1−42) is purchased and then digested with 

NdeI and SacI to generate the inset. The vector and insert are ligated using T4 ligase and then 

transformed into TOP 10 competent E. coli. E. coli cells transformed with ligated plasmid form 

colonies on agar containing carbenicillin. Plasmids are isolated from colonies, and the sequences 

are verified by DNA sequencing. In this section, we constructed five plasmids with familial 

mutations: A21G, E22G, E22K, E22Q, and D23N. This cloning strategy is inexpensive and is 

simpler to execute than site-directed mutagenesis. The entire cloning procedure takes 2 days, and 

many mutants can be generated concurrently. Another advantage of this strategy is that Aβ(M1−42) 

plasmids containing multiple point mutations can be prepared as easily as plasmids containing 

single point mutations. 

The purification and preparation of Aβ(M1−42) containing familial mutations are identical to 

those of Aβ(M1−42). The composition of familial mutant Aβ(M1−42) peptides was assessed using 

MALDI-MS (Figure 1.5A). The expression levels and yields of the Aβ(M1−42) familial mutants 

varied because of different aggregation propensities of the peptides. Analytical HPLC traces of 

crude samples of the A21G and E22Q mutants showed smaller first peaks and larger second and 

third peaks, suggesting that more oligomers are formed after the inclusion bodies are dissolved. 

Figure 1.5B shows typical yields of the peptides. Our expression and purification procedures 

proved to be unsuitable for the E22Q mutant, which showed very little monomer in the HPLC 

trace. 
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Conclusion 

The procedures described in this chapter provide an efficient method for the expression 

and purification of Aβ(M1−42), 15N-labeled Aβ(M1−42), and Aβ(M1−42) containing several familial 

mutations. Our method employs the most convenient features of protein expression and peptide 

purification to provide ready access to good quantities of the pure peptides. We anticipate that our 

method will provide new opportunities for pilot experiments that require large amounts of Aβ. We 

also  anticipate that this method can be adjusted for the expression and purification of other 

amyloidogenic proteins. 
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Methods  

Isolation of pET-Sac-Aβ(M1−42) plasmid  

We received the pET-Sac-Aβ(M1−42) plasmid from Addgene as a bacterial stab and 

immediately streaked the bacteria onto a LB agar-plate containing carbenicillin (50 mg/L). 

Colonies grew in < 24h. Single colonies were picked and used to inoculate 5 mL of LB broth 

containing carbenicillin (50 mg/L). The cultures were shaken at 225 rpm overnight at 37˚C. To 

isolate the pET-Sac-Aβ(M1−42) plasmids, minipreps were performed using a Zymo ZR plasmid 

miniprep kit. The concentration of the plasmids was measured using a Thermo Scientific Nanodrop 

instrument.  

 

Bacterial expression of Aβ(M1−42) 

Transformation and expression of Aβ(M1−42)  

All liquid cultures were performed in culture media (LB broth containing 50 mg/L 

carbenicillin and 34 mg/L chloramphenicol). For Aβ(M1−42) wild-type and mutant peptides: Wild-

type or mutant plasmids were transformed into BL21 DE3 PLysS Star Ca2+-competent E. coli 

through heat shock method. The cell cultures were spread on LB agar plates containing 

carbenicillin (50 mg/L) and chloramphenicol (34 mg/L). Single colonies were picked to inoculate 

5 mL of culture media for overnight culture. (A glycerol stock of BL21 DE3 PLysS Star Ca2+-

competent E. coli bearing the plasmids was made, and the future expressions were started by 

inoculating culture media with an aliquot of the glycerol stock). The next day, all 5 mL of the 

overnight culture were used to inoculate 1 L of culture media. After inoculation, the culture was 

shaken at 225 rpm at 37 ˚C until the cell density reached an OD600 of approximately 0.45 (after 
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around 3 h 45 min). Protein expression was then induced by the addition of isopropyl β-D-1-

thiogalactopyranoside (IPTG) to a final concentration of 0.1 mM, and the cells were shaken at 225 

rpm at 37 °C for 4 h with IPTG.  The cells were then harvested by centrifugation (4000 rpm, 4 ˚C, 

25 min), and the cell pellets were stored at -80°C.  

For 15N-labeled Aβ(M1−42): Wild-type plasmids were transformed into BL21 DE3 PLysS 

Star Ca2+-competent E. coli through heat shock method. The cell cultures were spread on LB agar 

plates containing carbenicillin (50 mg/L) and chloramphenicol (34 mg/L). Single colonies were 

picked to inoculate 5 mL of culture media for overnight culture. [A glycerol stock of BL21 DE3 

PLysS Star Ca2+-competent E. coli bearing the plasmids was made, and the subsequent expressions 

were started by inoculating culture media with an aliquot of the glycerol stock.] The next day, all 

5 mL of the overnight culture were used to inoculate 1 L of culture media. After inoculation, the 

culture was shaken at 225 rpm at 37 ˚C until the cell density reached an OD600 of approximately 

0.45–0.50 (after around 3 h 50 min). The cells were harvested by centrifugation in sterile 500-mL 

thick-walled centrifuge bottles (4000 rpm, 4 ˚C, 25 min). The cell pellets were then resuspended 

in sterile M9 minimal media supplemented with 15NH4Cl, carbenicillin (50 mg/L), and 

chloramphenicol (34 mg/L) (Table 1.S1), and incubated for 1 h at 225 rpm at 37 °C. Protein 

expression was then induced by the addition of isopropyl β-D-1-thiogalactopyranoside (IPTG) to 

a final concentration of 0.1 mM, and the cells were shaken at 225 rpm at 25 °C for ~20 h with 

IPTG.  The cells were then harvested by centrifugation (4000 rpm, 4 ˚C, 25 min), and the cell 

pellets were stored at -80°C.  

Table 1.S1. M9 minimal media. 

Reagents Amount 
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Cell lysis and inclusion body preparation  

To lyse the cells, the cell pellet was resuspended in 20 mL of buffer A (10 mM Tris/HCl, 

1 mM EDTA, pH 8.0) and sonicated for 2 min on ice (50% duty cycle) until the lysate appeared 

homogenous. The lysate was then centrifuged for 25 min at 16,000 rpm at 4˚C. The supernatant 

was removed, and the pellet was resuspended in buffer A, sonicated and centrifuged as described 

above. The sonication and centrifugation steps were repeated three times. After the fourth 

supernatant was removed, the remaining pellet was resuspended in 15 mL of freshly prepared 

buffer B (8 M urea, 10 mM Tris/HCl, 1 mM EDTA, pH 8.0), and was sonicated as described above, 

until the solution became clear.  

 

Peptide purification 

The solution (15 mL) was then diluted with 10 mL of buffer A and filtered through a Fisher 

Brand 0.22 µm non-sterile hydrophilic PVDF syringe filter (Catalog No. 09-719-00). 

5X M9 salts solution  
(34.0 g of Na2HPO4, 15.0 g of KH2PO4, 
and 2.5 g of NaCl in 1.0 L of H2O) 

200.0 mL 

1.0 M MgSO4ꞏ7H2O solution 2.0 mL 

1.0 M CaCl2 solution 0.1 mL 

15NH4Cl 1.0 g 

D-Glucose 10.0 g 

Carbenicillin (50 mg/mL) 1 mL 

Chloramphenicol (34 mg/mL in EtOH) 1 mL 

H2O Fill up to 1.0 L 
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Analytical reverse-phase HPLC was performed to evaluate if expression of Aβ(M1−42) was 

successful. A 40-µL sample of the above solution was injected onto an Agilent 1200 instrument 

equipped with a Phenomonex Aeris PEPTIDE 2.6u XB-C18 column with a Phenomonex 

SecurityGuard ULTRA cartridges guard column for C18 column. HPLC grade acetonitrile (ACN) 

and 18 MΩ deionized water, each containing 0.1% trifluoroacetic acid, were used as the mobile 

phase. The sample was eluted at 1.0 mL/min with a 5–100% acetonitrile gradient over 20 min, at 

35 °C or 60 °C. Figure S1 shows an example HPLC trace of the crude Aβ(M1−42) solution. 
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Figure 1.S1. HPLC trace of filtered urea-solubilized Aβ(M1−42) and silver-stained SDS-PAGE gel of 
HPLC fractions. HL: Precision Plus Protein Dual Color Standards from Bio-Rad; LL: Spectra Multicolor 
Low Range Protein Ladder from ThermoFisher.  

 

Unpurified 
Aβ(M1–42) 

Ladders 
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Aβ(M1−42) peptides were then purified by preparative reverse-phase HPLC equipped with 

an Agilent ZORBAX 300SB-C8 semi-preparative column (9.4 x 250 mm) with a ZORBAX 

300SB-C3 preparative guard column (9.4 x 15 mm). The C8 column and the guard column were 

heated to 80 °C in a water bath. HPLC grade acetonitrile (ACN) and 18 MΩ deionized water, each 

containing 0.1% trifluoroacetic acid, were used as the mobile phase at a flow-rate of 5 mL/min. 

The peptide solution was split into three ~8 mL aliquots, and purified in three separate runs. The 

peptide was loaded onto the column by flowing 20% ACN for 10 min and then eluted with a 

gradient of 20–40% ACN over 20 min. Fractions containing the monomer generally eluted from 

34% to 38% ACN. After the peptide was collected, the column was washed by injecting 5 mL of 

filtered buffer B (8 M urea, 10 mM Tris/HCl, 1 mM EDTA, pH 8.0) while flushing at 95% ACN 

for 15 minutes. This cleaning procedure ensures elution of all peptide that is retained in the column 

and avoids problems of cross-contamination between runs.  

The purity of each fraction was assessed using analytical reverse-phase HPLC. A 40-µL 

sample was injected onto the analytical HPLC. The sample was eluted at 1.0 mL/min with a 5–

100% acetonitrile gradient over 20 min, at 35 °C or 60 °C. Pure fractions were combined and the 

purity of the combined fractions were checked using analytical HPLC. The combined fractions 

were concentrated by rotary evaporation to remove ACN, and then frozen with dry ice, liquid 

nitrogen, or a -80 °C freezer. [It is recommended to combine and freeze the purified fractions 

within 5 hours after purification to avoid oxidation of methionine.] The frozen sample was then 

lyophilized to give a fine white powder.  
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NaOH treatment and peptide concentration determination 

The lyophilized peptide was then dissolved in 2 mM NaOH to achieve a concentration of 

~0.5 mg/mL. The pH was adjusted (if necessary) by addition of 0.1 M NaOH to give a solution of 

pH ~10.5. The sample was sonicated in a water ultrasonic bath at room temperature for 1 min or 

until the solution became clear. When preparing samples, pH should not be near pH 5.5 where the 

peptide is prone to aggregate, and solution become opaque, giving inaccurate UV readings. pH 

should not be over 11, where tyrosine is mostly deprotonated, giving slightly different UV spectra 

(Figure 1.S2). 

The concentration of Aβ(M1−42) was determined by absorbance at 280 nm using the 

extinction coefficient (ε) for tyrosine of 1490 M−1cm−1 (c = A/1490). The Aβ(M1−42) solution was 

then aliquoted into 0.0055 µmol or 0.020 µmol aliquots in 0.5 mL microcentrifuge tubes. The 15N-

labeled Aβ(M1−42) solution was aliquoted into appropriate volume that contains 0.5 mg in 1.6 mL 

Eppendorf tubes. The aliquots were lyophilized and then stored in a desiccator at -20 °C for future 

use. 
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Figure 1.S2. UV absorption spectra of Aβ(M1−42) at different pH. 

Table 1.S2 shows a representative schedule for expression of Aβ(M1−42). Table 1.S3 shows 

a representative schedule for expression of 15N-labeled Aβ(M1−42). 

Table 1.S2. A representative schedule for expression of Aβ(M1−42). 
Day Time Steps 

Monday Evening Starter culture 

Tuesday 

Morning Daytime culture 

Afternoon IPTG Induced expression  

Evening Cell pelleting 

Wednesday 

Morning Sonication; urea extraction 

Afternoon 
Purification by prep-HPLC 

Collecting pure fractions, freeze, and lyophilize 

Thursday Afternoon NaOH treatment, freeze, and lyophilize 

 
Table 1.S3. A representative schedule for expression of 15N-labeled Aβ(M1−42). 

Day Time Steps 

Monday Evening Starter culture 

Tuesday 

Morning Daytime culture 

Afternoon Media exchange to 
15

N-containing M9 media 

Evening IPTG induction and incubation in 25 ˚C 

Wednesday 

Morning Cell pelleting 

Morning Sonication; urea extraction 

Afternoon 
Purification by prep-HPLC; collecting pure 
fractions, freeze, and lyophilize 
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 Thursday Morning  NaOH treatment, freeze, and lyophilize 

 

Mass spectrometry  

MALDI mass spectrometry was performed using an AB SCIEX TOF/TOF 5800 System. 

0.5 µL of 2,5-dihydroxybenzoic acid (DHB) was dispensed onto a MALDI sample support, 

followed by the addition of 0.5 µL peptide sample. The mixture was allowed to air-dry. All 

analyses were performed in positive reflector mode, collecting data with a molecular weight range 

of 2000–8000 Da. 

 

SDS-PAGE 

SDS-PAGE and silver staining were adapted from and in some cases taken verbatim from 

our previously reported procedure.2 For the sample preparation, a 0.0055 μmol aliquot of Aβ 

peptide was dissolved in 11 μL of 20 mM HEPES buffer (pH 7.4) to give a 500 µM peptide stock 

solution, and serial diluted with 11 uL of 20 mM HEPES buffer (pH 7.4) to create 11 µL of peptide 

stock solutions with concentrations of 250 µM to 1.0 µM. The peptide stock solutions were then 

immediately diluted with 11 μL of 2X SDS-PAGE loading buffer (100 mM Tris buffer at pH 6.8, 

20% (v/v) glycerol, and 4% w/v SDS) to give 11 µL of peptide working solutions with 

concentrations from 125 µM to 0.5 µM. A 12.0-μL aliquot of each working solution was run on a 

16% polyacrylamide gel with a 4% stacking polyacrylamide gel. The gels were run at a constant 

90 volts at room temperature. 

Staining with silver nitrate was used to visualize peptides in the SDS-PAGE gel. Briefly, 

the gel was first rocked in fixing solution (50% (v/v) methanol and 5% (v/v) acetic acid in 
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deionized water) for 20 min. Next, the fixing solution was discarded and the gel was rocked in 

50% (v/v) aqueous methanol for 10 min. Next, the 50% methanol was discarded and the gel was 

rocked in deionized water for 10 min. Next, the water was discarded and the gel was rocked in 

0.02% (w/v) sodium thiosulfate in deionized water for 1 min. The sodium thiosulfate was 

discarded and the gel was rinsed twice with deionized water for 1 min (2X). After the last rinse, 

the gel was submerged in chilled 0.1% (w/v) silver nitrate in deionized water and rocked at 4 °C 

for 20 min. Next, the silver nitrate solution was discarded and the gel was rinsed with deionized 

water for 1 min (2X). To develop the gel, the gel was incubated in developing solution (2% (w/v) 

sodium carbonate, 0.04% (w/v) formaldehyde until the desired intensity of staining was reached 

(~1–3 min). When the desired intensity of staining was reached, the development was stopped by 

discarding the developing solution and submerging the gel in 5% aqueous acetic acid. 

 

NMR spectroscopy 

Approximately 0.5 mg of NaOH-treated, lyophilized 15N-labeled Aβ(M1−42) was dissolved 

in 0.6 mL of 50 mM potassium phosphate buffer containing the internal standard, 4,4-dimethyl-4-

silapentane-1-ammonium trifluoroacetate (DSA) at a concentration of 30 µM and 10% D2O (pH 

7.4) to give a 160 μM peptide solution. The exact concentration of the peptide solution was 

determined by absorbance at 280 nm using the extinction coefficient for tyrosine of 1490 M−1cm−1. 

The NMR sample was prepared immediately prior to the NMR experiment. NMR was performed 

using a Bruker DRX500 500 MHz spectrometer equipped with a cryogenic probe. The temperature 

was maintained at 5 °C to reduce peptide aggregation. NMR data were processed using 

XWinNMR. 1H-15N heteronuclear single quantum correlation (HSQC) spectra were acquired 



28 
 

using GARP decoupling. The number of points acquired in the direct dimension (1H) was 2048, 

and the number of increments in the indirect dimension (15N) was 256 experiments.  

 

Molecular cloning  

DNA sequences for Aβ(M1−42) familial mutant  

DNA sequences for Aβ(M1−42) familial mutant peptides were ordered from Genewiz. Figure 1.S3 

shows the design of the DNA sequences for Aβ(M1−42) mutants. 

__ 3’ and 5’ overhangs  __ Nde1 restriction site/start codon  __ stop codons 

__  Sac1 restriction site  __ familial mutation 

>Aβ(M1−42) 

GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GCT GAA GAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

>Aβ(M1–42/A21G) 

GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GGT GAA GAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

>Aβ(M1–42/E22G) 

GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GCT GGT GAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

>Aβ(M1–42/E22K) 
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GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GCT AAG GAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

>Aβ(M1–42/E22Q) 

GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GCT CAG GAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

>Aβ(M1–42/D23N) 

GATATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT CAC 
CAC CAG AAG CTG GTG TTC TTC GCT GAA AAC GTG GGT TCT AAC AAG GGT GCT 
ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAGCTC 
GATCCG 

 

Figure 1.S3. Design of the DNA sequences for Aβ(M1−42) mutants. 

Restriction enzyme digestion of pET-Sac-Aβ(M1−42) and Aβ(M1−42) familial mutant DNA sequences 

The pET-Sac-Aβ(M1−42) plasmid was digested using Sac1 and Nde1 restriction enzymes. 

Table 1.S4 details the restriction reaction conditions. Reagents were added in the order they are 

listed. 

 

Table 1.S4. Double-digestion of the pET- Sac Aβ(M1−42) plasmid. 

Reagents Amount  

pET-Sac Aβ(M1−42) 
20 µL of 50 ng/uL plasmid 

solution (1.0 µg in total)  

10X CutSmart buffer 5.0 µL 
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H2O 23.0 µL 

Nde1 restriction enzyme 1.0 µL (1 U) 

Sac1-HF restriction enzyme 1.0 µL (1 U) 

Total 50.0 µL 

Time 1.0 h 

Temperature 37.0 °C 

 

Next, to prevent backbone self-ligation, the digested plasmid was treated with shrimp 

alkaline phosphatase (rSAP). Table 1.S5 details the rSAP reaction conditions.  

Table 1.S5. SAP treatment of the vectors. 

Reagents Amount  

Double-digestion mixture 50.0 µL 

rSAP 1.0 µL (1U) 

Total 51.0 µL 

Time 0.5 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 

 

After the rSAP reaction and heat inactivation were complete, the reaction mixture was 

mixed with DNA loading buffer and loaded onto a 1% agarose gel containing ethidium bromide 

(5 µL per 100 mL gel). The agarose gel was run at 100 V for ~30 min. A UV box was used to 

visualize the digested pET-Sac vector (~4500 bp), which was excised from the gel using a razor 

blade. The digested pET-Sac vector was purified from the agarose gel using a Zymoclean Gel 

DNA Recovery Kit. The concentration of the vector after purification was measured using a 
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Thermo Scientific Nanodrop instrument. The purified digested pET-Sac linear vector was used in 

the subsequent ligation step. 

The Aβ(M1−42) mutant DNA sequences were digested using Sac1 and Nde1 restriction 

enzymes. Table 1.S6 details the restriction reaction conditions. Reagents were added in the order 

they are listed. 

 

Table 1.S6. Double-digestion of the inserts. 

Reagents Amount  

DNA sequence encoding mutation 
20 µL of 5 ng/µL DNA 

solution (100.0 ng in total) 

10X CutSmart buffer 2.5 µL 

H2O 1.5 µL 

Nde1 restriction enzyme 0.5 µL (0.5 U) 

Sac1-HF restriction enzyme 0.5 µL (0.5 U) 

Total 25.0 µL 

Time 1 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 

 

T4 ligation of the Aβ(M1−42) mutant DNA sequences and the linear digested pET-Sac vector 

The inserts and the vectors were ligated together using T4 ligase. Table 1.S7 details the T4 

ligation reaction conditions. Reagents were added in the order they are listed. 

Table 1.S7. T4 ligation of the inserts and the vectors. 

Reagents Amount 
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Insert:Vector = 0:1  
(molar ratio)  

(negative control) 

Insert:Vector = 5:1  
(molar ratio) 

Vector 
6.2 µL of 9.7 ng/µL DNA 
solution (60.0 ng in total) 

6.2 µL of 9.7 ng/µL DNA 
solution (60.0 ng in total) 

Insert --- 
2.5 µL of 4.0 ng/µL DNA 
solution (10.0 ng in total) 

10X T4 DNA 
ligase reaction 
buffer 

2.0 µL 2.0 µL 

T4 DNA ligase 1.0 µL 1.0 µL 

H2O 10.8 µL  8.3 µL 

Total 20.0 µL 20.0 µL 

Time 10 min 

Temperature 22.0 °C (room temperature) 

Heat inactivation 65.0 °C for 10 min 

 

2 µL of the ligation reaction mixture was then transformed into TOP10 Ca2+-competent E. 

coli using the heat shock method. The cell cultures were spread on LB agar plates containing 

carbenicillin (50 mg/L). Single colonies were picked to inoculate 5 mL of overnight cultures in 

LB media with carbenicillin (50 mg/L). The plasmids were extracted from TOP10 cells using 

Zymo ZR plasmid miniprep kit. The concentration of the plasmids was measured through Thermo 

Scientific NanoDrop spectrophotometer. The sequences of the Aβ(M1−42) mutants were verified by 

DNA sequencing. 
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Characterization Data 

Analytical HPLC trace of Aβ(M1−42). % Purity: >99%

 

MALDI-MS trace of of Aβ(M1−42).  

Positive reflector mode; Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass calculated for M+: 4642.3; Exact mass calculated for [M+H]+: 4643.3; Exact mass 
calculated for [M+2H]2+: 2322.2. Observed [M+H]+: 4642.8; Observed [M+2H]2+: 2322.0.  
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Figure 1.S4. Analytical HPLC and MALDI-MS traces of Aβ(M1−42). 

 

Analytical HPLC trace of 15N-labeled Aβ(M1−42). % Purity: >99% 
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MALDI-MS trace of 15N-labeled Aβ(M1−42).  

Positive reflector mode. Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass calculated for M+: 4698.3; Exact mass calculated for [M+H]+: 4699.3; Exact mass 
calculated for [M+2H]2+: 2350.2. Observed [M+H]+: 4697.6; Observed [M+2H]2+: 2349.4.  
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Figure 1.S5. Analytical HPLC and MALDI-MS traces of 15N-labeled Aβ(M1−42). 
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Analytical HPLC trace of Aβ(M1–42/A21G). % purity: >99% 

 

MALDI-MS trace of Aβ(M1–42/A21G).  

Positive reflector mode. Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass calculated for M+: 4628.3; Exact mass calculated for [M+H]+: 4629.3. Observed 
[M+H]+: 4629.1.  
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Figure 1.S6. Analytical HPLC and MALDI-MS traces of Aβ(M1–42/A21G). 
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Analytical HPLC trace of Aβ(M1–42/E22G). % purity: >99% 

 

MALDI-MS trace of Aβ(M1–42/E22G).  

Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass for M+: 4570.3; Exact mass calculated for [M+H]+: 4571.3; Exact mass calculated 
for [M+2H]2+: 2286.2. 

Observed [M+H]+: 4570.6; Observed [M+2H]2+: 2285.9. 
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Figure 1.S7. Analytical HPLC and MALDI-MS traces of Aβ(M1–42/E22G). 
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Analytical HPLC trace of Aβ(M1–42/E22K). % purity: >99% 

 

 

MALDI-MS trace of Aβ(M1–42/E22K).  

Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass for M+: 4641.3; Exact mass calculated for [M+H]+: 4642.3; Exact mass calculated 
for [M+2H]2+: 2321.7. 

Observed [M+H]+: 4642.0; Observed [M+2H]2+: 2321.5. 
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Figure 1.S8. Analytical HPLC and MALDI-MS traces of Aβ(M1–42/E22K). 

 

Analytical HPLC trace of Aβ(M1–42/D23N). % purity: >95% 
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MALDI-MS trace of Aβ(M1–42/D23N).  

Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid.  

Exact mass for M+: 4641.3; Exact mass calculated for [M+H]+: 4642.3; Exact mass calculated 
for [M+2H]2+: 2321.7. 

Observed [M+H]+: 4641.9; Observed [M+2H]2+: 2321.5. 
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Figure 1.S9. Analytical HPLC and MALDI-MS traces of Aβ(M1–42/D23N) 
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Chapter 2a 

 

Expression of N-Terminal Cysteine Aβ42 and 

Conjugation to Generate Fluorescent and 

Biotinylated Aβ42 

 
Introduction  
 

Peptides and proteins bearing an N-terminal cysteine residue are valuable tools in chemical biology 

research, because the unique reactivity of N-terminal cysteine permits native chemical ligation, 

conjugation, and other site-specific modifications.1–4 Amyloid-β (Aβ) peptides bearing an N-

terminal cysteine offer promise in Alzheimer’s disease research through N-terminal labeling with 

fluorophores or biotin, as well as other N-terminal modifications. N-terminally labeled Aβ peptides 

have been widely used to investigate cellular phagocytosis, transport, and clearance of Aβ through 

optical fluorescence microscopy, and to screen anti-Aβ antibodies through enzyme-linked 

immunosorbent assays (ELISA).5–29 Site-specific labeling on the N-terminus of Aβ minimizes 

perturbation in the structure and function of the peptide, as the central and the C-terminal regions 

of Aβ are more involved in fibril and oligomer formation.16,27,30 Although some N-terminally 

 
a This chapter is adapted from Zhang, S.; Guaglianone, G.; Morris, M. A.; Yoo, S.; Howitz, W. J.; Xing, L.; Zheng, 
J.; Jusuf, H.; Huizar, G.; Lin, J.; Kreutzer, A. G.; Nowick, J. S. Biochemistry 2021, 60, 1191−1200. 
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labeled derivatives of Aβ are commercially available, they are expensive (ca. $1000/mg) and 

limited to biotin and a few common fluorophores. Ready access to good quantities of pure N-

terminally labeled Aβ can advance Alzheimer’s disease research by enabling experiments that 

would otherwise be hindered by insufficient access to these peptides. 

Here we describe an efficient method for recombinant expression and purification of the 

Aβ peptide with an N-terminal cysteine, Aβ(C1–42), and the preparation of labeled Aβ(C1–42) peptides. 

Expressed Aβ peptides are superior to chemically synthesized Aβ, because they are free from the 

amino acid deletions or epimers that form through amino acid racemization during each coupling 

step.31,32 Expressed Aβ peptides have been found to aggregate more quickly and be more toxic 

than synthetic Aβ, and thus are widely used in amyloid research.33-35 Although Aβ peptides bearing 

fluorescent and biotin labels can be prepared by chemical synthesis, the expressed Aβ peptide 

bioconjugates should also be preferable to those derived from synthetic Aβ.  

Chapter 1 reported an efficient method for expression and purification of N-terminal 

methionine Aβ, Aβ(M1−42).36 In chapter 2, we set out to adapt this method to include a cysteine 

residue for further functionalization by attempting to express Aβ(MC1-42). When we expressed an 

Aβ(MC1-42) plasmid in E. coli, we were surprised to find that the N-terminal methionine is 

endogenously excised by the E. coli methionyl aminopeptidase (MAP), leaving cysteine on the N-

terminus and affording Aβ(C1–42) (Figure 2.1).37–39 This hitherto unrecognized observation provides 

a method of preparing the Aβ(C1–42) peptide, without the additional methionine group that originates 

from the translational start codon.30,40 The absence of methionine is significant, because Aβ(C1–42) 

represents the minimal modification of native Aβ(1–42)
 that permits further functionalization 

through robust cysteine-maleimide conjugation. Our method to prepare Aβ(C1–42) is straightforward 

and does not require any additional treatment with enzymes or reagents after the initial expression 
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and reverse-phase preparative HPLC purification. This expression method affords ca. 14 mg of 

Aβ(C1–42) with > 97% purity from one liter of bacterial culture. 

 

Figure 2.1. Sequences of Aβ(1–42), Aβ(MC1–42), and Aβ(C1–42). 
 

The Aβ(C1–42) can be further functionalized to create a variety of derivatives using thiol-

maleimide chemistry and readily available maleimide-based labeling reagents.41 We have 

developed an optimized labeling protocol to allow Aβ(C1–42) to be labeled with fluorophores or 

biotin in 15 minutes without Aβ oligomer or fibril formation, and we demonstrate this protocol 

through the preparation of Aβ(C1–42) labeled with fluorophores (TAMRA and FAM) and biotin. 

Only two equivalents of the labeling reagents are required to achieve complete labeling, which 

minimizes the cost of the maleimide reagents. This labeling protocol affords ca. 3 mg of labeled 

Aβ from one liter of bacterial culture with minimal cost for reagents. HPLC analysis indicates the 

labeled peptides to be 94–97% pure. We also demonstrate that these labeled Aβ peptides behave 

similarly to unlabeled Aβ(M1−42) in aggregation and fibrillization assays, which indicates that the 

labeling of the N-terminus of Aβ does not substantially alter the properties of the Aβ. We further 

demonstrate the application of the fluorophore-labeled Aβ(C1–42) by using fluorescence microscopy 

to visualize its interactions with mammalian cells and bacteria.  

These methods represent a novel and valuable contribution to the Aβ toolbox, because they 

exploit a hitherto unrecognized cleavage of methionine in expressed Aβ42, provide tailored 

conjugation conditions to enable rapid labeling of this highly aggregation-prone peptide, and allow 

choice of wide variety of fluorophores and other labels. We anticipate that these methods will 
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provide researchers with convenient access to useful Aβ peptides bearing N-terminal labels or a 

free N-terminal cysteine residue.   

 

Results and Discussion 

We expressed Aβ(C1–42) in E. coli using a plasmid for Aβ(MC1–42) that we constructed and have 

subsequently made available through Addgene.42 The expressed peptide forms inclusion bodies 

that are isolated by multiple rounds of washing. The inclusion bodies are then solubilized in urea 

buffer, and the solubilized Aβ(C1–42) is purified by reverse-phase HPLC. The pure HPLC fractions 

of Aβ(C1–42) are combined, and the conjugation reactions are performed directly in the combined 

pure fractions at alkaline pH. The conjugated peptides are purified by another round of HPLC 

purification. The pure HPLC fractions are then combined and lyophilized. The yields of the labeled 

peptides are assessed gravimetrically, and the composition and purity of the peptides are assessed 

by analytical HPLC and matrix-assisted laser desorption ionization mass spectrometry (MALDI-

MS). For subsequent biophysical and biological studies, the purified peptide is rendered 

monomeric by treatment with hexafluoroisopropanol (HFIP). Biophysical experiments show that 

the labeled Aβ(C1–42) behaves similarly to unlabeled Aβ(M1−42), and fluorescence microscopy studies 

with mammalian cells and bacteria further demonstrate applications of the labeled Aβ(C1–42). 

 

Expression and Purification of Aβ(C1−42). We prepared a pET-Sac plasmid encoding 

Aβ(MC1−42) in the same fashion as we had previously described,36 and we deposited the plasmid 

with Addgene to make it available to others.42 We also provide procedures to prepare the plasmid 

in the Supporting Information (Figure 2.S1). To express Aβ(C1−42), we transform the pET-Sac-

Aβ(MC1−42) plasmid into BL21(DE3)-pLysS competent E. coli and induce expression with 
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isopropyl β-D-1-thiogalactopyranoside (IPTG) when the cultured E. coli reach an optical density 

(OD600) of 0.45. After expression, we lyse the cells, wash the inclusion bodies containing Aβ(C1−42) 

with Tris buffer, and then solubilize the inclusion bodies with 8 M urea. We then filter the solution 

through a 0.22 μm hydrophilic polyethersulfone (PES) syringe filter or a 0.22 μm hydrophilic 

polyvinylidene fluoride (PVDF) filter (to prevent damaging the HPLC columns) and purify the 

Aβ(C1−42) by preparative reverse-phase HPLC using a C8 column at 80 °C with water and 

acetonitrile containing 0.1% trifluoroacetic acid (TFA). A typical analytical HPLC trace of the 

filtered lysate shows four major peaks, with the first peak corresponding to the Aβ(C1–42) monomer 

(Figure 2.S2). The Aβ(C1−42) monomer elutes at ca. 34% acetonitrile during the preparative HPLC 

purification. We then combine the HPLC fractions containing pure Aβ(C1–42) monomer, and the 

combined pure fractions typically show >97% purity, as assessed by analytical HPLC (Figure 2.2A 

and Figure 2.S7). We measure the concentration of Aβ(C1–42) in the combined the HPLC fractions 

by UV absorbance at 280 nm with an estimated extinction coefficient for tyrosine of 1490 M-1cm-

1. On the basis of the spectrophotometrically determined concentration, we typically obtain ca. 14 

mg of Aβ(C1–42) as the trifluoroacetate salt from one liter of bacterial culture.  

MALDI-MS shows that the mass of the peptide is consistent with Aβ(C1–42), not Aβ(MC1–42) 

(Figure 2.2B), and tandem mass spectrometry (MS/MS) peptide sequencing confirms that the N-

terminus of the peptide begins with cysteine, rather than methionine (Figures 2.S9). The loss of 

the N-terminal methionine is consistent with a mechanism in which methionyl aminopeptidase 

(MAP) excises the N-terminal methionine.39–41 The combined pure HPLC fractions of Aβ(C1−42) 

can be directly used for subsequent labeling, or stored at -80 °C for at least three weeks without 

forming detectable aggregates.  
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Figure 2.2. Characterization of Aβ(C1–42). (A) Analytical HPLC trace of purified Aβ(C1–42). HPLC was 
performed on a C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes. (B) MALDI 
mass spectrum of Aβ(C1–42). Mass-to-charge (m/z) labels on peaks correspond to [M+H]+ and [M+2H]2+. 
 
  

Labeling of Aβ(C1–42). Proteins are often labeled with fluorophores or biotin by dissolving 

the lyophilized protein powder in buffer and adding a reactive derivative of the fluorophore or 

biotin to the solution of the protein. We found that when we lyophilized the Aβ(C1–42), it became 

unsuitable for labeling, because it aggregated during the lyophilization and redissolution process. 

All of our attempts to label lyophilized Aβ(C1–42) gave rise to turbid solutions of aggregated Aβ(C1–

42) that were unsuitable for subsequent purification and use. To address this problem, we have 

developed a protocol to rapidly label the Aβ(C1–42) in the combined HPLC fractions, where Aβ 

remains mostly monomeric. 
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In this protocol, we first we determine the concentration of Aβ(C1–42) in the combined HPLC 

fractions by UV absorbance at 280 nm. We then calculate the amount of the maleimide-based 

labeling reagent needed for a 2:1 molar ratio of the reagent to the Aβ(C1–42) peptide. Although 

typical thiol-maleimide labeling protocols use a 5–20-fold molar excess of the maleimide reagent, 

we found that a 2-fold molar excess is sufficient to achieve complete labeling of the Aβ(C1–42). Use 

of only a 2-fold molar excess of the reagent not only minimizes the cost, but also simplifies 

subsequent purification of the Aβ(C1–42) conjugate. Typical thiol-maleimide labeling protocols 

suggest treating the cysteine-containing unlabeled peptide with a 10–100-fold molar excess of 

tris(2-carboxyethyl)phosphine (TCEP) to reduce any disulfide bonds that might have formed. We 

found that TCEP interferes with the labeling of Aβ(C1–42) and is unnecessary for our Aβ labeling 

protocol.43 

We found that the labeling reaction must be performed in alkaline conditions to proceed 

rapidly and avoid aggregation of the Aβ. The pH of the combined HPLC fractions of Aβ(C1–42) is 

ca. 2.2 because of the presence of TFA in the mobile phases, which is unfavorable for thiol-

maleimide conjugation chemistry. At acidic pH, the thiol-maleimide reaction does not reach 

completion after overnight incubation, and Aβ(C1–42) aggregates before being completely labeled. 

Common protein labeling protocols recommend doing the thiol-maleimide conjugation at ca. pH 

7.4. Aβ(C1–42) aggregates rapidly at this pH, which is close to its isoelectric point (pI = 5.6), where 

Aβ(C1–42) is not heavily charged and is thus prone to aggregation.44 We observed that at pH 7.4, Aβ 

aggregates in several minutes, which hinders the labeling of Aβ. We thus developed a basification 

protocol to rapidly raise the pH of the acidic HPLC fractions to ca. 9.0. It is essential to bring the 

pH from ca. 2.2 to ca. 9.0 rapidly to bypass the pI quickly thus prevent Aβ aggregation.45 In this 

protocol, we first titrate a 1 mL portion of the combined HPLC fractions with pH 9.0 sodium borate 
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buffer until a pH of 9.0 is reached. This portion of the combined HPLC fractions is discarded. We 

then calculate the quantity of borate buffer needed to basify the remainder of the combined HPLC 

fractions to pH 9.0 and add it in a single portion. We then add the appropriate amount the 

maleimide reagent as a solution in DMSO and allow the reaction to proceed for 15 minutes at room 

temperature to achieve complete labeling of the Aβ.  

 

Purification, Characterization, and HFIP Treatment of Labeled Aβ(C1–42). We purify 

the labeled Aβ(C1–42) by preparative HPLC to remove unreacted maleimide reagent, borate buffer, 

and oligomers that formed during the labeling reaction. Before HPLC purification, we must filter 

the reaction mixture to prevent damaging the HPLC column. We have found both hydrophilic 

polyvinylidene fluoride (PVDF) syringe filters and hydrophilic polyethersulfone (PES) syringe 

filters are suitable for filtering expressed Aβ(M1−42) and Aβ(C1–42) before HPLC purification while 

minimizing peptide loss.36 Nevertheless, we find that only PES filters should be used for filtering 

the labeling reaction mixture, as the use of PVDF filters resulted in substantial loss of fluorophore 

or biotin labeled Aβ(C1–42) peptide. The filtered solution is then subjected to purification by 

preparative reverse-phase HPLC on a C8 column at 80 °C. The labeled Aβ(C1–42) elutes at ca. 34–

38% acetonitrile. The pure fractions of labeled Aβ(C1–42) peptide are combined.  

Using these procedures, we labeled Aβ with three different maleimide reagents: 

maleimide-6-carboxyfluorescein (FAM), maleimide-5-tetramethylrhodamine (TAMRA), and 

maleimide-PEG2-biotin (Figure 2.3). MALDI-MS corroborated the composition of each labeled 

Aβ peptide (Figure 2.4). HPLC analysis indicated the purity of each peptide to be 94.0−96.6% 

(Figures 2.5, 2.S10, 2.S12, 2.S14). After lyophilizing the combined pure HPLC fractions, we 

gravimetrically determined the yield of each of the labeled peptides as the trifluoroacetate salt to 
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be 2.6−3.6 mg per liter of bacterial culture (Table 2.S15). To provide aliquots of monomeric 

labeled Aβ for subsequent biophysical and biological studies, we dissolve and incubate the 

lyophilized powder of labeled Aβ in HFIP and portion the labeled Aβ into 0.02 µmol (ca. 0.1 mg) 

aliquots. We then lyophilize the aliquots to remove HFIP and store the lyophilized aliquots in a 

desiccator at -20 °C until further use. 

 

Thiazine Rearrangement of Labeled Aβ(C1–42). After we completed the work, Gober et 

al. recently reported that maleimide conjugates of N-terminal cysteine peptides rearrange to the 

isomeric thiazines over the course of hours at neutral or basic pH (Figure 2.3A).46 To evaluate the 

occurrence of this rearrangement in the maleimide conjugates of Aβ(C1−42) reported in the this 

chapter, we have performed ultra-performance liquid chromatography–high-energy collision-

induced mass spectrometry (UPLC–MSE) analysis on 5-TAMRA-Aβ(C1−42). Upon digestion of 5-

TAMRA-Aβ(C1−42) with proteinase K at 37 °C at pH 7.2 followed by UPLC–MSE, we were able to 

identify a set of three peaks in the UPLC trace associated with 5-TAMRA-Aβ(C1−7) (14.4, 16.3, 

16.5 minutes) and a set of three peaks in the UPLC trace associated with 5-TAMRA-Aβ(C1−5) (15.9, 

17.8, and 18.1 minutes) (Figure 2.6). The patterns of three unique peaks associated with each 

digestion fragment are consistent with the thiazine isomer and the two diastereomers of the 

maleimide conjugate. Similar patterns of three peaks were reported by Gober et al. for maleimide 

conjugates of several model tripeptides bearing N-terminal cysteine residues, with the thiazine 

isomer eluting first and the two diastereomers of the maleimide conjugate eluting subsequently.46 

The observation of these characteristic sets of three peaks provides strong evidence that 5-

TAMRA-Aβ(C1−42) has partially rearranged to the thiazine isomer in the course of preparation and 

isolation. We expect that 6-FAM-Aβ(C1−42) and PEG2-biotin-Aβ(C1−42) also partially rearranged to 
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the thiazine isomers in the course of preparation and isolation. We further expect these Aβ(C1−42) 

maleimide conjugates to fully rearrange to the corresponding thiazine isomers during the course 

of common experiments that involve prolonged incubation at neutral pH (Figure 2.3). Because N-

terminal substitution does not substantially alter the properties of the Aβ, we anticipate that the 

isomerization of the maleimide conjugates to the isomeric thiazines will not significantly affect 

the use of the N-terminally labeled Aβ42 peptides. 

 

 

Figure 2.3. Conjugation of Aβ(C1-42) with maleimide reagents (A). Structures of labeled Aβ products: FAM-
Aβ(C1-42) (B), TAMRA-Aβ(C1-42) (C), and PEG2-biotin-Aβ(C1-42) (D). 
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Figure 2.4. MALDI mass spectra of fluorophore and biotin labeled Aβ(C1–42): (A) TAMRA-labeled Aβ. (B) 
FAM-labeled Aβ. (C) Biotin-labeled Aβ. Mass-to-charge (m/z) labels on peaks correspond to [M+H]+ and 
[M+2H]2+.  
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Figure 2.5. Analytical HPLC traces of purified fluorescent and biotin labeled Aβ(C1–42): (A) HPLC trace of 
TAMRA-labeled Aβ at 214 nm and 541 nm. (B) HPLC trace of FAM-labeled Aβ at 214 nm and 494 nm. 
(C) HPLC trace of biotin-labeled Aβ at 214 nm. HPLC was performed on a C18 column at 60 °C with 
elution with 5–67% acetonitrile over 15 minutes. The absorbance of FAM-labeled Aβ at 494 nm is low in 
the acidic (0.1% TFA) HPLC mobile phase. 
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Figure 2.6. UPLC–MSE total ion current chromatogram of 5-TAMRA-Aβ(C1−42) digested with 
proteinase K for either 10 minutes (A) or 60 minutes (B). Peaks were analyzed and assigned by 
MSE analysis through identification of b and y ions in the fragmentation mass spectra using Waters 
BiopharmaLynx software. UPLC was performed on a C4 reverse-phase column with elution with 
3–27% acetonitrile containing 0.1% formic acid over 25 minutes. 

 

Oligomerization and Fibrilization Studies of Labeled Aβ(C1–42). To determine whether 

N-terminal labeling perturbs the aggregation properties of the Aβ(C1–42), we compared labeled Aβ 

to unlabeled Aβ by SDS-PAGE, thioflavin T (ThT) fluorescence assays, fluorescence suppression 

assays, and transmission electron microscopy (TEM). In these studies we used Aβ(M1−42), an 

expressed homologue with properties similar to native Aβ(1–42), as an unlabeled Aβ control.36  
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SDS-PAGE shows that the labeled Aβ peptides behave similarly to Aβ(M1−42) (Figure 2.7). 

We ran SDS-PAGE at a range of concentrations to better observe both the monomeric and 

oligomeric species, and we visualized the peptides by silver staining. We also visualized the FAM- 

and TAMRA-labeled Aβ directly by fluorescence imaging. At lower concentrations (e.g., 4 and 8 

µM), the Aβ shows up exclusively or predominantly as the monomer, which appears as a band 

between the 4.6 kDa and 10 kDa ladder bands. At higher concentrations (e.g., 125 and 250 µM), 

bands associated with trimers and tetramers appear just below and above the 17 kDa ladder band. 

In spite of the differences among the N-terminal substituents and visualization techniques for the 

SDS-PAGE gels, all of the gels show remarkably similar patterns of monomers and oligomers 

among the four peptides. 

 

Figure 2.7. SDS-PAGE of labeled Aβ(C1–42) and Aβ(M1−42) at a range of concentrations, visualized by silver 
staining and fluorescence imaging. (A and B) FAM-labeled Aβ(C1–42) visualized by silver staining and 
fluorescence imaging. (C and D) TAMRA-labeled Aβ(C1–42) visualized by silver staining and fluorescence 
imaging. (E and F) Biotin-labeled Aβ(C1–42) and Aβ(M1−42) visualized by silver staining. The contrast of 
images 6A, 6C, 6E, and 6F have been increased by 40% to enhance the visualization of the silver staining.  
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ThT fluorescence assays are widely used to study the onset of fibril formation by 

amyloidogenic peptides. In these assays, Aβ or a related amyloidogenic peptide is incubated with 

ThT. After a lag time, the onset of fibril formation is marked by the rapid increase in ThT 

fluorescence and a subsequent plateau. In a ThT assay, the Aβ(M1−42) exhibited a lag time of ca. 

100 minutes, followed by a rapid increase in fluorescence and a plateau, reflecting the formation 

of fibrils (Figure 2.8A). The biotin-labeled Aβ(C1–42) exhibited a shorter lag time (ca. 20 minutes), 

followed by a more rapid increase in fluorescence and a plateau (Figure 2.8B). The FAM label 

absorbs light at wavelengths similar to ThT and does not permit a conventional ThT fluorescence 

assay to be performed. Aggregation of the FAM- and TAMRA-labeled Aβ can be observed by a 

diminution of fluorescence as the labeled Aβ begins to aggregate, even before the onset of fibril 

formation.27,29 We thus studied the aggregation of these fluorophore-labeled Aβ peptides through 

a fluorescence suppression assay. In this assay, the FAM-labeled Aβ(C1–42) exhibited a slight initial 

diminution in the fluorescence signal, followed by a lag time, and then a rapid drop in fluorescence. 

The initial diminution in fluorescence may reflect the formation of small oligomers, while the 

subsequent drop likely reflects the formation of fibrils (Figure 2.8C). In contrast, the TAMRA-

labeled Aβ(C1–42) exhibited an immediate substantial drop in fluorescence, suggesting more rapid 

aggregation and fibril formation (Figure 2.8D). The differences observed between the biotin-

labeled Aβ(C1–42) and the Aβ(M1−42), and between the FAM- and TAMRA-labeled Aβ(C1–42), indicate 

that the choice of label is important in the aggregation of the Aβ.  
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Figure 2.8. ThT fluorescence assays and fluorescence suppression assays of labeled Aβ(C1–42) and Aβ(M1−42). 
(A and B) ThT fluorescence assays of Aβ(M1−42) and biotin-labeled Aβ (40 µM peptide, 40 µM ThT, 37 °C, 
quiescent, 6 hours). (C and D) Fluorescence suppression assays of FAM-labeled Aβ and TAMRA-labeled 
Aβ (40 µM peptide, 37 °C, quiescent, 6 hours). These assays were performed in five replicates (light blue, 
dark blue, orange, yellow, and gray). 
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To directly visualize amyloid fibrils formed by labeled Aβ, we performed transmission 

electron microscopy (TEM). TEM studies reveal that Aβ(M1−42), biotin-labeled Aβ(C1–42), FAM-

labeled Aβ(C1–42), and TAMRA-labeled Aβ(C1–42) all form fibrils after one day of incubation (Figure 

2.9 and Figure 2.S18). The fibrils differ in morphology: Aβ(M1−42) forms wide, twisted, multi-

fibrillar assemblies. Biotin-labeled Aβ(C1–42) forms long, thin fibrils. FAM- and TAMRA-labeled 

Aβ(C1–42) form more heterogenous fibrils. The TEM studies further confirm that the choice of label 

is important in the aggregation of Aβ. We performed atomic force microscopy (AFM) to further 

characterize the fibrils. AFM shows that the fibrils formed by Aβ(M1−42), biotin-labeled Aβ(C1–42), 

FAM-labeled Aβ(C1–42), and TAMRA-labeled Aβ(C1–42) range in height from ca. 2–5 nm and exhibit 

some morphological differences (Figure 2.10 and 2.S19). Although there are differences among 

the rates of fibril formation and the morphologies of the fibrils, the TEM and AFM experiments 

and the ThT and fluorescence suppression experiments collectively show that all of the labeled Aβ 

peptides retain the propensity to form fibrils. 

 

Figure 2.9. Transmission electron micrographs of fibrils formed by Aβ peptides: (A) Aβ(M1−42), fibril width 
ca. 36 nm; (B) TAMRA-labeled Aβ, fibril width ca. 15 nm; (C) FAM-labeled Aβ, fibril width ca. 56 nm; 
(D) Biotin-labeled Aβ, fibril width ca. 12 nm. Fibrils were formed by incubating 40 µM of each peptide in 
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PBS buffer (pH 7.4, 37 °C, 1 day, 225 rpm shaking). The red bars indicate the locations where the widths 
of the fibrils were measured. 
 

 
 

Figure 2.10. Atomic force micrographs of fibrils formed by Aβ peptides: (A) Aβ(M1−42), fibril height ca. 4.5 
nm; (B) TAMRA-labeled Aβ, fibril height ca. 5.2 nm; (C) FAM-labeled Aβ, fibril height ca. 2.3 nm; (D) 
Biotin-labeled Aβ, fibril height ca. 4.1 nm. Fibrils were formed by incubating 40 µM of each peptide in 
PBS buffer (pH 7.4, 37 °C, 1 day, 225 rpm shaking). The red arrows indicate the locations where the heights 
of the fibrils were measured. 
 
 

Fluorescence Microscopy Studies of Fluorophore-Labeled Aβ(C1–42). To evaluate the 

applicability of the labeled Aβ in fluorescence microscopy, we visualized the interaction of the 

FAM- and TAMRA-labeled Aβ(C1–42) with mammalian cells and bacteria. The interaction of Aβ 

with neuronal cell membranes is thought to be important in neurodegeneration in Alzheimer’s 

disease.28,47 When we treated SH-SY5Y neuroblastoma cells with the fluorescent Aβ, we observed 

binding to the cell membranes, internalization of the fluorescent Aβ (Figure 2.11A, 2.11B, and 

2.S17). These interactions occurred rapidly (within 3 hours) for the TAMRA-Aβ and more slowly 

(within 48 hours) for the FAM-Aβ. In both cases, we observe small punctate features within the 

cells, suggesting that internalization occurs through interaction with the cell membranes and the 
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formation of endosomes. Macrophages have been shown to play an important role in Aβ 

clearance.48,49 When we treated RAW 264.7 macrophage cells with fluorescent Aβ, we also 

observed uptake of the Aβ, with the uptake of the TAMRA-Aβ occurring more extensively. The 

punctate features associated with the internalized peptides are larger, consistent with phagocytosis 

of the labeled Aβ by the macrophage (Figure 2.11C, 2.11D, and 2.S17). Aβ is also thought to have 

antimicrobial activity and play a role in innate immune response.50,51 When we treated B. subtilis 

(Gram-positive) and E. coli (Gram-negative) with the fluorescent Aβ, we observed interaction of 

what appeared to be aggregated Aβ with the bacterial cell walls (Figure 2.11E and 2.11F). These 

results indicate that the fluorescent Aβ peptides prepared by this method can be used to visualize 

and monitor interactions between Aβ and cells, with the TAMRA-Aβ giving somewhat more rapid 

and more uniform staining.52  
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Figure 2.11. Fluorescence micrographs of labeled Aβ with mammalian cells and bacteria. (A and B) SH-
SY5Y neuroblastoma cells treated with FAM- and TAMRA-labeled Aβ (10 µM peptides, 37 °C, 48 and 3 
hours, respectively). The nuclei are shown in blue through Hoechst 33342 staining. (C and D) RAW 264.7 
macrophage cells treated with FAM- and TAMRA-labeled Aβ (10 µM peptides, 37 °C, 4 hours). (E and F) 
B. subtilis treated with FAM- and TAMRA-labeled Aβ (5 µM peptides, 37 °C, 225 rpm, 225 rpm shaking, 
2 hours). (G and H) E. coli treated with FAM- and TAMRA-labeled Aβ (5 µM peptides, 37 °C, 225 rpm, 
225 rpm shaking, 2 hours). These micrographs were collected by Gretchen Guaglianone and Dr. Michael 
Morris. 

 

Conclusions 

Our discovery that expression of an Aβ(MC1-42) plasmid in E. coli leads to endogenous 

excision of methionine has enabled us to develop methods to express and purify Aβ(C1-42) and then 

label the Aβ at the N-terminus with fluorophores or biotin through cysteine-maleimide chemistry. 
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The expression and labeling of Aβ(C1-42) provide an efficient and economical route to obtain ca. 14 

mg of N-terminal cysteine Aβ or ca. 3 mg of labeled Aβ per liter of bacterial culture. Analytical 

HPLC and MALDI analyses confirm that the Aβ(C1-42) and labeled Aβ are pure and homogeneous. 

SDS-PAGE, ThT fluorescence assays and related fluorescence suppression assays, and TEM 

studies establish that N-terminally labeled Aβ retains aggregation properties similar to unlabeled 

Aβ. Fluorescence microscopy shows that the labeled Aβ can be used to visualize interactions 

between Aβ and mammalian or bacterial cells.  

Expression offers advantages over solid phase peptide synthesis, because the expressed Aβ is 

free of deletion or epimerization impurities. The addition of a single cysteine residue at the N-

terminus enables labeling of the expressed Aβ with complete site specificity using maleimide-

based reagents. Although NHS esters are widely used to label lysine residues or the N-terminus of 

proteins, site specific labeling of expressed Aβ is not possible using NHS-ester based reagents, 

because multiple labeling sites are present.  

The expression, purification, and conjugation methods that we report here should enable other 

researchers to produce milligram quantities of pure labeled Aβ in their own laboratories. Ready 

access to labeled Aβ peptides will advance amyloid and Alzheimer’s disease research by 

facilitating experiments that might otherwise be hindered by insufficient access to these valuable 

peptides.53–65 We anticipate these fluorophore and biotin labeled Aβ peptides will be especially 

useful in investigating cellular interactions, transport, and clearance of Aβ, as well as screening 

anti-Aβ antibodies.66–68 Researchers may also apply our methods to label Aβ with other popular 

fluorophores, such as Alexa Fluor™ 488 and BODIPY™ FL.69,70 The potential to install a variety 

of fluorophores may enable studies of Aβ peptide interactions through Förster resonance energy 

transfer (FRET) studies in which Aβ has been labeled with FRET donors and acceptors, such as 
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Cy3 and Cy5. The N-terminal cysteine Aβ formed through N-terminal methionine excision also 

promises to be valuable in other applications, such as native chemical ligation or other site-specific 

modifications. We anticipate that this method of incorporating an N-terminal cysteine residue can 

be adapted to the expression, purification, and conjugation of other variants of Aβ, such as familial 

mutants,36 further enabling a variety of experiments in Alzheimer’s disease research. 
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Materials and Methods1   

General Information 

Chemicals and Supplies. All chemicals were used as received unless otherwise noted. 

Deionized water (18 MΩ) was obtained from a Thermo Fisher Scientific Barnstead Genpure Pro 

water purification system. The pET-Sac-Aβ(M1−42) plasmid was a gift from Dominic Walsh 

(Addgene plasmid # 71875). DNA sequences that encode Aβ(MC1–42) was purchased in 500 ng 

quantities from Genewiz. NdeI and SacI restriction enzymes, CutSmart buffer, and shrimp alkaline 

phosphatase (rSAP) were purchased from New England Biolabs (NEB). TOP10 Ca2+-competent 

E. coli and BL21 DE3 PLysS Star Ca2+-competent E. coli, T4 ligase, and ethidium bromide were 

purchased from Thermo Fisher Scientific. Zymo ZR plasmid miniprep kit was purchased from 

Zymo Research. Zymoclean Gel DNA Recovery Kit was purchased from Zymo Research. Fisher 

BioReagents LB Broth was purchased from Thermo Fisher Scientific. Carbenicillin was purchased 

from Gold Biotechnology and added to culture media as a 1000X stock solution (50.0 mg/mL) in 

water. Chloramphenicol was purchased from RPI Research Products and added to culture media 

as a 1000X stock solution (34.0 mg/mL) in EtOH. Isopropyl β-D-1-thiogalactopyranoside (IPTG) 

was purchased from Gold Biotechnology and added to the culture media as a 1000X stock solution 
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(23.8 mg/mL) in water. Maleimide-6-carboxyfluorescein (FAM) and maleimide-5-

tetramethylrhodamine (TAMRA) were purchased from Lumiprobe and maleimide-PEG2-biotin 

was purchased from Thermo Fisher Scientific. DMSO was purchased from Thermo Fisher 

Scientific. Urea and sodium borate were purchased from Thermo Fisher Scientific. Boric acid was 

purchased from Sigma-Aldrich. Tris hydrochloride was purchased from Avantor. 

Ethylenediaminetetraacetic acid (EDTA) was purchased from Sigma-Aldrich. Trifluoroacetic acid 

(TFA), and HPLC grade acetonitrile (ACN) were purchased from Thermo Fischer Scientific. 

1,1,1,3,3,3-Hexafluoro-2-propanol (HFIP) was purchased from Oakwood Chemical. Thioflavin T 

(ThT) was purchased from Sigma-Aldrich. Spectra multicolor low range protein ladder and 6X 

SDS-PAGE loading buffer were purchased from Thermo Fisher Scientific. Sodium carbonate 

(≥99.5%) was purchased from Sigma-Aldrich.a Ammonium persulfate, formaldehyde, and silver 

nitrate were purchased from Thermo Fischer Scientific. N,N,N',N'-tetramethylethylenediamine 

(TEMDA) was purchased from Alfa Aesar. Sodium thiosulfate was purchased from Avantor. 

Corning® 96-well half area black/clear flat bottom polystyrene nonbinding surface (NBS) 

microplates (product number: 3881) were purchased from Corning Incorporated.b 0.22 μm 

Hydrophilic polyethersulfone (PES) syringe filters were purchased from Genesee Scientific 

(catalog number: 25-244). 0.20 μm Nylon syringe filters were purchased from Thermo Fisher 

Scientific (catalog number: 09-719-006). DMEM:F12 media were purchased from Thermo Fisher 

Scientific. Molecular biology grade agarose was purchased from Thermo Fisher Scientific. Difco 

Mueller Hinton broth was purchased from Becton Dickinson and Company. 

 
a Use of high-purity sodium carbonate is crucial for successful silver staining. 
b Microplates with a non-binding surface give reproducible ThT assay results. 
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Instrumentation. The concentrations of the DNA and peptide samples were measured 

using a Thermo Fisher Scientific NanoDrop One spectrophotometer. E. coli were incubated in a 

Thermo Fisher Scientific MaxQ Shaker 6000. E. coli were pelleted by centrifugation using 

Beckman Coulter Avanti J-E centrifuge with JA-10 and JA-18 rotors. E. coli were lysed using a 

QSonica Q500 ultrasonic homogenizer. Analytical reverse-phase HPLC was performed on an 

Agilent 1260 Infinity II instrument equipped with a Phenomonex bioZen Peptide XB-C18 LC 

column (4.6 x 150 mm, 2.6 μm particle size). Preparative reverse-phase HPLC was performed on 

a Rainin Dynamax instrument SD-200 equipped an Agilent ZORBAX 300SB-C8 semi-preparative 

column (9.4 x 250 mm, 5.0 μm particle size) with a ZORBAX 300SB-C3 preparative guard column 

(9.4 x 15 mm, 7.0 μm particle size). During preparative HPLC purification, the C8 column and the 

guard column were heated to 80 °C in a Sterlite plastic bin equipped with a Wancle Sous Vide 

immersion circulator. HPLC grade acetonitrile and deionized water (18 MΩ), each containing 

0.1% trifluoroacetic acid (TFA), were used for analytical and preparative reverse-phase HPLC. 

MALDI-TOF mass spectrometry and tandem mass spectrometry (MS/MS) peptide sequencing 

were performed using an AB SCIEX TOF/TOF 5800 System. Rotary evaporation was conducted 

using a Büchi Rotavapor. Lyophilization was conducted using a Labconco FreeZone Freeze Dry 

System. Sonication of the peptide DMSO stock was performed using a SharperTek ultrasonic 

cleaner. pH of the solutions was measures using a Thermo Fisher Scientific AB150 Benchtop pH 

Meter and a Fisherbrand™ accumet™ pH probe. Fluorescence suppression assays and ThT 

fluorescence assays were performed using a Thermo Fisher Scientific Varioskan Lux microplate 

reader. The absorbance of the ThT solution and peptide solutions were measured using a Thermo 

Fisher Scientific Multiskan Go microplate spectrophotometer. SDS-PAGE gels were visualized 

using a ChemiDoc Touch Imaging System. Mammalian cell fluorescence microscopy was 
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performed using a Keyence BZ-X810 fluorescence microscope. Mammalian cell fluorescence 

microscopy was performed using a Zeiss LSM 780 confocal fluorescence microscope. TEM 

images were obtained using a JEOL JEM-2100F-cryo-TEM instrument. 

 

Molecular Cloning  

This section describes the preparation of the pET-Sac-Aβ(MC1–42) plasmid. We have 

now deposited the pET-Sac-Aβ(MC1–42) plasmid with Addgene to make it available to others.2 

Isolation of pET-Sac-Aβ(M1−42) Plasmid. The pET-Sac-Aβ(M1−42) plasmid was purchased as 

a bacterial stab from Addgene (Addgene plasmid #71875)3, which was made available as a gift 

from D. Walsh.4 The bacterial stab was immediately streaked onto a LB agar-plate containing 

carbenicillin (50 mg/L). Colonies grew in < 24 h. Single colonies were picked and used to inoculate 

5 mL of LB broth containing carbenicillin (50 mg/L). The cultures were shaken at 225 rpm 

overnight at 37 °C. To isolate the pET-Sac-Aβ(M1−42) plasmids, minipreps were performed using a 

Zymo ZR plasmid miniprep kit. The concentration of the plasmids was measured using a Thermo 

Scientific Nanodrop instrument.  

Restriction Enzyme Digestion of pET-Sac-Aβ(M1−42) Plasmid. The pET-Sac-Aβ(M1−42) 

plasmid was digested using SacI and NdeI restriction enzymes to remove the Aβ(M1−42) sequence 

and prepare vector backbones for the subsequent generation of Aβ(MC1–42) recombinant plasmid. 

Table 2.S1 details the restriction reaction conditions. Reagents were added in the order they are 

listed. 
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Table 2.S1. Restriction enzyme digestion of the pET- Sac Aβ(M1−42) plasmid 

Reagents Amount 

pET-Sac Aβ(M1−42) 
20 µL of 50 ng/µL plasmid solution (1.0 µg in 

total) 

10X CutSmart buffer 5.0 µL 

H2O 23.0 µL 

NdeI restriction enzyme 1.0 µL (1 U) 

SacI-HF restriction enzyme 1.0 µL (1 U) 

Total 50.0 µL 

Time 1.0 h 

Temperature 37.0 °C 

 

Next, to prevent vector backbone self-ligation, the digested plasmid was treated with 

shrimp alkaline phosphatase (rSAP). Table 2.S2 details the rSAP reaction conditions.  

Table 2.S2. rSAP treatment of the vector backbones 

Reagents Amount 

Restriction enzyme digestion mixture 50.0 µL 

rSAP 1.0 µL (1U) 

Total 51.0 µL 

Time 0.5 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 
 

After the rSAP reaction and heat inactivation were complete, the reaction mixture was 

mixed with DNA loading buffer and loaded onto a 1% agarose gel containing ethidium bromide 

(5 µL per 100 mL gel). The agarose gel was run at 100 V for ca. 30 min. A UV box was used to 

visualize the digested pET-Sac vector (ca.4500 bp), which was excised from the gel using a razor 

blade. The digested pET-Sac vector was purified from the agarose gel using a Zymoclean Gel 

DNA Recovery Kit. The concentration of the vector after purification was measured using a 
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Thermo Scientific Nanodrop instrument. The purified digested pET-Sac linear vector was used in 

the subsequent ligation step. 

Design of the DNA Sequence for Aβ(MC1–42). DNA fragment for Aβ(MC1–42) was ordered from 

Genewiz. Figure 2.S1 shows the design of the DNA sequence for Aβ(MC1–42). 

__ 3’ and 5’ overhangs  __ Nde1 restriction site/start codon  

 __ stop codons  __ Sac1 restriction site   

 

GAT ATA CAT ATG TGC GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC GAA GTT 
CAC CAC CAG AAG CTG GTG TTC TTC GCT GAA GAC GTG GGT TCT AAC AAG GGT 
GCT ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG GAG CTC 
GAT CCG 

 

Figure 2.S1. Design of the DNA sequence for Aβ(MC1–42). 

 

Restriction Enzyme Digestion of Aβ(MC1–42) DNA Fragment. The Aβ(MC1–42) DNA fragment 

was digested using SacI and NdeI restriction enzymes to generate the insert DNA. Table 2.S3 

details the restriction reaction conditions. Reagents were added in the order they are listed. 



90 
 

Table 2.S3. Restriction enzyme digestion of the Aβ(MC1–42) DNA fragment 

Reagents Amount 
DNA sequence encoding 

mutation 
20 µL of 5 ng/µL DNA solution (100.0 ng in 

total) 
10X CutSmart buffer 2.5 µL 

H2O 1.5 µL 

NdeI restriction enzyme 0.5 µL (0.5 U) 

SacI-HF restriction enzyme 0.5 µL (0.5 U) 

Total 25.0 µL 

Time 1.0 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 
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T4 Ligation of the Aβ(MC1–42) DNA Fragment and the pET-Sac Vector. The Aβ(MC1–42) DNA 

fragment (insert) and the backbone vector were ligated together using T4 ligase. Table 2.S4 details 

the T4 ligation reaction conditions. Reagents were added in the order they are listed. 

Table 2.S4. T4 ligation of the insert and the vector 

Reagents 

Amount 

Insert:Vector = 0:1 
(molar ratio) 

(negative control) 

Insert:Vector = 5:1 
(molar ratio) 

Vector 
6.2 µL of 9.7 ng/µL DNA 
solution (60.0 ng in total) 

6.2 µL of 9.7 ng/µL DNA 
solution (60.0 ng in total) 

Insert --- 
2.5 µL of 4.0 ng/µL DNA 
solution (10.0 ng in total) 

10X T4 DNA 
ligase reaction 

buffer 
2.0 µL 2.0 µL 

T4 DNA ligase 1.0 µL 1.0 µL 

H2O 10.8 µL 8.3 µL 

Total 20.0 µL 20.0 µL 

Ligation time 10 min 

Temp 22.0 °C (room temperature) 

Heat inactivation 65.0 °C for 10 min 

 

Aβ(MC1–42) Recombinant Plasmid Preparation. 2 µL of the ligation reaction mixture was 

then transformed into TOP10 Ca2+-competent E. coli using the heat shock method. The cell 

cultures were spread on LB agar plates containing carbenicillin (50 mg/L). Single colonies were 

picked to inoculate 5 mL of overnight cultures in LB media with carbenicillin (50 mg/L). The 

plasmid was extracted from TOP10 cells using Zymo ZR plasmid miniprep kit. The concentration 

of the plasmid was measured through Thermo Scientific NanoDrop spectrophotometer. The DNA 

sequence of the Aβ(MC1–42) recombinant plasmid was verified by DNA sequencing. The Aβ(MC1–42) 

recombinant plasmid was deposited to Addgene.2 
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Representative Schedule for the Expression, Purification, and Labeling of Aβ(C1–42) 

Table 2.S5. Representative schedule for the expression, purification, and labeling of Aβ(C1–42) 

Day Time Steps 

Day 1 Evening Starter culture 

Day 2 

Morning Daytime culture 

Afternoo
n 

IPTG induced expression of Aβ(C1–42) 

Evening Cell pelleting 

Day 3 

Morning Cell lysis and urea extraction to obtain peptide solution 

Afternoo
n 

Prep-HPLC purification of the 1st batch of peptide solution 

Evening Prep-HPLC purification of the 2nd batch of peptide solution 

A total of ca. 14.0 mga of pure Aβ(C1–42) is obtained 
(in two batches of combined HPLC fractions) 

Day 4 
Morning Labeling of the 1st batch of Aβ(C1–42); prep-HPLC purification 

Afternoo
n 

Labeling of the 2nd batch of Aβ(C1–42); prep-HPLC purification 

Day 4–5 
Overnigh

t 
Lyophilization of purified labeled Aβ(C1–42) 

A total of ca. 3.0 mgb of pure labeled Aβ(C1–42) is obtained 

Day 5 
Afternoo

n 
HFIP treatment of pure labeled Aβ(C1–42); lyophilization 

 

Bacterial expression of Aβ(C1–42) 

Transformation of Aβ(MC1–42) Plasmid. All liquid cultures were performed in culture media 

(LB broth containing 50 mg/L carbenicillin and 34 mg/L chloramphenicol). Aβ(MC1–42) plasmid 

was transformed into BL21 DE3 PLysS Star Ca2+-competent E. coli through heat shock method. 

The cell cultures were spread on LB agar plates containing carbenicillin (50 mg/L) and 

 
a The yield of Aβ(C1–42) was determined spectrophotometrically. 
b The yield of labeled Aβ(C1–42) was determined gravimetrically. 
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chloramphenicol (34 mg/L). Single colonies were picked to inoculate 5 mL of culture media for 

overnight culture (ca. 14 h). A glycerol stock of BL21 DE3 PLysS Star Ca2+-competent E. coli 

bearing the plasmid was made. The glycerol stock was stored at -80 °C and was used in all 

subsequent expression procedures. 

Expression of Aβ(C1–42). For a typical expression procedure, a starter culture was made by 

inoculating culture media with an aliquot of the glycerol stock. The next day, all 5 mL of the 

overnight culture were used to inoculate 1 L of culture media. After inoculation, the culture was 

shaken at 225 rpm at 37 ˚C (for ca. 3 hours and 50 minutes) until the cell density reached an OD600 

of ca. 0.45. Protein expression was then induced by the addition of isopropyl β-D-1-

thiogalactopyranoside (IPTG) to a final concentration of 0.1 mM, and the cells were shaken at 225 

rpm at 37 °C for 4 more hours with IPTG.  The cells were then harvested by centrifugation at 4000 

rpm using a JA-10 rotor (2800 x g) at 4 ˚C for 25 minutes, and the cell pellets were then stored at 

-80 °C.  

 

Purification of the Aβ(C1–42) Peptide 

Cell Lysis. To lyse the cells, the cell pellet was resuspended in 20 mL of buffer A (10 mM 

Tris/HCl, 1 mM EDTA, pH 8.0) and sonicated for 2 minutes on ice (50% duty cycle) until the 

lysate appeared homogenous. The lysate was then centrifuged for 25 minutes at 16000 rpm using 

a JA-18 rotor (38000 x g) at 4˚C. The supernatant was removed, and the pellet was resuspended in 

buffer A, sonicated and centrifuged as described above. The sonication and centrifugation steps 

were repeated two additional times. After the third supernatant was removed, the remaining pellet 

(inclusion bodies) was resuspended in 15 mL of freshly prepared buffer B (8 M urea, 10 mM 
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Tris/HCl, 1 mM EDTA, pH 8.0), and was sonicated as described above, until the peptide solution 

became clear.  

 

Sample Filtering and Analytical HPLC. The peptide solution (ca. 15 mL) was then diluted 

with 10 mL of buffer A and filtered through a 0.22 μm hydrophilic PES syringe filter from Genesee 

Scientific (catalog number: 25-244) or a 0.22 µm hydrophilic PVDF syringe filter from Thermo 

Fisher Scientific (catalog number: 09-719-006).a Successful expression of the Aβ(C1–42) peptide 

was confirmed by analytical reverse-phase HPLC as follows: A 20-µL sample of the above 

solution was injected onto an Agilent 1260 Infinity II instrument equipped with a Phenomonex 

bioZen Peptide XB-C18 LC column (4.6 x 150 mm, 2.6 μm particle size). HPLC grade acetonitrile 

(ACN) and 18 MΩ deionized water, each containing 0.1% trifluoroacetic acid, were used as the 

mobile phase. The sample was eluted at 1.0 mL/min with a 5–67% acetonitrile gradient over 15 

minutes, at 60 °C. The absorbance was taken at 214 nm. A typical analytical HPLC trace of the 

successfully expressed Aβ(C1–42) shows four major peaks, with the first peak (ca. 10.4 min) 

corresponding to the Aβ(C1–42) monomer (Figure 2.S2). 

 
a Use of appropriate filter materials is essential for minimizing loss of peptide by adsorption during 
filtration. 
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Figure 2.S2. Representative HPLC trace of filtered, unpurified Aβ(C1–42). HPLC was performed on a 
C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance was monitored 
at 214 nm. 

Preparative HPLC Purification of Aβ(C1–42). The filtered peptide solution was then purified 

by preparative reverse-phase HPLC equipped with an Agilent ZORBAX 300SB-C8 semi-

preparative column (9.4 x 250 mm) with a ZORBAX 300SB-C3 preparative guard column (9.4 x 

15 mm). The C8 column and the guard column were heated to 80 °C in water bath using a Sterlite 

plastic bin equipped with a Wancle Sous Vide immersion circulator.a HPLC grade acetonitrile 

(ACN) and 18 MΩ deionized water, each containing 0.1% trifluoroacetic acid, were used as the 

mobile phase at a flow-rate of 5 mL/min. The filtered peptide solution (ca. 24 mL) was split into 

two ca. 12 mL batches and purified in two separate runs, with three injections in each run.b In each 

run, the peptide was loaded onto the column while flowing 20% ACN through the column. The 

Aβ(C1–42) peptide was then eluted using the following solvent gradient (Table 2.S6). The 

 
a Any water heater large enough to submerge a HPLC column should be sufficient. 
b It may be possible to purify the peptide in a single batch if a larger diameter column is used (e.g., 
21.4 x 250 mm). 



96 
 

absorbance was taken at 214 nm. Fractions containing the monomeric Aβ(C1–42) generally eluted 

from 33% to 35% ACN.  

Table 2.S6. HPLC solvent gradient for the purification of Aβ(C1–42) 

% H2O % ACN Elapsed Time  

80 20 0 min 

80 20 15 min 

40 65 60 min 

5 95 61 min 

5 95 80 min 

 

Column Maintenance. After the peptide was collected, the column was washed by injecting 

5 mL of filtered buffer B (8 M urea, 10 mM Tris/HCl, 1 mM EDTA, pH 8.0) while flushing at 

95% ACN for 15 minutes. This cleaning procedure ensures elution of the peptide that is retained 

in the column and avoids problems of cross-contamination between runs. If an increase in column 

back-pressure is seen after several purifications, back-flushing the semi-preparative HPLC column 

using the following cleaning protocol will solve the problem (Table 2.S7).  

Table 2.S7. Prep-HPLC column cleaning protocol 

Solvent Flow rate Washing Time  

100% ACN 5 mL/min 10 min 

100% isopropanol 2 mL/min 15 min 

100% hexanes 2 mL/min 20 min 

100% isopropanol 2 mL/min 15 min 

100% ACN 5 mL/min 10 min 

 

Characterization of Purified Aβ(C1–42). The purity of each fraction was assessed using 

analytical reverse-phase HPLC. A 20-µL sample was injected onto the analytical HPLC. The 
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sample was eluted at 1.0 mL/min with a 5–67% acetonitrile gradient over 15 min, at 60 °C. The 

absorbance was taken at 214 nm. Pure fractions were combined and the purity of the combined 

fractions were checked using analytical HPLC. The purity of Aβ(C1–42) was determined to be 97.7% 

by integration of the analytical HPLC trace at 214 nm (Figure 2.S7). The yield of Aβ(C1–42) was 

determined to be ca. 14.0 mg per liter of bacterial culture, on the basis of the 

spectrophotometrically determined concentration of Aβ(C1–42) in the combined pure HPLC 

fractions of each batch and the total volume of the two batches of the combined pure HPLC 

fractions. The details of spectrophotometric determination of the concentration of Aβ(C1–42) in the 

combined pure HPLC fractions can be found in the “Labeling of Aβ(C1–42)” section of the 

Supporting Information. The composition of the combined peptides was assessed by matrix-

assisted laser desorption ionization mass spectrometry (MALDI-MS) and tandem mass 

spectrometry (MS/MS) (Figure 2.S8 and 2.S9). The details of running MALDI-MS and MS/MS 

can be found in the “Mass Spectrometry” section of the Supporting Information.  

Storage of the Combined Pure HPLC Fractions of Aβ(C1–42). The combined pure HPLC 

fractions of Aβ(C1–42) can be directly used for subsequent labeling, or stored at -80 °C for at least 

three weeks without forming detectable aggregates. It is recommended to combine and freeze (at 

-80 °C or with dry ice) the purified fractions within 5 hours after purification to avoid oxidation of 

methionine.  
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Labeling of Aβ(C1–42)  

The labeling was performed for the first batch of combined pure HPLC fractions of 

Aβ(C1–42)., and then repeated for the second batch of Aβ(C1–42). A representative protocol to 

label one batch of combined pure HPLC fractions of Aβ(C1–42) is provided below.a 

Stoichiometry Calculation. The combined pure HPLC fractions of Aβ(C1–42) was removed 

from the freezer or dry ice and allowed to thaw (ca. 20 min). The concentration of Aβ(C1–42) in the 

combined HPLC fractions was determined by UV absorbance at 280 nm using an estimated 

extinction coefficient (ε) for tyrosine of 1490 M−1cm−1. A 35% ACN solution (acetonitrile 35%, 

water 64.9% and trifluoroacetic acid 0.1%) was used as blank solution for the UV absorbance 

measurement.b The amount of the maleimide-based labeling reagent needed was then calculated 

based on a 2:1 molar ratio of the reagent to the Aβ(C1–42) peptide. A typical reagent table for labeling 

Aβ(C1–42) with maleimide-5-tetramethylrhodamine (TAMRA) is provided here (Table 2.S8). 

Labeling of Aβ(C1–42) with maleimide-6-carboxyfluorescein (FAM) or maleimide-PEG2-biotin was 

performed in a similar manner.  

 
a It may be possible to label and purify the peptide in a single batch if a larger diameter column is 
used (e.g., 21.4 x 250 mm). 
b The typical volume of the combined pure HPLC fractions from purifying a 12-mL batch of 
peptide solution is ca. 10 mL. The typical UV absorbance of the combined pure HPLC fractions 
at 280 nm is ca. 0.2 and the typical peptide concentration in the combined pure HPLC fractions is 
ca. 140 µM.  
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Table 2.S8. Reagent table for labeling Aβ(C1–42) with maleimide-5-TAMRA 

Reagent 
Combined HPLC fractions of 
Aβ(C1–42) 

Maleimide-5-TAMRA 

Concentration 141.9 µM --- 

volume 8.0 mL --- 

Mass --- 
1.26 mg  
dissolved in 126 µL DMSO 

Molecular weight --- 552.6 g/mol 

Moles 1.14 µmol 2.28 µmol 

Molar equivalent 1.0 2.0 

 

Sodium Borate Buffer Preparation. A 750 mM sodium borate buffer solution (pH 9.0) was 

made by dissolving 1.54 g of sodium borate decahydrate (Na2B4O7•10H2O) and 0.25 g of boric 

acid (H3BO3) in 22 mL of deionized water (18 MΩ), followed by adding more deionized water (18 

MΩ) until the total volume was 27 mL (Table 2.S9). The final pH of the 750 mM sodium borate 

buffer solution made through this recipe is typically 9.0. It is not necessary to further adjust the 

pH using acid or base. 

Table 2.S9. Recipe of making 750 mM sodium borate buffer (pH 9.0) 

Reagent Molecular weight Mass/Volume 

Sodium borate 
decahydrate 
(Na2B4O7•10H2O) 

381.43 g/mol 1.54 g 

Boric acid (H3BO3) 61.84 g/mol 0.25 g 

Deionized water 
(18 MΩ) 

--- 
Add 22 mL to dissolve Na2B4O7•10H2O and H3BO3, 
then fill up to a total volume of 27 mL 

 

Titration. A 1.0 mL portion of the combined HPLC fractions of Aβ(C1–42) was then set aside 

on ice and titrated with the 750 mM sodium borate buffer in increments of 20 µL without stirring 

or shaking. The pH of the solution was checked with a pH meter after the addition of each aliquot. 
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After a pH of 9.0 was reached, one additional 20 µL increment of sodium borate buffer was added. 

The titration results were recorded in a table and the titrated 1.0 mL portion of the combined HPLC 

fractions of Aβ(C1–42) was discarded. A typical titration table is provided below (Table 2.S10).  

Table 2.S10. Titration of a 1.0 mL portion of the combined HPLC fractions of Aβ(C1–42) 

Total volume of 750 mM sodium 
borate buffer (pH 9.0) added 

pH 

0 2.3 

20 µL  2.4 

40 µL 6.0 

60 µL 8.3 

80 µL 8.8 

100 µL 8.9 

120 µL 9.0 

140 µL 9.1 

 

Basification. The volume of sodium borate buffer needed to basify the remainder of the 

combined HPLC fractions to pH 9.0 was calculated from the total volume of the sodium borate 

buffer used to titrate the 1.0 mL portion of the combined HPLC fractions of Aβ(C1–42). The 

appropriate volume of the sodium borate buffer was added in a single portion to the remainder of 

the combined HPLC fractions on ice without stirring or shaking (Table 2.S11). The pH of the 

basified solution was checked with a pH meter. The basified solution was also checked with 

analytical HPLC to make sure Aβ(C1–42) stayed in mostly monomeric form after basification (Figure 

2.S3).a 

 
a If the basification process is not properly performed, a substantial (> 20%) oligomer peak will 
appear after the monomer peak (at ca. 11.1 and 10.3 min, respectively). The labeling will still 
work, but the yield of labeled Aβ will be compromised.  
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Table 2.S11. Basification of the remainder of the combined HPLC fractions of Aβ(C1–42) 

Total volume of 750 mM sodium borate 
buffer (pH 9.0) added 

pH 

0 2.4 

1120 µL  8.9 

 

 

Figure 2.S3. Representative HPLC trace of basified combined pure fractions of Aβ(C1–42). HPLC was 
performed on a C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance 
was monitored at 214 nm. 

 

Labeling. After basification, the remainder of the combined HPLC fractions of Aβ(C1–42) 

was removed from the ice bath. The calculated amount the maleimide reagent (Table 2.S8) was 

dissolved in DMSO to give a 10 mg/mL stock solution. The maleimide reagent stock solution was 

slowly added to the remainder of the combined HPLC fractions of Aβ(C1–42) with gentle swirling. 

The reaction mixturea was then allowed to stand without stirring or shaking at room temperature 

 
a The composition of the reaction mixture: ca. 30.6% v/v acetonitrile, 0.1% v/v trifluoroacetic acid, 
1.4% v/v DMSO, 67.9% v/v water, 92 mM sodium borate/boric acid, 250 µM maleimide reagent, 
and 125 µM Aβ(C1–42). 
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for 15 minutes. If maleimide-5-TAMRA or maleimide-6-FAM was used as the labeling reagent, 

the reaction mixture was also protected from light. 

 

Purification of Labeled Aβ(C1–42)  

Sample Filtering and Analytical HPLC. After the reaction had proceeded for 15 minutes, 

the reaction mixture was filtered through a 0.22 μm hydrophilic PES syringe filter from Genesee 

Scientific (catalog number: 25-244). A PVDF syringe filter should not be used to filter the reaction 

mixture as it will lead to a substantial loss of labeled peptide in the reaction mixture. Successful 

labeling of the Aβ(C1–42) peptide was confirmed by analytical reverse-phase HPLC as follows: A 

20-µL sample of the above solution was injected onto an Agilent 1260 Infinity II instrument 

equipped with a Phenomonex bioZen Peptide XB-C18 LC column (4.6 x 150 mm, 2.6 μm particle 

size). HPLC grade acetonitrile (ACN) and 18 MΩ deionized water, each containing 0.1% 

trifluoroacetic acid, were used as the mobile phase. The sample was eluted at 1.0 mL/min with a 

5–67% acetonitrile gradient over 15 minutes at 60 °C. If maleimide-5-TAMRA was used as the 

labeling reagent, the absorbance was taken at 214 nm and 541 nm. If maleimide-6-FAM was used 

as the labeling reagent, the absorbance was taken at 214 nm and 494 nm. If maleimide-PEG2-biotin 

was used as the labeling reagent, the absorbance was taken at 214 nm. A typical analytical HPLC 

trace of the successfully labeled Aβ(C1–42) shows a sharp peak corresponds to monomeric labeled 

Aβ(C1–42) at ca. 10.2 minutes, with a slight retention time change compare to the unlabeled Aβ(C1–

42) (Figure 2.S4, 2.S5, and 2.S6) (Table 2.S12).  
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Figure 2.S4. Representative analytical HPLC trace of filtered, unpurified TAMRA-labeled Aβ(C1–42). HPLC 
was performed on a C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and 
absorbance was monitored at 214 nm (top) and 541 nm (bottom). 
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Figure 2.S5. Representative analytical HPLC traces of filtered, unpurified FAM-labeled Aβ(C1–42). HPLC 
was performed on a C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and 
absorbance was monitored at 214 nm (top) and 494 nm (bottom). 
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Figure 2.S6.  Representative analytical HPLC trace of filtered, unpurified biotin-labeled Aβ(C1–42). The 
absorbance was taken at 214 nm. HPLC was performed on a C18 column at 60 °C with elution with 5–67% 
acetonitrile over 15 minutes, and absorbance was monitored at 214 nm. 

 

Table 2.S12. Analytical HPLC retention time 

Peptide Analytical HPLC retention time 

Unlabeled Aβ(C1–42) 10.4 min 

TAMRA-Aβ(C1–42) 10.7 min 

FAM-Aβ(C1–42) 10.6 min 

Biotin-Aβ(C1–42) 10.0 min 
 

Preparative HPLC Purification of Labeled Aβ(C1–42). The reaction mixture was then 

purified by preparative reverse-phase HPLC equipped with an Agilent ZORBAX 300SB-C8 semi-

preparative column (9.4 x 250 mm) with a ZORBAX 300SB-C3 preparative guard column (9.4 x 

15 mm).a The C8 column and the guard column were heated to 80 °C in water bath using a Sterlite 

 
a It may be possible to label and purify the peptide in a single batch if a larger diameter column is 
used (e.g., 21.4 x 250 mm). 
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plastic bin equipped with a Wancle Sous Vide immersion circulator.a HPLC grade acetonitrile 

(ACN) and 18 MΩ deionized water, each containing 0.1% trifluoroacetic acid, were used as the 

mobile phase at a flow rate of 5 mL/min. The filtered reaction mixture was loaded with two 4-mL 

injections onto the column while flowing 20% ACN through the column. The labeled-Aβ(C1–42) 

peptide was then purified using the following solvent gradient (Table 2.S13). The absorbance was 

taken at 214 nm. Fractions containing the monomeric labeled-Aβ(C1–42) generally eluted from 34% 

to 38% ACN.b  

Table 2.S13. HPLC solvent gradient for the purification of labeled-Aβ(C1–42) 

% H2O % ACN Elapsed Time  

80 20 0 min 

80 20 15 min 

40 65 60 min 

5 95 61 min 

5 95 80 min 
 

Characterization of Purified labeled Aβ(C1–42). The purity of each fraction was assessed 

using analytical reverse-phase HPLC. A 20-µL sample was injected onto the analytical HPLC. 

The sample was eluted at 1.0 mL/min with a 5–67% acetonitrile gradient over 15 min, at 60 °C. If 

maleimide-5-TAMRA was used as the labeling reagent, the absorbance was taken at 214 nm and 

541 nm. If maleimide-6-FAM was used as the labeling reagent, the absorbance was taken at 214 

nm and 494 nm. If maleimide-PEG2-biotin was used as the labeling reagent, the absorbance was 

taken at 214 nm. Pure fractions were combined and the purity of the combined fractions were 

 
a Any water heater large enough to submerge a HPLC column should be sufficient. 
b An increase in column back-pressure is rare after purifying the reaction mixture. If column 
maintenance is needed, please refer to the “Column Maintenance” procedures from the 
“Purification of the Aβ(C1–42) Peptide” section. 
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checked using analytical HPLC. The purities of labeled Aβ(C1–42) were determined by integration 

of the analytical HPLC trace at 214 nm (Figure 2.S10, 2.S12, and 2.S14) (Table 2.S14). The 

composition of the combined peptides was assessed by matrix-assisted laser desorption ionization 

mass spectrometry (MALDI-MS) (Figure 2.S11, 2.S13, and 2.S15). The details of running 

MALDI-MS can be found in the “Mass Spectrometry” section of the Supporting Information.  

Table 2.S14. Typical purities of labeled-Aβ(C1–42) peptides  

Labeled-Aβ(C1–42) peptides Purity 

TAMRA-Aβ(C1–42) 94.7% 

FAM-Aβ(C1–42) 94.0% 

Biotin-Aβ(C1–42) 96.6% 

 

Storage of the Purified Labeled Aβ(C1–42). The combined pure HPLC fractions of labeled-

Aβ(C1–42) were concentrated by rotary evaporation to remove ACN,a and then frozen with dry ice. 

It is recommended to combine and freeze the purified fractions within 5 hours after purification to 

avoid oxidation of methionine. The frozen sample was then lyophilized. For TAMRA- and FAM- 

labeled Aβ(C1–42), the sample should be protected from light during lyophilization process.  

Yields of Labeled Aβ(C1–42) Peptides. After the lyophilization was completed, the 

lyophilized labeled Aβ from two batches of purifications are combined, and the yields of the 

labeled peptides were assessed gravimetrically. Table 2.S15 shows the typical yields of labeled-

Aβ(C1–42) peptides per liter of bacterial culture. 

 
a The water bath for the rotary evaporator should not be heated.  
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Table 2.S15. Typical yields of labeled-Aβ(C1–42) peptides  

Labeled-Aβ(C1–42) peptides Yield (per liter of bacterial culture) 

TAMRA-Aβ(C1–42) 3.6 mg 

FAM-Aβ(C1–42) 2.6 mg 

Biotin-Aβ(C1–42) 3.0 mg 

 

HFIP Treatment of Labeled Aβ(C1–42) Peptides 

The lyophilized labeled Aβ(C1–42) peptides were then treated with HFIP to provide aliquots 

of monomeric Aβ for subsequent biophysical and biological studies. Briefly, the lyophilized 

peptide was dissolved in HFIP to give a clear solution with 0.25 mg/mL concentration of peptide. 

The peptide solution was allowed to stand without stirring or shaking at room temperature for 3 

hours. The solution was then placed on ice for an additional 30 minutes. For TAMRA-labeled 

Aβ(C1–42) and FAM-labeled Aβ(C1–42), the samples were protected from light. The Aβ(M1−42) peptide, 

which was prepared as a control, was treated in a similar fashion.a 

The chilled peptide solution was then aliquoted into microcentrifuge tubes using a single-

channel pipette.b We typically aliquot 0.02 µmol of peptide (ca. 0.1 mg) per tube, as shown in 

Table 2.S16. The tubes were then frozen in dry ice and lyophilized to remove HFIP. The 

lyophilized aliquots were stored in a desiccator at -20 °C until needed for further use. For TAMRA-

labeled Aβ(C1–42) and FAM-labeled Aβ(C1–42), the samples were protected from light.  

 
a Aβ(M1–42) is an expressed homologue with properties similar to native Aβ(1–42), which was used 
as an unlabeled Aβ control for subsequent biophysical and biological studies. Aβ(M1–42) was 
expressed, purified, and lyophilized following the protocol we published previously.1  
b It is important to chill the HFIP solution to minimize evaporation and allow dispensing with a 
single-channel pipette. Alternatively, a positive displacement pipette may be used. 
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Table 2.S16. Volumes of HFIP peptide solution per aliquot  

Peptide 
Moles of 
peptide per 
tubea 

Molecular 
weighta 

Mass of 
peptide  
per tube 

HFIP peptide 
solution 
concentration 

Volume of HFIP 
peptide solution per 
tube 

TAMRA-
Aβ(C1–42) 

0.02 µmol 

5170 g/mol 0.103 mg 

0.25 mg/mL 

412 µL 

FAM-Aβ(C1–

42) 
5116 g/mol 0.102 mg 408 µL 

Biotin-
Aβ(C1–42) 

5143 g/mol 0.103 mg 412 µL 

Aβ(M1−42) 4645 g/mol 0.093 mg 372 µL 
a Molecular weight calculated for the free peptide. If trifluoroacetate counterions are present from HPLC 
purification, then the effective molecular weight of the peptide will be higher (by ca. 10-15%, depending on the 
number of trifluoroacetate counterions per peptide), and the number of µmol of peptide per tube will be slightly 
lower (by ca. 10-15%, depending on the number of trifluoroacetate counterions per peptide). 

 

Mass Spectrometry  

Matrix-assisted laser desorption ionization mass spectrometry (MALDI-MS) and tandem 

mass spectrometry (MS/MS) were performed using an AB SCIEX TOF/TOF 5800 System. 0.5 µL 

of 2,5-dihydroxybenzoic acid (DHB) was dispensed onto a MALDI sample support, followed by 

the addition of 0.5 µL peptide sample. The mixture was allowed to air-dry. MALDI analyses were 

performed in positive reflector mode, collecting data with a molecular weight range of 1000–9000 

Da. MS/MS analysis of the Aβ(C1–42) peptide was performed using CID fragmentation of the 

precursor mass 4617 ± 2 Da. The B&Y fragment ion was calculated with fragment ion calculators. 

 

SDS-PAGE, Silver staining, and Fluorescence Imaging 

Sample Preparation and SDS-PAGE. A 0.02 μmol aliquot of labeled Aβ(C1–42) or Aβ(M1−42) 

was dissolved in 20.0 μL of DMSO first, then diluted with 13.3 µL of 10 mM sodium phosphate 

buffer (pH 7.4) to give a 600 µM peptide stock solution. 15.0 µL of the 600 µM peptide stock 

solution was serial diluted with 15.0 µL of 10 mM sodium phosphate buffer (pH 7.4) to create 15.0 
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µL of peptide stock solutions with concentrations of 300 µM to 4.7 µM. The peptide stock 

solutions were then immediately diluted with 3.0 μL of 6X SDS-PAGE loading buffer to give 18.0 

µL of peptide working solutions with concentrations from 500 µM to 3.9 µM. All 18.0 μL of each 

working solution was loaded on a 4% stacking polyacrylamide gel with a 16% running 

polyacrylamide gel. The gels were run at a constant 90 volts at room temperature for ca. 3 hours. 

For FAM-labeled Aβ(C1–42) and TAMRA-labeled Aβ(C1–42), the gels were protected from light. 

Silver Staining. Silver staining method was used to visualize the SDS-PAGE gels for 

labeled Aβ(C1–42) and Aβ(M1−42). Briefly, the gel was first rocked in fixing solution (50% (v/v) 

methanol and 5% (v/v) acetic acid in deionized water) for 20 minutes. Next, the fixing solution 

was discarded and the gel was rocked in 50% (v/v) aqueous methanol for 10 minutes. Next, the 

50% methanol was discarded and the gel was rocked in deionized water for 10 minutes. Next, the 

water was discarded and the gel was rocked in 0.02% (w/v) sodium thiosulfate in deionized water 

for 1 minutes. The sodium thiosulfate was discarded and the gel was rinsed twice with deionized 

water for 1 minute (2X). After the last rinse, the gel was submerged in chilled 0.1% (w/v) silver 

nitrate in deionized water and rocked at 4 °C for 20 minutes. Next, the silver nitrate solution was 

discarded and the gel was rinsed with deionized water for 15 seconds (2X). To develop the gel, 

the gel was incubated in developing solution (2% (w/v) sodium carbonate,a 0.04% (w/v) 

formaldehyde until the desired intensity of staining was reached (ca. 1–3 min). When the desired 

intensity of staining was reached, the development was stopped by discarding the developing 

solution and submerging the gel in 5% aqueous acetic acid. 

 
a Use of high-purity (≥99.5%) sodium carbonate is crucial for successful silver staining. 
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Fluorescence Imaging. Fluorescence imaging was also used to visualize the SDS-PAGE 

gels for TAMRA-labeled Aβ(C1–42) and FAM-labeled Aβ(C1–42). Before silver staining, the gels for 

TAMRA-labeled Aβ(C1–42) and FAM-labeled Aβ(C1–42) were imaged using a ChemiDoc Touch 

Imaging System. The gel for TAMRA-labeled Aβ(C1–42) was imaged with Krypton channel 

(excitation at ca. 530 nm, exposure time: 0.2 seconds). The gel for FAM-labeled Aβ(C1–42) was 

imaged with Fluorescein channel (excitation at ca. 490 nm, exposure time: 0.2 seconds). 

 

Thioflavin T (ThT) Assay  

ThT Solution Preparation. The ThT solution was freshly prepared and placed on ice before 

use. Briefly, a solution of ca. 40 µM ThT was prepared in a 1x PBS buffer (pH 7.4). The 

concentration of ThT in the solution was determined by UV absorbance at 412 nm using an 

estimated extinction coefficient (ε) of 36000 M−1cm−1 and adjusted to 41.7 µM. The solution was 

filtered through a 0.22 µm nylon syringe filter. The ThT solution was stored on ice and protected 

from light. 

Peptide Working Solution Preparation. A 0.02 μmol aliquot of biotin-labeled Aβ(C1–42) or 

Aβ(M1−42) was dissolved in 20 μL of DMSO first and sonicated for 30 s in a water bath, then diluted 

with 480 µL of ThT solution to give a working solution with final peptide concentration of 40 µM 

and ThT concentration of 40 µM. The peptide working solution was stored on ice and protected 

from light.  

ThT Fluorescence Assay Setup. ThT fluorescence assays were conducted in Corning® 96-

well half area black/clear flat bottom polystyrene nonbinding surface (NBS) microplates (product 

number: 3881). A 100-µL aliquot of the working solution was immediately transferred to each of 
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five wells of 96-well plate, and the plate was kept at room temperature. ThT solution was 

transferred to each of five wells of 96-well plate as negative control. The 96-well plate was sealed 

with adhesive plate sealer. The 96-well plate was immediately inserted into a Thermo Fisher 

Scientific Varioskan Lux microplate reader. The plate was incubated at 37 °C with or without 

shaking (240 rpm, low shaking force) and the ThT fluorescence was monitored (440 nm excitation, 

485 nm emission, 5 nm bandwidth) over 6 hours using the bottom-read mode. 

 

Fluorescence Suppression Assay 

Peptide Working Solution Preparation. A 0.02 μmol aliquot of TAMRA-labeled Aβ(C1–42) 

or FAM-labeled Aβ(C1–42) was dissolved in 20 μL of DMSO first and sonicated for 30 s in a water 

bath, then diluted with 480 µL of 1X PBS (pH 7.4) to give a working solution with final peptide 

concentration of 40 µM. The peptide working solution was stored on ice and protected from light.  

Fluorescence Suppression Assay Setup. Fluorescence suppression assays were conducted 

in Corning® 96-well half area black/clear flat bottom polystyrene nonbinding surface (NBS) 

microplates (product number: 3881). A 100-µL aliquot of the working solution was immediately 

transferred to each of five wells of 96-well plate, and the plate was kept at room temperature. 1X 

PBS buffer was transferred to each of five wells of 96-well plate as negative control. The 96-well 

plate was sealed with adhesive plate sealer. The 96-well plate was immediately inserted into a 

Thermo Fisher Scientific Varioskan Lux microplate reader incubated at 37°C with or without 

shaking (240 rpm, low shaking force). The fluorescence was monitored with 541 nm excitation, 

567 nm emission, 5 nm bandwidth for TAMRA-labeled Aβ(C1–42) and with 494 nm excitation, 520 

nm emission, 5 nm bandwidth for FAM-labeled Aβ(C1–42) over 6 hours using the bottom-read mode. 
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Transmission Electron Microscopy (TEM) 

Sample Preparation. A 0.02 μmol aliquot of labeled Aβ(C1–42) or Aβ(M1−42) was dissolved 

in 20 μL of DMSO first, then diluted with 480 µL of 1X PBS buffer (pH 7.4) to give a 40 µM 

peptide solution. The peptide solutions were then incubated at 37 °C for 24 hours, while shaking 

at 225 rpm. 

TEM Imaging. TEM images of Aβ peptides were taken with a JEM-2100F transmission 

electron microscope (JEOL, Peabody, MA, USA) at 200 kV with an electron dose of ca. 15 e-/A2. 

The sample was cooled at liquid nitrogen temperature through the cryostage. The images were 

recorded on a Gatan OneView CCD (Gatan, Pleasanton, CA, USA), at magnification of 30000x 

with a pixel size of 3.7 Angstrom at specimen space. The contrast and brightness of the images 

were adjusted as appropriate. 

 

Atomic Force Microscopy (AFM) 

Sample Preparation. A 0.02 μmol aliquot of labeled Aβ(C1–42) or Aβ(M1−42) was dissolved 

in 20 μL of DMSO first, then diluted with 480 µL of 1X PBS buffer (pH 7.4) to give a 40 µM 

peptide solution. The peptide solutions were then incubated at 37 °C for 21 hours, while shaking 

at 225 rpm. 

AFM Imaging. A drop of the peptide sample solution (3 μL) was deposited on freshly 

cleaved mica mounted on glass slides. After 5 minutes, the mica was gently rinsed once or twice 

with 50 μL aliquots of deionized water (18 MΩ) to remove salts. Excess liquid was blotted off by 
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Whatman filter papers and the mica was left air-dry for an additional 5 minutes, and the samples 

were imaged immediately after the mica is dry. All AFM images of Aβ peptides were taken under 

ambient condition with an Anton Paar Tosca 400 AFM instrument. Scanning parameters were as 

follows: tapping mode, setpoint at 285.6 kHz which is 5% below cantilever resonance frequency, 

scan rate at 1.0 Hz. 

 

Fluorescence Microscopy 

SH-SY5Y Cell Preparation, Treatment, and Imaging. SH-SY5Y cells were plated in an 

Ibidi µ-Slide 8 Well Chamber Slide at 20,000 cells per well. Cells were incubated in 500 µL of a 

1:1 mixture of DMEM:F12 media supplemented with 10% fetal bovine serum, 100 U/mL 

penicillin, and 100 µg/mL streptomycin at 37 °C in a 5% CO2 atmosphere and allowed to adhere 

to the bottom of the slide for 24 hours. Working solutions of FAM-Aβ and TAMRA-Aβ were 

prepared immediately prior to cell treatment by adding 10 μL of 20 mM NaOH to one aliquot of 

0.02 μmol lyophilized FAM-Aβ or TAMRA-Aβ. The resulting solution was diluted with 190 μL 

of media bringing this solution to a peptide concentration of 100 μM. An 80 μL aliquot of the 100 

μM stock solution was added to 720 μL of warmed media for a final peptide concentration of 10 

µM. After 24 hours, the media was removed from the wells and replaced with 200 μL of 1µg/mL 

Hoechst in phenol red free 1:1 DMEM:F12 media. After 30 minutes, the Hoechst-containing media 

was removed and replaced with 200 µL of 10 µM FAM-Aβ or TAMRA-Aβ. Control wells were 

treated with media containing no peptide. The slide was incubated in the microscope chamber for 

0–48 hours and imaged for the duration using a Keyence BZ-X810 fluorescence microscope. 

Images were collected with a 60x oil immersion objective lens. Fluorescence micrographs of 

treated cells were recorded using the GFP filter cube [excitation wavelength = 470/40 nm (450–
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490 nm) and emission wavelength = 525/50 nm (500–550 nm)] for FAM-Aβ, and the TexasRed 

filter cube [excitation wavelength = 560/40 nm (540–580 nm) and emission wavelength = 630/75 

nm (592.5–667.5 nm)] for TAMRA-Aβ. The image brightness of the FAM and TAMRA channels 

was adjusted using BZ-X810 Analyzer software.  

RAW 264.7 Cell Preparation, Treatment, and Imaging. RAW 264.7 cells were plated in an 

Ibidi µ-Slide 8 Well Chamber Slide at 25,000 cells per well. Cells were incubated in 500 µL of 

DMEM media supplemented with 10% fetal bovine serum at 37 °C in a 5% CO2 atmosphere and 

allowed to adhere to the bottom of the slide for 24 hours. Working solutions of FAM-Aβ and 

TAMRA-Aβ were prepared immediately prior to cell treatment by adding 10 μL of 20 mM NaOH 

to one aliquot of 0.02 μmol lyophilized FAM-Aβ or TAMRA-Aβ. This solution was diluted with 

190 μL of media for a peptide concentration of 100 μM. An 80 μL aliquot of the 100 μM stock 

solution was added to 720 μL of warmed media for a final peptide concentration of 10 μM. After 

24 hours, the media was removed from the wells and replaced with 200 μL of 1 µg/mL Hoechst in 

phenol red free 1:1 DMEM:F12 media. After 30 minutes, the Hoechst-containing media was 

removed and replaced with 200 µL of 10 µM FAM-Aβ or TAMRA-Aβ. Control wells were treated 

with media containing no peptide. The slide was incubated for 4 hours and imaged using a Keyence 

BZ-X810 fluorescence microscope. Images were collected with a 60x oil immersion objective 

lens. Fluorescence micrographs of treated cells were recorded using the GFP filter cube [excitation 

wavelength = 470/40 nm (450–490 nm) and emission wavelength = 525/50 nm (500–550 nm)] for 

FAM-Aβ, and the TexasRed filter cube [excitation wavelength = 560/40 nm (540–580 nm) and 

emission wavelength = 630/75 nm (592.5–667.5 nm)] for TAMRA-Aβ. The image brightness of 

the FAM and TAMRA channels was adjusted using BZ-X800 Analyzer software. 
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Bacteria Culturing, Treatment, and Imaging.5 B. subtilis (ATCC 6051) and E. coli (ATCC 

10798) were allowed to grow overnight (ca. 16 h) in Mueller-Hinton broth in a shaking incubator 

at 225 rpm and 37 °C. The following morning, the cultures were diluted 1:100 in the appropriate 

broth and were allowed to grow exponentially in a shaking incubator at 225 rpm and 37 °C. Once 

an OD600 of ca. 0.3 was achieved, 500 µL of bacteria was transferred to a sterile Eppendorf tube 

and the bacteria were centrifuged at 4000 rpm (1300 x G) for 5 min. 

1 mg/mL DMSO stock solutions of FAM- and TAMRA-labeled Aβ were prepared by 

dissolving a 0.02 μmol aliquot of the lyophilized peptide (ca. 0.1 mg) in 100 μL of sterile DMSO 

in an autoclaved Eppendorf tube. Solutions of labeled Aβ were protected from excessive exposure 

to light in the imaging experiments by use of an unlit biosafety cabinet and minimizing exposure 

to room lights. 

A 2% stock solution of agarose was prepared by adding 1.0 g of agarose into 50 mL of 

sodium phosphate buffer, autoclaving, and allowing the solution to cool until it completely 

solidified. While the bacteria were growing in the shaking incubator, fresh 2% agarose beds were 

prepared to immobilize bacteria for fluorescence microscopy studies as follow: On a laboratory 

bench equipped with an alcohol burner (to help maintain sterility), microscope slides were gently 

warmed on a hot plate. While the slides were gently warming, the solidified 2% agarose solution 

was heated in a microwave oven until it became a homogenous liquid. Once the microscope slides 

were warm to the touch, a 75-µL aliquot of the molten 2% agarose solution was applied to each 

microscope slide, and a No. 1.5 coverslip was immediately applied gently to the drop of agarose. 

The assembly was allowed to set for at least 45 minutes before use. 

While the bacteria were being centrifuged, 25 µg/mL solutions of FAM- and TAMRA-

labeled Aβ were freshly prepared and then used immediately to stain the bacteria. The 25 µg/mL 
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solutions were prepared by diluting 15 µL of each 1 mg/mL DMSO stock solution with 585 µL of 

sterile PBS. The diluted solutions were subsequently vortexed for 30 seconds and then used 

immediately to stain the bacteria. 

After centrifuging the bacteria (see above), the supernatant was removed, the pellet was 

resuspended in 500 µL of 25 μg/mL of the probe solution, and the bacteria were incubated in a 

shaking incubator at 225 rpm, 37 °C for 2 h. The bacteria were centrifuged at 4000 rpm (1300 x 

G) for 5 min, and the supernatant was removed. The pellet was resuspended in 500 µL of sterile 

PBS, the suspension was centrifuged at 4000 rpm (1300 x G) for 5 min, and the supernatant was 

removed. This washing process was repeated two additional times. After the last wash, the cells 

were resuspended in 200−500 µL of sterile PBS.a On a sterile bench, the coverslip of each agarose 

bed was removed, and a 5-µL aliquot of the stained bacteria was applied to the coverslip. The 

coverslip was then sandwiched on top of the agarose bed. 

The stained bacteria were immediately imaged on a Zeiss LSM 780 confocal fluorescence 

microscope. Images were collected with a 63x oil immersion objective lens, with additional optical 

zoom used as needed to provide detailed images. Fluorescence micrographs of bacteria treated 

with FAM-labeled Aβ were recorded with excitation at 488 nm and emission between 490–544 

nm. Fluorescence micrographs of bacteria treated with TAMRA-labeled Aβ were recorded with 

excitation at 561 nm and emission between 568–639 nm. The image brightness of the FAM and 

TAMRA channels were adjusted linearly using Volocity 6.3 (Quorum Technologies), and a 

medium filter in the Volocity software was used to reduce noise in all channels. 

  

 
a The volume of phosphate buffer was selected based on the size of the pellet remaining after the 
washing steps. 
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Characterization Data and Additional Figures 

Analytical HPLC Trace, MALDI Mass Spectrum, and MS/MS Spectrum of Aβ(C1–42) 

 

 

 

Figure 2.S7. Representative analytical HPLC trace of Aβ(C1–42). HPLC was performed on a C18 column at 
60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance was monitored at 214 nm. 
Purity: = 97.7%. 
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Figure 2.S8. Representative MALDI mass spectrum of Aβ(C1–42). Positive reflector mode; Matrix: 2,5-
dihydroxybenzoic acid. Exact mass calculated for M+: 4614.3; Exact mass calculated for [M+H]+: 4615.3; 
Exact mass calculated for [M+2H]2+: 2308.1. Observed [M+H]+: 4615.8; Observed [M+2H]2+: 2308.4. 
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Figure 2.S9. Representative MS/MS spectrum of Aβ(C1–42). MS/MS analysis was performed using CID 
fragmentation of the precursor mass 4617 ± 2 Da. The B&Y fragment ion was calculated with fragment ion 
calculators. The peptide sequence was determined to be 
CDAEFRHDSGYEVHHQKLVFFAEDVGSNKGAIIGLMVGGVVIA. 

  

Sequence: CDAEFRHDSGYEVHHQKLVFFAEDVGSNKGAIIGLMVGGVVIA,   pI: 5.31109 

 
Fragment Ion Table, monoisotopic masses 

 Seq    #       B            Y         # (+1) 

  C     1    104.01651   4615.28610   43  
  D     2    219.04345   4512.27691   42  
  A     3    290.08056   4397.24997   41  
  E     4    419.12316   4326.21286   40  
  F     5    566.19157   4197.17027   39  
  R     6    722.29268   4050.10185   38  
  H     7    859.35159   3894.00074   37  
  D     8    974.37853   3756.94183   36  
  S     9   1061.41056   3641.91489   35  
  G    10   1118.43203   3554.88286   34  
  Y    11   1281.49535   3497.86139   33  
  E    12   1410.53795   3334.79807   32  
  V    13   1509.60636   3205.75547   31  
  H    14   1646.66527   3106.68706   30  
  H    15   1783.72418   2969.62815   29  
  Q    16   1911.78276   2832.56924   28  
  K    17   2039.87772   2704.51066   27  
  L    18   2152.96179   2576.41570   26  
  V    19   2252.03020   2463.33163   25  
  F    20   2399.09861   2364.26322   24  
  F    21   2546.16703   2217.19481   23  
  A    22   2617.20414   2070.12639   22  
  E    23   2746.24673   1999.08928   21  
  D    24   2861.27368   1870.04669   20  
  V    25   2960.34209   1755.01974   19  
  G    26   3017.36355   1655.95133   18  
  S    27   3104.39558   1598.92987   17  
  N    28   3218.43851   1511.89784   16  
  K    29   3346.53347   1397.85491   15  
  G    30   3403.55494   1269.75995   14  
  A    31   3474.59205   1212.73848   13  
  I    32   3587.67611   1141.70137   12  
  I    33   3700.76018   1028.61731   11  
  G    34   3757.78164    915.53324   10  
  L    35   3870.86570    858.51178    9  
  M    36   4001.90619    745.42772    8  
  V    37   4100.97460    614.38723    7  
  G    38   4157.99607    515.31882    6  
  G    39   4215.01753    458.29735    5  
  V    40   4314.08594    401.27589    4  
  V    41   4413.15436    302.20748    3  
  I    42   4526.23842    203.13906    2  
  A    43   4597.27554     90.05500    1  
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Analytical HPLC Trace and MALDI Mass Spectrum of 5-TAMRA-Aβ(C1-42) 

 

 

Figure 2.S10. Representative analytical HPLC trace of 5-TAMRA-Aβ(C1-42). HPLC was performed on a 
C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance was monitored 
at 214 nm (top) and 541 nm (bottom). Purity: = 94.7%. 
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Figure 2.S11. Representative MALDI mass spectrum of 5-TAMRA-Aβ(C1-42). Positive reflector mode; 
Matrix: 2,5-dihydroxybenzoic acid. Exact mass calculated for M+: 5166.5; Exact mass calculated for 
[M+H]+: 5167.5; Exact mass calculated for [M+2H]2+: 2584.2. Observed [M+H]+: 5168.8; Observed 
[M+2H]2+: 2584.9. 
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Analytical HPLC Trace and MALDI Mass Spectrum of 6-FAM-Aβ(C1-42) 

 

 

Figure 2.S12. Representative analytical HPLC trace of 6-FAM-Aβ(C1-42). HPLC was performed on a C18 
column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance was monitored at 
214 nm (top) and 494 nm (bottom). Purity: = 94.0%. 
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Figure 2.S13. Representative MALDI mass spectrum of 6-FAM-Aβ(C1-42). Positive reflector mode; Matrix: 
2,5-dihydroxybenzoic acid. Exact mass calculated for M+: 5112.4; Exact mass calculated for [M+H]+: 
5113.4; Exact mass calculated for [M+2H]2+: 2557.2. Observed [M+H]+: 5114.6; Observed [M+2H]2+: 
2557.7. 
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Analytical HPLC Trace and MALDI Mass Spectrum of PEG2-Biotin-Aβ(C1-42) 

 

 

 

Figure 2.S14. Representative analytical HPLC trace of PEG2-biotin-Aβ(C1–42). HPLC was performed on a 
C18 column at 60 °C with elution with 5–67% acetonitrile over 15 minutes, and absorbance was monitored 
at 214 nm. Purity: = 96.6%. 
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Figure 2.S15. Representative MALDI mass spectrum of PEG2-biotin-Aβ(C1-42). Positive reflector mode; 
Matrix: 2,5-dihydroxybenzoic acid. Exact mass calculated for M+: 5139.5; Exact mass calculated for 
[M+H]+: 5140.5; Exact mass calculated for [M+2H]2+: 2570.8. Observed [M+H]+: 5140.8; Observed 
[M+2H]2+: 2570.8. 
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Figure 2.S16. ThT fluorescence assays and fluorescence suppression assays of labeled Aβ(C1–42) and 
Aβ(M1−42). (A and B) ThT fluorescence assays of Aβ(M1−42) and biotin-labeled Aβ (40 µM peptide, 40 µM 
ThT, 37 °C, 240 rpm shaking, 6 hours). (C and D) Fluorescence suppression assays of FAM-labeled Aβ 
and TAMRA-labeled Aβ (40 µM peptide, 37 °C, 240 rpm shaking, 6 hours). These assays were performed 
in five replicates (light blue, dark blue, orange, yellow, and gray). 
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Figure 2.S17. Fluorescence micrographs of labeled Aβ with mammalian cells (low magnification views). 
(A and B) SH-SY5Y neuroblastoma cells treated with FAM- and TAMRA-labeled Aβ (10 µM peptides, 37 
°C, 48 and 3 hours, respectively). Nuclei are shown in blue through DAPI staining. (C and D) RAW 264.7 
macrophage cells treated with FAM- and TAMRA-labeled Aβ (10 µM peptides, 37 °C, 4 hours).  
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Figure 2.S18. Transmission electron micrographs of the fibrils formed by Aβ peptides: (A–D) Aβ(M1−42); 
(E–H) TAMRA-labeled Aβ; (I–L) FAM-labeled Aβ; (M–P) Biotin-labeled Aβ. Fibrils were formed by 
incubating 40 µM of each peptide in PBS buffer (pH 7.4, 37 °C, 1 day, 225 rpm shaking). 
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Figure 2.S19. Atomic force micrographs of the fibrils formed by Aβ peptides: (A) Aβ(M1−42) AFM image 
and fibril height measurement data, fibril height ca. 4.5 nm; (B) TAMRA-labeled Aβ AFM image and fibril 
height measurement data, fibril height ca. 5.2 nm; (C) FAM-labeled Aβ AFM image and fibril height 
measurement data, fibril height ca. 2.3 nm; (D) Biotin-labeled Aβ AFM image and fibril height 
measurement data, fibril height ca. 4.1 nm. Fibrils were formed by incubating 40 µM of each peptide in 
PBS buffer (pH 7.4, 37 °C, 1 day, 225 rpm shaking). The red bars indicate the locations where the heights 
of the fibrils were measured. 
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Chapter 3 

 

Preparation and Studies of a Disulfide-Stapled Aβ 

that Forms Dimers but Does Not Form Fibrils 

Introduction 

Although Aβ fibrils are the most commonly found species in Alzheimer’s disease (AD) 

brains, Aβ oligomers are the key contributors to the neurodegeneration observed in AD.1–6 Small 

oligomers of Aβ have been shown to be far more neurotoxic than the large oligomers.7–9 The Aβ 

dimer has been proposed to be the basic building block of many larger Aβ oligomers and is thought 

to be one of the most neurotoxic and pathologically relevant species in AD.10–18 Aβ dimers are 

challenging to characterize and study, because Aβ oligomers are heterogenous and metastable. The 

oligomers vary in size and can rapidly aggregate into more stable fibrils.19–27 A plentiful source of 

homogenous and stable Aβ dimer would be valuable to the research in the pathogenesis of Aβ 

dimers in AD.  

Biogenic Aβ oligomers isolated from AD brains are arguably most biologically relevant, 

but the dimers and other oligomers are only present in minute concentrations and are thus difficult 

to study.7,12–15,28 For this reason, researchers have developed artificial covalent Aβ dimers by 

crosslinking Aβ monomers through several types of intermolecular crosslinkers, including 

isopeptide bond,28–30 dityrosine bond,28,29,31–33 disulfide bond,16,18,32,34–36 homocysteine-disulfide 
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bond,36 alkyl linker,36–39 4-hydroxynonenal induced crosslinking,40 and photoinduced crosslinking 

of unmodified proteins (PICUP).23,24,41–43 These covalent Aβ dimers generally aggregate further 

with time into a heterogenous mixture of larger oligomers, globulomers, protofibrils, or fibrils 

(Figure 3.1).  

Non-covalent Aβ dimers may be more biologically relevant than covalent dimers because 

they mimic native Aβ dimers that are formed through non-covalent interactions.5,31,44–46 Previous 

approaches to generate non-covalent oligomers have relied upon stabilizing intramolecular 

linkages, including intramolecular disulfide bonds and oximes, to facilitate non-covalent Aβ 

oligomer formation.47–53 The intramolecular linkages were designed to enforce a β-hairpin 

conformation, and thus promote Aβ oligomer formation and arrest Aβ in the oligomeric state. 

These modified Aβ peptides bearing intramolecular linkages formed various sizes of oligomers 

upon incubation in solution (Figure 3.1). 

 

Figure 3.1. Cartoons of covalent Aβ dimer generated by intermolecular disulfide bridges and non-covalent 
Aβ dimer generated by intramolecular disulfide bridges. 
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Although the Aβ oligomers formed by Aβ peptides bearing intermolecular or 

intramolecular linkages are often heterogenous, those artificial oligomers have proved useful in 

amyloid and Alzheimer’s disease research. These artificial oligomers have been used as chemical 

models to study Aβ peptide’s neurotoxicity,16,35–37,47,48,51 aggregation kinetics and pathways,23,24,28–

32,34,38,40,48,52 effects on behavioral deficits and neuroplasticity,18 antibody-binding activities,39,53 

and structural information.49 Although these efforts have provided useful chemical model systems, 

most of the oligomers produced are heterogenous. There are, to our knowledge, none that form 

stable homogeneous dimers. 

Our laboratory has recently developed conditions that permit the efficient expression and 

purification of Aβ42 peptides and mutants thereof. In the current study we set out to explore the 

effect of introduction of disulfide linkages into Aβ42 peptides, by preparing and studying a variety 

of mutant Aβ42 peptides containing two cysteine residues. Here, we report the discovery of 

AβC18C33, a mutant Aβ42 peptide containing a disulfide bond that forms stable homogeneous 

dimers.  

 

Results  

Design of Disulfide-Stapled Aβ Peptides. In previous studies, our laboratory has observed 

that homologous β-hairpin peptide containing different residue pairings form different types of 

oligomeric assemblies.54 Inspired by earlier studies of Aβ peptides containing disulfide linkages,47–

49,53 we expressed and purified five mutant Aβ42 peptides containing pairs of cysteine residues at 

positions 21 and 30, 18 and 33, 21 and 32, 24 and 29, and 21 and 31, respectively (Figure 3.2). 

The first of which corresponds to a peptide reported to form a mixtures of dimers and trimers in 
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SDS-PAGE and hexamers in the solid state.48,49 In each peptide, we replaced one residue from the 

hydrophobic central region of Aβ and one from the hydrophobic C-terminal region, with the goal 

of inducing β-hairpin formation with different residue pairings. 

 

Figure 3.2. Cartoons of mutant Aβ peptides that are constrained in β-hairpin conformation by 
intermolecular disulfide bridges. 

 

Preparation of Disulfide-Stapled Aβ Peptides. We prepared the recombinant plasmid 

encoding mutant Aβ peptides bearing double cysteine mutations through molecular cloning 

(Figure 3.S1 and 3.S2). We then transformed the recombinant plasmid into E. coli and express 

mutant Aβ peptides through isopropyl β-D-1-thiogalactopyranoside (IPTG) induction. After 
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expression, we lysed the cells and solubilize the inclusion bodies using urea to obtain cell lysate 

containing mutant Aβ peptides. We then added dimethyl sulfoxide (DMSO) to the cell lysate to 

oxidize the cysteines and form the intramolecular disulfide bridge in mutant Aβ peptides. Finally, 

we purified the disulfide-stapled Aβ peptides by preparative reverse-phase HPLC using a C8 

column at 80 °C with water and acetonitrile containing 0.1% trifluoroacetic acid (TFA). Each of 

the peptides contains an N-terminal methionine residue, which is associated with the start codon 

for the expression. For comparison, we also prepared Aβ(M1−42), which is a homologue of full-

length Aβ42 with properties similar to native Aβ42.55,56 

 

SDS-PAGE Studies: Discovery of the AβC18C33 Dimer. To evaluate the propensities of 

these disulfide-stapled Aβ peptides to form oligomers, we performed sodium dodecyl sulfate–

polyacrylamide gel electrophoresis (SDS-PAGE) and used silver staining to visualize the species 

formed by each of the peptides we prepared (Figure 3.3A). In the SDS-PAGE, Aβ(M1−42) runs with 

main band just above the 5 kDa ladder band, at ca. 6 kDa, that corresponds to the monomer, as 

well as a pair of weaker bands at ca. 13 and 15 kDa, which are generally attributed to trimer and 

tetramer.57,58 The previously reported AβC21C30 peptide gives a pair of bands, with similar 

appearance but slightly lower in position. These bands have previously been attributed to dimer 

and trimer.48 The AβC21C32 and AβC21C31 peptides give bands just above the 5 kDa ladder band, at 

ca. 6 kDa, and thus form monomers. The AβC24C29 peptide gives a pattern of monomer, trimer, and 

tetramer bands similar in position and appearance to those of Aβ(M1−42). The AβC18C33 peptide 

stands out among the mutant peptides, giving an intense band midway between the 10 and 15 kDa 

ladder bands, at ca. 12 kDa, which corresponds to the dimer. 
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Figure 3.3. SDS-PAGE studies of the oligomerization propensities of the disulfide-stapled Aβ peptides. 
(A) oligomerization patterns of disulfide-stapled Aβ peptides at 80 µM concentration. (B) Comparison of 
the oligomerization pattern of Aβ(M1 −42) and AβC18C33 peptides at various concentrations.  

 

To further explore the dimerization of the AβC18C33 peptide, we ran SDS-PAGE at 

concentrations ranging from 7.8 to 500 μM (Figure 3.3B). At each concentration, the dimer band 

predominates, with small bands corresponding to monomer and higher-order oligomers at higher 



138 
 

concentrations. In contrast, Aβ(M1−42) shows a predominance of the monomer at all concentrations, 

with the trimer and tetramer bands appearing at higher concentrations. 

To investigate the effect of the disulfide bond of AβC18C33 upon dimer formation, we 

reduced the disulfide bond of AβC18C33 using tris(2-carboxyethyl)phosphine hydrochloride (TCEP) 

and studied the oligomerization of the reduced AβC18C33 peptide by SDS-PAGE (Figure 3.4). The 

reduced AβC18C33 peptide shows distinct bands corresponding to monomer, dimer, trimer, and 

tetramer, at lower concentrations, as well as an additional band corresponding to the pentamer at 

higher concentrations. These results demonstrate that the disulfide bond is essential for non-

covalent dimer formation and establish that the cysteine mutations alone do not induce the 

formation of a well-defined dimer. 

 

Figure 3.4. SDS-PAGE studies of AβC18C33 before and after TCEP reduction at various concentrations.  
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MS Studies of AβC18C33. To further corroborate the formation of non-covalent dimers and 

to exclude the possibility of covalent dimer formation through a pair of intermolecular disulfide 

bonds, we performed mass spectrometry. Matrix-assisted laser desorption/ionization mass 

spectrometry shows exclusively the AβC18C33 monomer (Figure 3.S12). This observation is 

significant, because it establishes that the dimer observe for AβC18C33 in SDS-PAGE is non-

covalent, rather than a covalent dimer formation through a pair of intermolecular disulfide bonds 

or a catenane. The AβC18C33 peptide also shows monomer in the ESI mass spectrum in SEC-MS, 

eluting with ammonium formate and acetonitrile at pH 10 (Figure 3.5A). Addition of the non-ionic 

detergent dodecyl maltoside (DDM) to the SEC eluant gives a new peak in the total ion current 

chromatogram associated with the dimer (Figure 3.5B). Analysis of this peak reveals 5+ and 6+ 

ions associated with the dimer (Figure 3.5C and 3.5D). The observation of non-covalent dimers in 

SEC-MS experiments with DDM provide further evidence that AβC18C33 forms well-defined 

dimers in the presence of detergent.  
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Figure 3.5. SEC-MS studies of AβC18C33 peptide. (A) SEC chromatogram showing AβC18C33 
monomers. (B) SEC chromatogram showing the formation of AβC18C33 dimers after coincubation 
with DDM. (C) Mass spectrum of the SEC peak corresponding to AβC18C33 dimers and monomers. 
(D) A representative mass peak corresponds to 5+ ion associated with AβC18C33 dimers. 

 

To further characterize the non-covalent AβC18C33 dimers, we performed native ion 

mobility–mass spectrometry (IM-MS). In this technique, the sample is directly injected into the 

mass spectrometer, and species are separated in the gas phase on the basis of mobility. A solution 

of 25 μM AβC18C33 and 300 μM DDM in 200 mM ammonium acetate buffer pH 7.4 directly 

injected into the instrument gave an ion mobility chromatogram with two main peaks at 7.8 and 

11.1 ms, corresponding to the dimer and monomer (Figure 3.6). Analysis of the isotope patterns 

and m/z ratios confirmed that the peaks correspond to the dimer and monomer. The SEC-MS and 
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IM-MS results agree with SDS-PAGE results that AβC18C33 forms well-defined dimers in the 

presence of detergent micelles.  

 

Figure 3.6. IM-MS studies of AβC18C33 peptide. 

 

CD Studies of AβC18C33. To explore the structure of dimers formed by AβC18C33, we turned 

to circular dichroism (CD) spectroscopy. In the absence of SDS, a 30 μM solution of AβC18C33 in 

10 mM sodium phosphate buffer at pH 7.4 exhibits a broad negative band below 230 nm, with a 

shallow minimum at 203 nm (Figure 3.7A). With 20 mM SDS, the CD spectrum shows a well-

defined minimum at 212 nm and maximum at 191 nm (Figure 3.7A). These data indicate that the 

AβC18C33 peptide adopts β-sheet structure in the presence of SDS, but that random coil structure 

predominates in the absence of SDS. The spectrum in the presence of SDS differs dramatically 

from that of Aβ(M1−42), which exhibits minima at 207 and 222 nm and a maximum at 190 nm in 

SDS and thus adopts α-helical structure (Figure 3.7B). These results bring into sharp perspective 

the effect of the disulfide staple upon the conformation of AβC18C33, preventing α-helix formation 

and enforcing β-sheet formation under conditions most relevant to SDS-PAGE. 
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Figure 3.7. CD spectra of AβC18C33 (A) and Aβ(M1−42) (B) in the absence or in the presence of SDS.  

 

To gain further insight into the structure of AβC18C33 dimers under conditions relevant to 

the SEC-MS and IM-MS experiments described above, we collected CD spectra of AβC18C33 and 

Aβ(M1−42) with various concentrations of DDM. The CD spectra of AβC18C33 with DDM at 

concentrations well above the critical micelle concentration (CMC, 0.17 mM), resemble the 

spectrum of AβC18C33 with 20 mM SDS (CMC 8 mM), exhibiting a well-defined minimum at 214 

nm and maximum at ca. 190 nm (Figure 3.8A). The CD spectrum of Aβ(M1−42) with DDM shows 
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a broader minimum, centered at 215 nm, and a weaker maximum at ca.190 nm (Figure 3.8B). 

Analysis of the AβC18C33 spectra using secondary structure analysis server BeStSel59,60 shows the 

formation of ca. 50% antiparallel β-sheet structure as the concentration of DDM is raised above 

the CMC (Figure 3.8C). In contrast, the Aβ(M1−42) spectra shows only ca. 20% antiparallel β-sheet 

structure under these conditions (Figure 3.8C). These results further support a model in which the 

disulfide staple enforces a β-hairpin conformation in AβC18C33 in the membrane-like environments 

provided by detergents.48,61. 



144 
 

/  



145 
 

Figure 3.8. CD spectra of AβC18C33 and Aβ(M1−42) in the presence of DDM. (A) CD spectra of 
AβC18C33 in the presence of various concentrations of DDM. (B) CD spectra of Aβ(M1−42) in the 
presence of various concentrations of DDM. (C) Percent composition of antiparallel β-sheet 
structure of AβC18C33 and Aβ(M1−42) peptides in the presence of various concentrations of DDM. 
The CD spectra were analyzed using secondary structure analysis server BeStSel. The critical 
micelle concentration (CMC) of DDM (ca. 0.15 mM) was marked with a dashed line. 

 

ThT, TEM, AUC, and DLS Studies of AβC18C33. To determine the effect of the disulfide 

staple upon fibril formation, we performed thioflavin T (ThT) fluorescence assays. Solutions of 

AβC18C33 and Aβ(M1−42) were incubated in PBS buffer at pH 7.4 in the presence of ThT at 37 °C. 

Under these conditions, Aβ(M1−42) showed a characteristic lag time followed by a rapid onset of 

fluorescence at ca. 30 minutes (Figure 3.9B). In contrast, AβC18C33 showed no appreciable increase 

in fluorescence over 24 hours (Figure 3.9A). To rule out the possibility that the AβC18C33 peptide 

is resistant to fibrilization because of the point mutations rather than the intramolecular disulfide 

bridge, we performed a ThT assay using an AβC18C33 analogue peptide bearing double alanine 

mutations, AβA18A33. Under comparable conditions, the AβA18A33 peptide showed a lag time of ca. 

4.5 hr, followed by a rapid onset of fluorescence (Figure 3.9C). These observations demonstrate 

that the disulfide bond prevents fibril formation. The longer lag time associated with the AβA18A33 

mutant likely reflect the effect of valine-to-alanine mutation at position 18 of the critical 

17LVFFA21 amyloidogenic region of Aβ.   
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Figure 3.9. ThT fluorescence assays of (A) AβC18C33, (B) Aβ(M1−42), and (C) AβA18A33. Assays were 
performed with 40 μM Aβ and 40 μM ThT in PBS buffer at 37 °C without shaking (quiescent 
conditions). Fluorescence was monitored with 440 nm excitation and 485 nm emission. The ThT 
assays were performed in five technical replicates (purple, dark blue, red, light blue, and green).  
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We performed transmission electron microscopy (TEM) to corroborate that AβC18C33 does 

not fibrilize. Incubation of AβC18C33 at 37 °C for 24 hours in PBS buffer, followed by imaging by 

TEM, showed no fibrils (Figure 3.10A). In contrast, Aβ(M1−42) showed long fibrils, characteristic 

of Aβ (Figure 3.10B). AβA18A33 also showed fibrils, albeit shorter than the characteristic Aβ(M1−42) 

fibrils (Figure 3.10C). Upon treatment with TCEP to reduce the disulfide bond and incubation in 

PBS buffer, AβC18C33 showed fibrils (Figure 3.10D). Collectively, these results confirm that the 

intramolecular disulfide bond is critical to arresting the AβC18C33 peptide in the oligomeric state.  

 

 

 

Figure 3.10. Transmission electron micrographs of Aβ peptides: (A) AβC18C33, (B) Aβ(M1−42), (C) 
AβA18A33, and (D) AβC18C33 with TCEP. Solution of the Aβ peptides were incubated in PBS buffer 
for 24 hours at 37 °C and then imaged by TEM with uranyl acetate staining. 

 

To further evaluate the AβC18C33 peptide in aqueous solutions, we performed analytical 

ultracentfugation (AUC) and dynamic light scattering (DLS) experiments. Sedimentation velocity 

AUC experiments in 10 mM sodium phosphate buffer with 25 mM NaCl at pH 7.4 on samples of 
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AβC18C33 at 5–160 μM show distinct species with sedimentation coefficients of 0.54 and 1.01, 

which correspond to the monomer and the dimer (Figure 3.S13). Larger aggregates that settled 

rapidly were also observed to pellet in these 60,000 rpm experiments and constituted 52–76% of 

the sample. In DLS experiments, a freshly prepared solution of AβC18C33 (30 μM in 10 mM sodium 

phosphate buffer at pH 7.4) shows a peak centered at 24.4 nm (Figure 3.11). Upon incubation for 

24 hours at 37 °C, the peak shifted to 32.7 nm. These results show that AβC18C33 forms large stable 

oligomeric assemblies in aqueous solution in the absence of detergent, and are consistent with the 

pelleting observed in the AUC experiments. Monomer and dimer, which are observed in the AUC 

experiments, are likely in equilibrium with these assemblies, but are too small to be observed by 

DLS. In contrast, a freshly prepared solution of Aβ(M1−42) shows a peak centered at 58.8 nm, which 

shifts to 955 nm upon incubation for 24 hours (Figure 3.11). These observations are consistent 

with the fibril formation observed in the ThT and TEM experiments. 

 

 

Figure 3.11. Dynamic light scattering experiments of AβC18C33 and Aβ(M1−42). DLS experiments 
were performed on 30 μM solutions of the Aβ peptides in 10 mM sodium phosphate buffer at pH 
7.4. DLS data were recorded for freshly prepared solutions and then after the solutions were 
incubated for 24 hours at 37 °C. 
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Conclusion and Discussion 

AβC18C33, a double mutant of the expressed peptide Aβ(M1−42) containing a disulfide staple, 

forms stable dimers in the presence of anionic and non-ionic detergents. The dimers exhibit a high 

degree of β-sheet character and can readily be observed by SDS-PAGE and mass spectrometry. In 

aqueous buffer, the AβC18C33 peptide does not aggregate to form fibrils, but instead forms stable 

solutions of large oligomers as well as detectable monomer and dimer. The AβC18C33 is readily 

prepared by expression in E. coli and can be purified by preparative reverse-phase HPLC.  

We anticipate that AβC18C33 will be a valuable tool in biological and biophysical 

experiments, by providing ready access to stable, homogenous, non-covalent Aβ dimers. 

Oligomers of native Aβ peptides (Aβ1–40, Aβ1–42, Aβ(M1–42), etc.) are heterogeneous and prone to 

further aggregation to form fibrils. Oligomeric preparations of these peptides can thus be 

problematic to use in biological and biophysical studies. The AβC18C33 peptide provides an 

attractive alternative to these preparations, because of the stability and homogeneity of the dimers 

that it forms in membrane-like environments.  
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General information on materials and methods 

All chemicals were used as received unless otherwise noted. Deionized water (18 MΩ) was 

obtained from a Thermo Scientific Barnstead Genpure Pro water purification system. The pET-

Sac-Aβ(M1–42) plasmid was a gift from Dominic Walsh (Addgene plasmid # 71875).2 DNA 

sequences that encode AβC21C30, AβC21C32, AβC24C29, AβC21C31, and AβC18C333 were purchased in 

500 ng quantities from Genewiz. NdeI and SacI restriction enzymes, CutSmart buffer, and shrimp 

alkaline phosphatase (rSAP) were purchased from New England Biolabs (NEB). TOP10 Ca2+-

competent E. coli and BL21 DE3 PLysS Star Ca2+-competent E. coli, T4 ligase, and ethidium 

bromide were purchased from Thermo Fisher Scientific. Zymo ZR plasmid miniprep kit and 



161 
 

Zymoclean Gel DNA recovery kit was purchased from Zymo Research. Carbenicillin and 

chloramphenicol were purchased from RPI Research Products. The carbenicillin was added to 

culture media as a 1000X stock solution (50 mg/mL) in water. The chloramphenicol was added to 

culture media as a 1000X stock solution (34 mg/mL) in EtOH. Dimethyl sulfoxide (DMSO) was 

purchased from Thermo Fisher Scientific and stored in a desiccator. 3-(4,5-Dimethylthiazol-2-yl)-

2,5-Diphenyltetrazolium Bromide (MTT) reagent were purchased from Thermo Fisher Scientific. 

The concentration of the DNA sequences was measured using a Thermo Scientific 

NanoDrop spectrophotometer. E. coli were incubated in a Thermo Scientific MaxQ Shaker 6000. 

E. coli were lysed using a QSonica Q500 ultrasonic homogenizer. Analytical reverse-phase HPLC 

was performed on an Agilent 1200 instrument equipped with a Phenomonex Aeris PEPTIDE 2.6u 

XB-C18 column with a Phenomonex SecurityGuard ULTRA cartridges guard column for C18 

column. Preparative reverse-phase HPLC was performed on a Rainin Dynamax instrument SD-

200 equipped an Agilent ZORBAX 300SB-C8 semi-preparative column (9.4 x 250 mm) with a 

ZORBAX 300SB-C3 preparative guard column (9.4 x 15 mm). During purifications, the C8 

column and the guard column were heated to 80 °C in a Sterlite plastic bin equipped with a Kitchen 

Gizmo Sous Vide immersion circulator. HPLC grade acetonitrile and deionized water (18 MΩ), 

each containing 0.1% trifluoroacetic acid (TFA), were used for analytical and preparative reverse-

phase HPLC. MALDI-TOF mass spectrometry was performed using an AB SCIEX TOF/TOF 

5800 system. SEC mass spectrometry and ion mobility mass spectrometry were performed using 

Waters Synapt G2 HD system. The dynamic light scattering (DLS) experiments were performed 

in disposable cuvettes using the Malvern Zetasizer µV instrument. 
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Isolation of pET-Sac-Aβ(M1–42) plasmid  

We received the pET-Sac-Aβ(M1–42) plasmid from Addgene as bacterial stabs and 

immediately streaked the bacteria onto LB agar plates containing carbenicillin (50 mg/L). Colonies 

grew in less than 24h. Single colonies were picked and used to inoculate 5 mL of LB broth 

containing carbenicillin (50 mg/L). The cultures were shaken at 225 rpm overnight at 37˚C. To 

isolate the pET-Sac-Aβ(M1–42) plasmid, minipreps were performed using a Zymo ZR plasmid 

miniprep kit. The concentration of the plasmids was measured using a Thermo Scientific Nanodrop 

instrument.  

 

Molecular cloning  

DNA sequences encoding mutant peptides  

DNA sequences encoding mutant peptides were ordered from Genewiz. Figure 3.S1 shows the 

design of these DNA sequences. 

__ 3’ and 5’ overhangs  __ Nde1 restriction site/start codon  __ stop codons 

__  Sac1 restriction site  __ codon for cysteine __ codon for alanine 

 

Aβ(MC1–42): 5’-GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GTG TTC TTC GCT GAA GAC GTG GGT TCT AAC 
AAG GGT GCT ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG-3’ 

 

AβC21C30: 5’-GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GTG TTC TTC TGC GAA GAC GTG GGT TCT AAC 
AAG GGT TGC ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG-3’ 
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AβC21C32: 5’-GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GTG TTC TTC TGC GAA GAC GTG GGT TCT AAC 
AAG GGT GCT ATC TGC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG-3’ 

 

AβC24C29: 5’-GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GTG TTC TTC GCT GAA GAC TGC GGT TCT AAC 
AAG TGC GCT ATC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG-3’ 

 

AβC21C31: 5’-GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GTG TTC TTC TGC GAA GAC GTG GGT TCT AAC 
AAG GGT GCT TGC ATC GGT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG-3’ 

 

AβC18C333: 5’- GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG TGC TTC TTC GCT GAA GAC GTG GGT TCT AAC 
AAG GGT GCT ATC ATC TGC CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG -3’ 

 

AβA18A333: 5’- GAT ATA CAT ATG GAC GCT GAA TTC CGT CAC GAC TCT GGT TAC 
GAA GTT CAC CAC CAG AAG CTG GCT TTC TTC GCT GAA GAC GTG GGT TCT AAC 
AAG GGT GCT ATC ATC GCT CTG ATG GTT GGT GGC GTT GTG ATC GCT TAA TAG 
GAG CTC GAT CCG -3’ 

 

Figure 3.S1. Design of the DNA sequences for Aβ(MC1–42) mutants. 
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Figure 3.S2. Molecular cloning strategy for constructing recombinant plasmids of Aβ(MC1–42) 

mutants. 

Restriction enzyme digestion of pET-Sac-Aβ(M1–42) plasmid 

The pET-Sac-Aβ(M1–42) plasmid was digested using SacI and NdeI restriction enzymes. 

Table 3.S1 details the restriction reaction conditions. Reagents were added in the order they are 

listed. 

Table 3.S1. Double-digestion of the pET- Sac Aβ(M1–42) plasmid. 

Reagents Amount  

pET-Sac Aβ(M1–42)  
 

20 µL of 50 ng/uL plasmid 
solution (1.0 µg in total)  

10X CutSmart buffer 5.0 µL 

H2O 23.0 µL 

NdeI restriction enzyme 1.0 µL (1 U) 

SacI-HF restriction enzyme 1.0 µL (1 U) 

Total 50.0 µL 

Time 1.0 h 

Temperature 37.0 °C 
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Next, to prevent backbone self-ligation, the digested plasmid was treated with shrimp 

alkaline phosphatase (rSAP). Table 3.S2 details the rSAP reaction conditions.  

Table 3.S2. SAP treatment of the vectors. 

Reagents Amount  

Double-digestion mixture 50.0 µL 

rSAP 1.0 µL (1U) 

Total 51.0 µL 

Time 0.5 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 

 

After the rSAP reaction and heat inactivation were complete, the reaction mixture was 

mixed with DNA loading buffer and loaded onto a 1% agarose gel containing ethidium bromide 

(5 µL per 100 mL gel). The agarose gel was run at 100 V for ~30 min. A UV box was used to 

visualize the digested pET-Sac vector (~4500 bp), which was excised from the gel using a razor 

blade. The digested pET-Sac vector was purified from the agarose gel using a Zymoclean gel DNA 

recovery kit. The concentration of the vector after purification was measured using a Thermo 

Scientific Nanodrop instrument. The purified digested pET-Sac linear vector was used in the 

subsequent ligation step. 

The Aβ(MC1–42) mutant DNA sequences were digested using SacI and NdeI restriction 

enzymes. Table 3.S3 details the restriction reaction conditions. Reagents were added in the order 

they are listed. 
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Table 3.S3. Double-digestion of the inserts. 

Reagents Amount  

DNA sequence encoding mutation 
20 µL of 5 ng/µL DNA 

solution (100.0 ng in total) 

10X CutSmart buffer 2.5 µL 

H2O 1.5 µL 

NdeI restriction enzyme 0.5 µL (0.5 U) 

SacI-HF restriction enzyme 0.5 µL (0.5 U) 

Total 25.0 µL 

Time 1.0 h 

Temperature 37.0 °C 

Heat inactivation 65.0 °C for 20 min 

 

T4 ligation of the Aβ(MC1–42) mutant DNA sequence and the linear digested pET-Sac vector 

The inserts and the vectors were ligated together using T4 ligase. Table 3.S4 details the T4 

ligation reaction conditions. Reagents were added in the order they are listed. 

Table 3.S4. T4 ligation of the inserts and the vectors. 

Reagents 

Amount 
Insert:Vector = 0:1  

(molar ratio)  
(negative control) 

Insert:Vector = 5:1  
(molar ratio) 

Vector 
9.1 µL of 6.6 ng/µL DNA 
solution (60.0 ng in total) 

9.1 µL of 6.6 ng/µL DNA 
solution (60.0 ng in total) 

Insert --- 
2.5 µL of 4.0 ng/µL DNA 
solution (10.0 ng in total) 

10X T4 DNA 
ligase reaction 
buffer 

2.0 µL 2.0 µL 

T4 DNA ligase 1.0 µL 1.0 µL 

H2O 7.9 µL  5.4 µL 
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Total 20.0 µL 20.0 µL 

Ligation time 10 min 

Temp 22.0 °C (room temperature) 

Heat inactivation 65.0 °C for 10 min 

 

2 µL of the ligation reaction mixture was then transformed into TOP10 Ca2+-competent E. 

coli using the heat shock method. The cell cultures were spread on LB agar plates containing 

carbenicillin (50 mg/L). Single colonies were picked to inoculate 5 mL of overnight cultures in 

LB media with carbenicillin (50 mg/L). The plasmids were extracted from TOP10 cells using 

Zymo ZR plasmid miniprep kit. The concentration of the plasmids was measured through Thermo 

Scientific NanoDrop spectrophotometer. The DNA sequences of the recombinant Aβ(MC1–42) 

plasmid was verified by DNA sequencing. 

 

Bacterial expression of Aβ(M1–42) mutant peptides  

Transformation and expression of Aβ(M1–42) mutant peptides  

All liquid cultures were performed in culture media (LB broth containing 50 mg/L 

carbenicillin and 34 mg/L chloramphenicol). Aβ(MC1–42) mutant plasmid was transformed into 

BL21 DE3 PLysS Star Ca2+-competent E. coli through heat shock method. The cell cultures were 

spread on LB agar plates containing carbenicillin (50 mg/L) and chloramphenicol (34 mg/L). 

Single colonies were picked to inoculate 5 mL of culture media for overnight culture. [A glycerol 

stock of BL21 DE3 PLysS Star Ca2+-competent E. coli bearing the plasmids was made, and the 

future expressions were started by inoculating culture media with an aliquot of the glycerol stock.] 
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The next day, all 5 mL of the overnight culture were used to inoculate 1 L of culture media. After 

inoculation, the culture was shaken at 225 rpm at 37 ˚C until the cell density reached an OD600 of 

approximately 0.45. Protein expression was then induced by the addition of isopropyl β-D-1-

thiogalactopyranoside (IPTG) to a final concentration of 0.1 mM, and the cells were shaken at 225 

rpm at 37 °C for 4 h with IPTG.  The cells were then harvested by centrifugation at 4000 rpm using 

a JA-10 rotor (2800 x g) at 4 ˚C for 25 min, and the cell pellets were then stored at -80°C.  

 

Cell lysis, inclusion body preparation, and disulfide bond formation by DMSO 

To lyse the cells, the cell pellet was resuspended in 20 mL of buffer A (10 mM Tris/HCl, 

1 mM EDTA, pH 8.0) and sonicated for 2 min on ice (50% duty cycle) until the lysate appeared 

homogenous. The lysate was then centrifuged for 25 min at 16000 rpm using a JA-18 rotor (38000 

x g) at 4˚C. The supernatant was removed, and the pellet was resuspended in buffer A, sonicated 

and centrifuged as described above. The sonication and centrifugation steps were repeated three 

times. After the last round of sonication and centrifugation, the supernatant was removed, the 

remaining pellet was resuspended in 15 mL of freshly prepared buffer B (8 M urea, 10 mM 

Tris/HCl, 1 mM EDTA, pH 8.0), and was sonicated as described above, until the solution became 

clear. The solution was diluted with 10 mL of buffer A, and 5 mL of DMSO was added to the 

solution. The resulting mixture (30 mL) was incubated on a shaker at room temperature for 2-6 

days. 
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Purification of Aβ(M1–42) mutant peptides 

The reaction mixture was titrated with 1M NaOH to a pH of ~10.5, and was filtered through 

a Fisher Brand 0.22 µm non-sterile hydrophilic PVDF syringe filter (Catalog No. 09-719-00). 

After filtering, the solution was titrated with 1M HCl to pH ca. 8.0. Successful expression of the 

Aβ(M1–42) mutant peptide was confirmed by analytical reverse-phase HPLC as follows: A 20-µL 

sample of the above solution was injected onto an Agilent 1200 instrument equipped with a 

Phenomonex Aeris PEPTIDE 2.6u XB-C18 column with a Phenomonex SecurityGuard ULTRA 

cartridges guard column for C18 column. HPLC grade acetonitrile (ACN) and 18 MΩ deionized 

water, each containing 0.1% trifluoroacetic acid, were used as the mobile phase. The sample was 

eluted at 1.0 mL/min with a 5–100% acetonitrile gradient over 20 min at 35 °C.  

Aβ(M1–42) mutant peptides were then purified by preparative reverse-phase HPLC equipped 

with an Agilent ZORBAX 300SB-C8 semi-preparative column (9.4 x 250 mm) with a ZORBAX 

300SB-C3 preparative guard column (9.4 x 15 mm). The C8 column and the guard column were 

heated to 80 °C in a water bath. HPLC grade acetonitrile (ACN) and 18 MΩ deionized water, each 

containing 0.1% trifluoroacetic acid, were used as the mobile phase at a flow-rate of 5 mL/min. 

The peptide solution was split into two ca. 15 mL batches and purified in two separate runs, with 

four injections in each run. In each run, the peptide was loaded onto the column by flowing 20% 

ACN for 15 min and then eluted with a gradient of 20–40% ACN over 20 min. Fractions containing 

the monomer generally eluted from 34% to 38% ACN. After the peptide was collected, the column 

was washed by flushing with 100% isopropanol for 15 minutes. This cleaning procedure ensures 

elution of the peptide that is retained in the column and avoids problems of cross-contamination 

between runs.  
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The purity of each fraction was assessed using analytical reverse-phase HPLC. A 20-µL 

sample was injected onto the analytical HPLC. The sample was eluted at 1.0 mL/min with a 5–

100% acetonitrile gradient over 20 min, at 35 °C. Pure fractions were combined and the purity of 

the combined fractions were checked using analytical HPLC. The combined fractions were 

concentrated by rotary evaporation to remove ACN, and then frozen with dry ice, liquid nitrogen, 

or a -80 °C freezer. [It is recommended to combine and freeze the purified fractions within 5 hours 

after purification to avoid oxidation of methionine.] The frozen sample was then lyophilized to 

give a fine white powder.  

NaOH treatment and peptide concentration determination 

The lyophilized peptide was then dissolved in 2 mM NaOH to achieve a concentration of 

~0.5 mg/mL. The pH was adjusted by addition of 0.1 M NaOH to give a solution of pH ~10.5. The 

sample was sonicated in a water ultrasonic bath at room temperature for 1 min or until the solution 

became clear. The concentration of the peptide was determined by absorbance at 280 nm using the 

extinction coefficient (ε) for tyrosine of 1490 M−1cm−1 (c = A/1490). The peptide solution was 

then aliquoted into 0.020 µmol aliquots in 0.5 mL microcentrifuge tubes. The aliquots were 

lyophilized and then stored in a desiccator at -20 °C for future use. 

 

SDS-PAGE 

The concentrations of the peptide working solutions vary for different SDS-PAGE assays. 

Here we provide a general procedure for the SDS-PAGE assays we conducted in this chapter. For 

the sample preparation, a 0.02 μmol aliquot of peptide was dissolved in 208.4 µL of deionized 
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water to give a 96 µM peptide stock solution. A 20 μL aliquot of the 96 µM peptide stock solution 

and 4 μL of 6X SDS-PAGE loading buffer (100 mM Tris buffer at pH 6.8, 20% (v/v) glycerol, 

and 4% w/v SDS) was then combined to give a 24 µL of peptide working solution with a 

concentration of 80 µM. A 10 μL aliquot of the working solution was run on a 16% polyacrylamide 

gel with a 4% stacking polyacrylamide gel. The gels were run at a constant 90 volts at room 

temperature. 

Staining with silver nitrate was used to visualize peptides in the SDS-PAGE gel. Briefly, 

the gel was first rocked in fixing solution (50% (v/v) methanol and 5% (v/v) acetic acid in 

deionized water) for 20 min. Next, the fixing solution was discarded and the gel was rocked in 

50% (v/v) aqueous methanol for 10 min. Next, the 50% methanol was discarded and the gel was 

rocked in deionized water for 10 min. Next, the water was discarded and the gel was rocked in 

0.02% (w/v) sodium thiosulfate in deionized water for 1 min. The sodium thiosulfate was 

discarded and the gel was rinsed twice with deionized water for 1 min (2X). After the last rinse, 

the gel was submerged in chilled 0.1% (w/v) silver nitrate in deionized water and rocked at 4 °C 

for 20 min. Next, the silver nitrate solution was discarded and the gel was rinsed with deionized 

water for 1 min (2X). To develop the gel, the gel was incubated in developing solution (2% (w/v) 

sodium carbonate, 0.04% (w/v) formaldehyde until the desired intensity of staining was reached 

(~1–3 min). When the desired intensity of staining was reached, the development was stopped by 

discarding the developing solution and submerging the gel in 5% aqueous acetic acid. 

 

Thioflavin T (ThT) fibrillization assay 

 ThT Solution Preparation. The ThT solution was freshly prepared and placed on ice before 
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use. Briefly, a solution of ca. 40 μM ThT was prepared in a 1x PBS buffer (pH 7.4). The 

concentration of ThT in the solution was determined by UV absorbance at 412 nm using an 

estimated extinction coefficient (ε) of 36000 M−1cm−1 and adjusted to 41.7 μM. The solution was 

filtered through a 0.22 μm nylon syringe filter. The ThT solution was stored on ice and protected 

from light. 

Peptide Working Solution Preparation. A 0.02 μmol aliquot of Aβ peptide was dissolved in 

500 μL of ThT solution to give a working solution with final peptide concentration of 40 μM and 

ThT concentration of 40 μM. The peptide working solution was stored on ice and protected from 

light. 

ThT Fluorescence Assay Setup. ThT fluorescence assays were conducted in Corning® 96- 

well half area black/clear flat bottom polystyrene nonbinding surface (NBS) microplates (product 

number: 3881). A 100-μL aliquot of the working solution was immediately transferred to each of 

five wells of 96-well plate, and the plate was kept at room temperature. ThT solution was 

transferred to each of five wells of 96-well plate as negative control. The 96-well plate was sealed 

with adhesive plate sealer. The 96-well plate was immediately inserted into a Thermo Fisher 

Scientific Varioskan Lux microplate reader. The plate was incubated at 37 °C without shaking and 

the ThT fluorescence was monitored (440 nm excitation, 485 nm emission, 5 nm bandwidth) over 

24 hours using the bottom-read mode. 

 

Dynamic light scattering (DLS) 

A 30 µM solution of Aβ peptide was freshly prepared in 10 mM sodium phosphate buffer 

(pH 7.4) , or incubated in the buffer at 37 °C for 24 hours with 225 rpm shaking. The dynamic 
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light scattering (DLS) experiments were performed in disposable cuvettes using the Malvern 

Zetasizer µV instrument at 25 °C. Scattering data were collected as an average of 10 scans for each 

measurement.  

 

Circular dichroism (CD) 

A 30 µM solution of Aβ peptide was freshly prepared in 10 mM sodium phosphate buffer 

with or without detergent (pH 7.4). CD spectra were acquired on a Jasco J-810 circular dichroism 

spectropolarimeter at room temperature. The instrumental parameters to record the CD spectra 

were: 260 nm to 190 nm measurement range, 1 nm data pitch, 2 nm band width, standard 

sensitivity, 50 nm/min of scanning speed. The data were averaged over 3 accumulations with 21-

point smoothing. The CD spectra were analyzed using secondary structure analysis server BeStSel. 

 

Mass spectrometry  

Matrix-assisted laser desorption/ionization mass spectrometry (MALDI-MS) was 

performed using an AB SCIEX TOF/TOF 5800 System. 0.5 µL of sinapinic acid (SA) or 2,5-

dihydroxybenzoic acid (DHB) was dispensed onto a MALDI sample support, followed by the 

addition of 0.5 µL peptide sample. The mixture was allowed to air-dry. All analyses were 

performed in positive reflector mode, collecting data with a molecular weight range of 1500–8000 

Da or 1800–10000 Da. 

Size exclusion chromatography-mass spectrometry (SEC-MS) was performed using a 

Waters Synapt G2 system. Aβ peptide was dissolved in 10 mM ammonium acetate buffer with or 
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without 0.4 mM n-Dodecyl β-D-maltoside (DDM) (pH 7.3) to a final peptide concentration of 0.25 

mg/mL and incubated at 37 °C for 2 hours. 2 µg of Aβ peptide was injected on the SEC column 

and the SEC was run in 1:1 ammonium formate: acetonitrile running buffer (pH 10.0). 

Ion mobility mass spectrometry (IM-MS) was performed using a Waters Synapt G2 

system. Aβ peptide was dissolved in 200 mM ammonium acetate buffer containing 0.3 mM DDM 

(pH 7.4) to a final concentration of 25 µM. 40 µL of the 25 µM peptide solution was then 

immediately injected on the IM-MS system.  

 

Transmission electron microscopy (TEM) 

TEM images of Aβ peptide were taken with a JEM-2100F transmission electron 

microscope (JEOL, Peabody, MA, USA) at 200 kV with an electron dose of approximately 15 e-

/A2. The microscope was equipped with Gatan K2 Summit direct electron detector (Gatan, 

Pleasanton, CA, USA) at 15,000x or 25,000x magnification. The sample was cooled at liquid 

nitrogen temperature through the cryostage. Contrast and brightness of the images were adjusted 

as appropriate. 
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Characterization Data and Additional Figures 

 

Figure 3.S3. An analytical HPLC trace of AβC21C30 peptide. Temperature: 35.0 °C. Sample purity: 97.5 
%. 
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Figure 3.S4. An analytical HPLC trace of AβC21C32 peptide. Temperature: 35.0 °C. Sample purity: 98.3 
%. 
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Figure 3.S5. An analytical HPLC trace of AβC24C29 peptide. Temperature: 55.0 °C. Sample purity: 96.2 
%. 
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Figure 3.S6. An analytical HPLC trace of AβC21C31 peptide. Temperature: 55.0 °C. Sample purity: 96.1 
%. 

 

 

 

 

 

 



179 
 

 

 

 

Figure 3.S7. An analytical HPLC trace of AβC18C33 peptide. Temperature: 35.0 °C. Sample purity: 97.9 
%. 
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Figure 3.S8. MALDI-TOF mass spectra of AβC21C30 peptide. Positive reflector mode. Matrix: 2,5-
dihydroxybenzoic acid. Exact mass: 4704.2; Observed [M+H]+: 4705.6637; Observed [M+2H]2+: 
2353.4552.  
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Figure 3.S9. MALDI-TOF mass spectra of AβC21C32 peptide. Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid. Exact mass: 4662.2; Observed [M+H]+: 4663.6112; Observed 
[M+2H]2+: 2332.4307.  
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Figure 3.S10. MALDI-TOF mass spectra of AβC24C29 peptide. Positive reflector mode. Matrix: 2,5-
dihydroxybenzoic acid. Exact mass: 4690.2; Observed [M+H]+: 4691.6955; Observed [M+2H]2+: 
2346.4663.  
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Figure 3.S11. MALDI-TOF mass spectra of AβC21C31 peptide. Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid. Exact mass: 4662.2; Observed [M+H]+: 4663.7105; Observed 
[M+2H]2+: 2332.4739.  
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Figure 3.S12. MALDI-TOF mass spectra of AβC18C33 peptide. Positive reflector mode.  

Matrix: 2,5-dihydroxybenzoic acid. Exact mass: 4690.2; Observed [M+H]+: 4690.8746; Observed 
[M+2H]2+: 2346.0047.  
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Figure 3.S13. Analytical ultracentrifugation studies of AβC18C33 peptide. The studies were performed by 
collaborator Dr. Borries Demeler. 
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Chapter 4a 

 

Structure-Based Drug Design of an Inhibitor of 

the SARS-CoV-2 Main Protease 

 

Introduction  
 

SARS-CoV-2 is a highly infectious virus that causes COVID-19, a serious respiratory 

infection that has caused over 178 million infections and over 3.8 million deaths worldwide as of 

June 2021.1 SARS-CoV-2 causes infected cells to express a main protease (Mpro or 3CL protease) 

that is responsible for site-specifically cleaving the polyprotein, which is translated from viral 

mRNA within human cells. The proteolytic activity of Mpro is essential for the virus to generate 

the individual proteins that are necessary for replication and infection. The essential role of Mpro, 

as well as the success of HIV protease inhibitors in the treatment of HIV/AIDS, make Mpro an 

attractive therapeutic target to treat COVID-19.2–7.  

Proteases are enzymes that cleave polypeptide chains, hydrolyzing an amide bond within 

the polypeptide chain. Once the polypeptide is bound within the active site of the protease, the 

 
a This chapter is adapted from Zhang, S.; Krumberger, M.‡; Morris, M. A.‡; Parrocha, C. M. T.; Kreutzer, A. G.; 
Nowick, J. S. Eur. J. Med. Chem. 2021, 218, 11390. 
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scissile amide bond is hydrolyzed to generate a carboxylic acid and amine (Figure 4.1A). The 

binding pockets of a protease are referred to as subsites, denoted by “S”. Typically, each subsite 

interacts with a specific side chain of the polypeptide substrate, denoted by “P”. The position at 

which the polypeptide substrate is cleaved determines the assignment of prime or no-prime 

notation. Prime notation refers to the C-terminal side and no-prime notation refers to the N-

terminal side of the polypeptide and corresponding pockets (Figure 4.1B). 

 

 

Figure 4.1. A: Amide bond hydrolysis by a protease enzyme. B: Binding of a protease to a polypeptide 
substrate. The side chains of the protein (P1, P2, P3, etc. and P1’, P2’, P3’, etc.) fit into pockets of the 
enzyme (S1, S2, S3, etc. and S1’, S2’, S3’, etc.). The scissile bond is designated with a wavy red line. This 
figure was prepared by Dr. Michael Morris. 
 

SARS-CoV-2 Mpro is a member of the class of enzymes called cysteine proteases. These 

proteases usually contain a catalytic dyad of cysteine and histidine residues in the active site, which 

catalyze the cleavage of polypeptides, as shown below. The histidine deprotonates the cysteine 

thiol to give a nucleophilic thiolate, which adds to the amide carbonyl of the substrate to form a 

tetrahedral intermediate. The tetrahedral intermediate then breaks down to give a thiol ester and 
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an amine. The electrophilic thiol ester is then hydrolyzed by water to give a carboxylic acid, thus 

completing the cleavage of the polypeptide substrate and regenerating the active enzyme (Figure 

4.2). 
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Figure 4.2. Proteolysis mechanism by the catalytic dyad of Mpro. This figure was prepared by Dr. Michael 
Morris. 
 

In this chapter, we will use the X-ray crystallographic structure of the homologous SARS-

CoV Mpro bound to a protein substrate to recapitulate the design of a cyclic peptide inhibitor of the 

SARS-CoV-2 Mpro.8 We will first use the molecular modeling software UCSF Chimera to visualize 

the X-ray crystallographic structure of the SARS-CoV Mpro bound to the protein substrate.9 We 

will then modify the protein substrate to create a model of the cyclic peptide inhibitor within the 

SARS-CoV Mpro. Finally, we will use AutoDock Vina to evaluate this model, by docking the 

inhibitor to SARS-CoV Mpro and then to SARS-CoV-2 Mpro.10 We have selected these software 

packages, because they can be downloaded without cost and are easy to learn.11–13 These and other 

molecular modeling studies helped our laboratory decide to pursue the synthesis of the cyclic 

peptide and experimentally evaluate its promise as an inhibitor of SARS-CoV-2 Mpro. In an 

accompanying paper, we describe the synthesis of the cyclic peptide and the experimental 

validation as an inhibitor of SARS-CoV-2 Mpro.8  

Here, we provide the rationale and then overview the process of designing the inhibitor 

with UCSF Chimera and evaluating it with AutoDock Vina. In the supporting information, we 

provide an illustrated step-by-step protocol showing the inhibitor design process to teach others 

how to execute the design process. We anticipate this chapter will help students and scientists use 

free software to design their own drug candidates for COVID-19 and the coronaviruses that will 

cause future pandemics.  

 

Results and Discussion 

Selecting a starting structure for inhibitor design. The design of the cyclic peptide 

inhibitor begins with the X-ray crystallographic structure of SARS-CoV Mpro (C145A) [Protein 
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Data Bank (PDB) ID: 5B6O].14 The SARS-CoV Mpro is 96% identical to the SARS-CoV-2 Mpro, 

and thus provides a good starting point for the design of inhibitors of SARS-CoV-2 Mpro.7 In this 

crystal structure, the C-terminal fragment of one Mpro molecule extends into the active site of an 

adjacent Mpro molecule. The C-terminal fragment would normally be cleaved by SARS-CoV Mpro, 

and thus the inactive C145A mutant provides a snapshot of the enzyme bound to one of its 

substrates. Molecules that mimic the C-terminal fragment, but are resistant to proteolysis, may 

serve as inhibitors that block viral replication.  

Modifying the C-terminal fragment of SARS-CoV Mpro to create a cyclic peptide 

inhibitor. We begin the procedures by displaying the C-terminal fragment of the Mpro (substrate) 

as sticks and the adjacent Mpro protein as a van der Waals surface, to visualize how the substrate 

fits into the binding pockets of the protein active site. The substrate adopts a kinked conformation, 

in which the phenyl group of Phe 309 points toward the backbone of Phe 305. The proximity of 

Phe 309 and Phe 305 inspired us to connect the phenyl group of the Phe 309 with the backbone of 

Phe 305 to form a cyclic peptide (Figure 4.3). By cyclizing the linear substrate, we aim to lock the 

peptide substrate into its bound conformation and increase its stability toward proteolysis. 

Furthermore, cyclic peptides often exhibit greater cell permeability than the corresponding linear 

analogues, which is critical because Mpro constitutes an intracellular target.15–20 
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Figure 4.3. The interaction between the substrate (sticks) and the active site of the protein (grey surface). 
The green oval illustrates the concept of connecting the phenyl group of Phe 309 to the backbone of Phe 
305.  
 

To create the cyclic peptide, we delete Ser 301, Gly 302, Val 303, Thr 304 (except for the 

carbonyl group), Lys 310, and the carbonyl group of Phe 309, as these fragments are not needed 

in the cyclic peptide (Figure 4.4A). We then add a methylene (CH2) group at the para position of 

Phe 309 by building a tetrahedral methyl group (CH3) in UCSF Chimera and then deleting one of 

the hydrogen atoms of the methyl group (Figure 4.4B).  

We next prepare to connect the Thr 304 carbonyl carbon to the newly built CH2 group, and 

thus cyclize the substrate. In UCSF Chimera, when the new bond is formed, it must not cross other 

atoms or bonds, otherwise subsequent structural minimization will fail. We rotate the backbone 

Cα–N bond of Gln 306 to bring the Thr 304 carbonyl carbon close to the CH2 group, to avoid 

crossing other atoms or bonds when building the new C–C bond (Figure 4.4C). We cyclize the 

substrate by building a C–C bond between the Thr 304 carbonyl carbon and the CH2 carbon. In 

cyclizing the substrate, we have built an unnatural amino acid residue — [4-(2-

aminoethyl)phenyl]-acetic acid (AEPA) — from Phe 309 and Thr 304. The resulting cyclic peptide 

contains a β-turn comprising Phe 305 and Gln 306 (Figure 4.4D). We envision that hydrogen 

bonding within this β-turn might provide additional conformational rigidity to the cyclic peptide. 
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Figure 4.4. Building the cyclic peptide. A: The structure of the substrate after deleting extraneous 
fragments. B: Adding a CH2 group at the para position of Phe 309. C: Rotating the backbone Cα–N bond 
of Gln 306 to bring the Thr 304 carbonyl carbon close to the CH2 group. D: Building a C–C bond between 
the Thr 304 carbonyl carbon and the CH2 carbon. 
 

Geometry optimization of the cyclic peptide inhibitor. At this point, the bond lengths, 

angles, and dihedral angles of the newly built cyclic peptide are not optimal. We are now ready to 

allow the cyclic peptide to relax to a low-energy conformation (local minimum) within the active 

site of the SARS-CoV Mpro. We use the “minimize structure” tool to optimize the geometry of the 

cyclic peptide while holding the structure of Mpro fixed.a The minimized structure (Figure 4.5A) 

has more reasonable bond lengths, angles, and dihedral angles than the structure prior to 

minimization (Figure 4.4D), with Phe 305 and Gln 306 forming a hydrogen-bonded β-turn.  

 

 
a In preparing the structure for geometry optimization, hydrogens are added to the protein and the inhibitor. The 

addition of hydrogens causes the color of portions of the surface to change from grey to tan. 
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Figure 4.5. Geometry optimization of the cyclic peptide inhibitor. A: The structure of the Gly 307 cyclic 
peptide after geometry optimization.21 B: Gly 307 has been mutated to Ser. C: The structure of the Ser 307 
cyclic peptide inhibitor after geometry optimization. D: The chemical structure of the Ser 307 cyclic peptide 
inhibitor. 

 

To introduce additional conformational rigidity, we mutate Gly 307 to Ser, which is the 

most common residue at the P1’ position of SARS-CoV-2 Mpro substrates (Figure 4.5B). UCSF 

Chimera allows this point mutation to be achieved with a single command. After the point 

mutation, we perform a second round of geometry optimization to clean up the structure and afford 

a hypothesized structure of the cyclic peptide inhibitor (Figure 4.5C). Figure 4.5D illustrates the 

chemical structure of the cyclic peptide inhibitor, which we term UCI-1 (University of California, 

Irvine Coronavirus Inhibitor-1).8  

Docking the inhibitor to SARS-CoV Mpro and SARS-CoV-2 Mpro. In structure-based 

drug design, we would typically now synthesize the cyclic peptide inhibitor and evaluate its 

activity experimentally through studying its ability to block the cleavage of a fluorogenic peptide 

substrate by SARS-CoV-2 Mpro. We would also attempt to co-crystalize the inhibitor with the Mpro 

to experimentally evaluate the structure hypothesized in Figure 5C. Using the co-crystal structure 

and additional structure-activity studies, we would then carry out iterative rounds of modification 

and optimization of the cyclic peptide inhibitor to achieve higher affinity and specificity for SARS-

CoV-2 Mpro. 

Since this is exclusively a computational study, we will use the molecular docking software 

AutoDock Vina in place of these experimental studies. UCSF Chimera enables AutoDock Vina to 

be used as a plugin, which allows us to conveniently perform molecular docking and view the 
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docking results in UCSF Chimera.a We will first evaluate the ability of the cyclic peptide inhibitor 

to bind the SARS-CoV Mpro in silico and thus test our cyclic peptide inhibitor design. We will then 

evaluate the ability of the cyclic peptide inhibitor to bind SARS-CoV-2 Mpro in silico to test our 

inhibitor against the relevant target of COVID-19. 

In the first molecular docking exercise, we dock the geometry-optimized cyclic peptide 

inhibitor to the SARS-CoV Mpro structure (PDB 5B6O), which we have already used for the 

inhibitor design.14 We start by defining a receptor search region to which AutoDock Vina will 

dock the inhibitor. The receptor search region should thus include the active site of the SARS-CoV 

Mpro. To facilitate identification of the active site, we highlight several residues in the active site 

in red (Cys 38, Cys 44, Met 49, Met 165, and His 41) and then set a grid box which engulfs all of 

the active site as the search region (Figure 4.6A). After the molecular docking is complete, we get 

five docked structures, with energy scores of -10.5, -8.0, -7.8, -7.7, and -7.6 kcal/mol. In the lowest 

energy structure, the inhibitor fits well in the active site of SARS-CoV Mpro. The P2 (Phe), P1 

(Gln), P1’ (Ser), and P2’ (Lys) side chains of the inhibitor occupy the S2, S1, S1’, and S2’ pockets, 

and the AEPA residue occupies the S3’ pocket (Figure 4.6B). This docking result demonstrates 

that the cyclic peptide inhibitor has the potential to bind to SARS-CoV Mpro.  

 
a UCSF Chimera provides a graphical user interface for the AutoDock Vina plugin, which allows the user to avoid 
command-line programming required by the free-standing AutoDock Vina application. 



197 
 

 

Figure 4.6. Molecular docking of the geometry-optimized cyclic peptide inhibitor to SARS-CoV Mpro. A: 
The region to which AutoDock Vina will perform molecular docking is defined using a grid box 
encompassing the active site of SARS-CoV Mpro. B: After molecular docking, the lowest energy 
conformation of the cyclic peptide inhibitor fits in the active site of SARS-CoV Mpro.  

 

In the second molecular docking exercise, we dock the geometry-optimized cyclic peptide 

inhibitor to a recently published crystal structure of SARS-CoV-2 Mpro (PDB 6YB7).21 We load 

the SARS-CoV-2 Mpro structure using the “fetch PDB” function in UCSF Chimera, and conduct 

molecular docking in a similar fashion to the previous exercise (Figure 4.7A). After the molecular 

docking is complete, we get ten docked conformations with energy scores of -8.1, -7.8, -6.8, -6.5, 

-6.5, -6.4, -6.4, -6.4, -6.2, and -5.6 kcal/mol. Although the lowest energy structure only partially 
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fits into the active site of SARS-CoV-2 Mpro, the second lowest energy structure of the inhibitor 

fits better in the active site. The P2 (Phe), P1 (Gln), P1’ (Ser), and P2’ (Lys) side chains of the 

inhibitor occupy the S1, S1’, S2, and S2’ pockets, while the AEPA residue sits near the S3’ pocket 

(Figure 4.7B). This docking result suggests that the cyclic peptide inhibitor that we designed based 

on SARS-CoV Mpro bound to a protein substrate might be repurposed to target SARS-CoV-2 Mpro.  

 

Figure 4.7. Molecular docking of the geometry-optimized cyclic peptide inhibitor to SARS-CoV-2 Mpro . 
A: The region to which AutoDock Vina will perform molecular docking is defined using a grid box 
encompassing the active site of SARS-CoV-2 Mpro. B: After molecular docking, the second lowest energy 
conformation of the cyclic peptide inhibitor fits in the active site of SARS-CoV-2 Mpro. 
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Conclusions 

UCSF Chimera and AutoDock Vina allow the structure-based design of inhibitors of 

SARS-CoV-2 Mpro as potential drug candidates. Using publicly available X-ray crystallographic 

structures and free software, anybody can unleash their imagination and try to invent new 

molecules that might help treat or prevent COVID-19 or other diseases. This chapter demonstrates 

the process and provides a simple example of how a published X-ray crystallographic structure 

can be modified and manipulated with the goal of creating molecules to bind and block a critical 

enzyme. This chapter can also be adapted to design inhibitors of other enzymes (e.g., HIV 

protease) from an X-ray crystallographic or NMR-based structure of an enzyme complex.22–28 We 

hope that this chapter will help students and scientists design their own inhibitors of SARS-CoV-

2 Mpro or other drug targets to help discover drugs for the treatment of COVID-19 and other 

diseases. 
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1. General notes 

1.1. Here we present the illustrated step-by-step protocol of our inhibitor design, geometry 

optimization, and molecular docking process. This protocol has been tested on both 

Windows (Windows 10) and Mac (MacOS Catalina) operating systems. The UCSF 

Chimera user interface is virtually identical between the two operating systems. This 

protocol includes steps and screenshots of operating UCSF Chimera in Windows 10 

system, and MacOS Catalina-specific notes.1,2  
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1.2. The following font style key will be used throughout the exercise to describe how to 

navigate and interact with the UCSF Chimera user interface using particular keystrokes or 

menu options: 

 

Font style Meaning Example 

bold key on keyboard up arrow, ctrl, shift, enter 

italics menu bar option in UCSF Chimera Actions → Surface → show 

“quotation” on-screen window text in UCSF Chimera “minimize structure” 

underlined on-screen button in UCSF Chimera minimize 

 

1.3. There is no general-purpose undo action in UCSF Chimera.3 For example, if you delete 

atoms, they are permanently gone and can only be recovered by reading the original 

structure file back into UCSF Chimera. It is therefore recommended to save the session 

after critical steps using File → Save Session As. To reopen a saved session, use File → 

open. 

2. Selecting a starting structure for inhibitor design 

2.1. We design the cyclic peptide inhibitor based on the X-ray crystallography structure of 

SARS-CoV Mpro (C145A) [Protein Data Bank (PDB) ID: 5B6O].4 To reduce the reader's 

workload, we simplified the SARS-CoV Mpro (C145A) structure (PDB 5B6O) using UCSF 

Chimera. The simplified structure contains only the portions that are relevant to this 

chapter: the C-terminal fragment of an Mpro molecule (substrate) and the adjacent Mpro 

molecule (protein) with the active site. We named the simplified PDB file as “5B6O-S.pdb” 
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and have provided it as an additional file with the Supporting Information (SI). Readers 

are encouraged to proceed to the next section using the “5B6O-S.pdb” file.  

2.2. If you are interested in the process of simplifying the SARS-CoV Mpro (C145A) structure 

(PDB: 5B6O) using UCSF Chimera, including generating symmetry mates and deleting 

unnecessary parts, the details can be found in the appendix of the SI. 

3. Modifying the C-terminal fragment of SARS-CoV Mpro to create a cyclic peptide inhibitor  

3.1.1. Showing the substrate and the protein binding pocket  

3.1.2. Download the “5B6O-S” PDB file from the SI. 

3.1.3. Open the “5B6O-S” PDB file in UCSF Chimera. 

In the menu bar across the top of the UCSF Chimera window, click File → Open. Find the 

“5B6O-S” file, then click Open.  

3.1.4. You can use the mouse to do basic model viewer controls. 

Left mouse button (LMB): Rotate the view 

Middle mouse button (MMB): Translate the view across screen 

Right mouse button (RMB): Zoom in or out 
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3.1.5. Visualize the protein as a van der Waals surface. 

UCSF Chimera currently shows a ribbon representation of the protein. It is helpful to 

visualize the protein as a van der Waals surface in order to better interpret the shape of the 

binding pocket.  

Select any part of the protein using Ctrl+LMB. Once an atom, residue, or secondary 

structure is selected, the up and down arrow keys will change the scope of a selection (e.g., 

atom → residue → secondary structure → entire model). To select the entire protein, press 

the up arrow key twice. 
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In the menu bar, click Actions → Surface → show. 

 

3.1.6. Change the color and transparency of the protein surface. 
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Sometimes it is helpful to add transparency to the protein surface in order to see through 

protrusions in the binding pocket, change the color of the surface, and remove other 

representations of the model from view: 

Actions → Surface → transparency → 30% 

Actions → Color → Dark Grey 

Actions → Ribbon → hide 

 

 

3.1.7. Rotate and zoom in the view so the substrate and protein binding pocket are facing you.  

Use LMB to rotate the view, MMB to translate view across screen, and RMB to zoom in, 

so that the substrate and protein binding pocket are facing you.  
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3.1.8. Add hydrogens to the substrate. 

Based on the interactions between this substrate and the binding pocket, we now want to 

make some structural modifications to the substrate to create a cyclic peptide inhibitor that 

may be more conformationally rigid and resistant to proteolysis. 

In order to simplify future structural modifications, we will add hydrogens to the substrate: 

Tools → Structure Editing → AddH. 

This will open the “Add Hydrogens” window. You will notice two possible models to add 

hydrogens to, “5B6O-S.pdb (#0.1)” and “5B6O-S.pdb (#0.2).” These two models are the 

substrate and protein, respectively. 

Select “5B6O-S.pdb (#0.1)” (the substrate), then click OK. 
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3.2. Deleting unnecessary residues, bonds, and atoms from the substrate 

Constructing our inhibitor involves removing certain residues from the substrate, mutating 

others, and creating new bonds to form a macrocycle. We will begin by deleting 

unnecessary residues, bonds, and atoms. 
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3.2.1. First, we want to select Ser 301 in the substrate and delete it. There are two ways to find 

and select Ser 301 of the substrate.   

a. Hovering the mouse cursor over any atom in the structure will cause text to appear in the 

format [model number] [residue name] [residue number] [atom type]. Hover the cursor 

over the atoms of the substrate until you find Ser 301.  

 

To select Ser 301, select any atom in the Ser 301 residue using Ctrl+LMB, then use the 

up arrow key once to expand the scope of the selection from a single atom to the entire Ser 

301 residue. 
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b. In the menu bar, Favorite → sequence. The following “Show Model Sequence” window 

will show up.  

 

Highlight “5B6O-S.pdb (#0.1) chain A” only, click Show. The following “chain A: 

3CLPRO” window will show up.  



214 
 

 

Find position 301, use LMB to click and drag to highlight the letter “S” representing Ser 

301. Click Quit to close the window. 

 

In the UCSF Chimera workspace, Ser 301 is selected.  

 

After using either way to select Ser 301, to delete the selected Ser 301, use Actions → 

Atoms/Bonds → delete. 
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3.2.2. Now delete Gly 302, as above. 
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3.2.3. Delete Val 303. 
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3.2.4. Rather than deleting Thr 304 in its entirety, we will only delete part of it. We will delete 

the side chain, the alpha carbon, and the amine, but leave the amide bond between Thr 304 

and Phe 305 intact. Hover the cursor over the substrate until you find those atoms and 

bonds to delete. To select multiple atoms or bonds simultaneously, hold Shift while using 

Ctrl+LMB (i.e. Ctrl+Shift+LMB). 
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As before, delete this selection using Actions → Atoms/Bonds → delete. 

If there are any leftover atoms/bonds that you did not select the first time, use 

Ctrl+Shift+LMB to select them and delete. Now only the amide bond of Thr 304 remains. 

  

3.2.5. Delete Lys 310 (the entire residue). 
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3.2.6. Delete the carbonyl of Phe 309. Use Ctrl+Shift+LMB to select the carbonyl oxygen, 

carbon-oxygen bond, carbonyl carbon, and carbon-carbon bond then Actions → 

Atoms/Bonds → delete. 
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3.3. Mutating Phe 309 to [4-(2-aminoethyl)phenyl]-acetic acid (AEPA) 

Our inhibitor design involves a mutation of Phe 309 to [4-(2-aminoethyl)phenyl]-acetic 

acid (AEPA) in order to form a macrocycle with the remaining amide bond of Thr 304. 

This starts by adding a new tetrahedral methyl group (CH3) to Phe 309 in the para position. 

Select the para hydrogen using Ctrl+LMB. 



221 
 

 

Tools → Structure Editing → Build Structure will open the “Build Structure” window.  

 

This window has multiple tabs for making structural modifications to atoms and bonds. 

These tabs can be navigated using the drop-down menu at the top-middle of the window; 

the initial tab is “Start Structure.” Navigate to the tab called “Modify Structure.” The 

window will change to show new options. 
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This window will allow you to modify selected atoms. (Keep this window open throughout 

the building process, or you will have to reopen it.) Currently, the para hydrogen of Phe 

309 is selected, and we want to change it to a tetrahedral methyl group (CH3). Under the 

heading “Change selected atoms to…”, make sure that the “Element,” “Bonds,” and 

“Geometry” options read “C,” “4,” and “tetrahedral,” respectively. Click Apply to make 

the indicated change. 

Note that under the header “Residue Name,” the radio button labeled “Change modified 

residue’s name to [UNK]” is selected. Because this is selected, when you changed the para 

hydrogen to a methyl, it also renamed Phe 309 to UNK 309. This is important for the 

upcoming minimization, and the reason why will be explained later. 
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Note that the new carbon is grey while the other carbons in the molecules remain tan. We 

want the color of the new carbon to be consistent with the rest of the substrate. Open the 

“Color Actions” window using: 

Actions → Color → all options. 

The grey carbon is already selected from the previous step; to change it to tan, check the 

box next to “Show all colors→” and click tan. Close the “Color Actions” window. 
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3.4. Creating a new bond to make the substrate a cyclic peptide 

Now we want to form a bond between the carbonyl carbon of Thr 304 and the newly built 

methyl carbon to make this substrate a macrocycle. To do so, we first have to make room 

on the newly built methyl group (CH3) by deleting one hydrogen. Clear the selection using 

Select → Clear Selection 

Simultaneously select one of the methyl hydrogens as well as its corresponding carbon-

hydrogen bond using Ctrl+Shift+LMB, then delete that selection using Actions → 

Atoms/Bonds → delete. The methyl group (CH3) becomes a methylene (CH2) group. 
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To form a bond between the Thr 304 carbonyl carbon and the newly built methylene (CH2) 

group carbon, we must rotate some bonds to put the atoms to be bonded into closer 

proximity. When the new bond is formed, it must not cross other atoms or bonds. Crossing 

other atoms or bonds will cause the later minimization to fail. 

Select the backbone Cα-N bond of Gln 306 using Ctrl+LMB. 
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In the currently open “Build Structure” window, change from the “Modify Structure” tab 

to the “Adjust Torsions” tab. As the relevant bond in Gln 306 is already selected, click 

Activate to make it rotatable and bring up options for changing the bond torsion. 

The bond can be rotated in three ways: 

a. Entering a new angle value and pressing Enter 

b. Clicking the arrow buttons to the left and right of the angle value 

c. Clicking and dragging the circular dial  

Using the method of your choice, rotate the bond so the carbonyl carbon and the newly 

built methylene (CH2) group carbon are as close to one another as possible. The goal is for 

there to be no intersections once a new bond is formed between these two atoms. In this 

case, we click the arrow button to the left of the angle value until the angle value shows -

109.0. 
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After you are done rotating, deactivate the bond torsion. To do so, click on #0.1 GLN 306.A 

CA -> N button and under the drop-down menu select Deactivate. 

 

Now we want to build a C-C bond between the Thr 304 carbonyl carbon and the newly 

built methylene (CH2) group carbon to cyclize the substrate. Select → Clear Selection. Use 
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Ctrl+Shift+LMB to simultaneously select both the carbonyl carbon of Thr 304 and the 

CH2 carbon. 

 

In the currently open “Build Structure” window, change from the Adjust Torsions tab to 

the Adjust Bonds tab. Find the drop-down menu that says reasonable and change it to all 

possible. Because the selected carbon atoms are more than 1.5 Angstroms apart, the bond 

we are about to create is not ‘reasonable;’ however, the upcoming minimization will correct 

the bond length and make it reasonable. Click Add to form this new bond. Again check to 

make sure that this new bond is not crossing other atoms or bonds. 
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3.5. Renaming Thr 304 
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The last step we do before conducting structural minimization of the cyclic peptide 

inhibitor is renaming Thr 304. The minimization method we select in this chapter is the 

AMBER* force field, which is pre-programmed to recognize the canonical amino acids. 

However, if a modified amino acid has the name of a canonical amino acid, the force field 

will not recognize it and the minimization will fail. Thr 304 is no longer intact after we 

have deleted parts of it. We have to rename it so that the force field will treat it as a new 

object. The previously modified Phe 309 has already been renamed as “UNK” by UCSF 

Chimera when we were adding a methyl group to it, so we rename the modified Thr 304 

as “UK2” using the command line. To open the command line: 

Tools → General Controls → Command Line 

In the command line, type: 

setattr r type UK2 :304.A 

Then press Enter. 

“setattr” stands for “Set Attribute.” “r” means “residue,” “type” refers to the residue name, 

“UK2” is the new residue name, and “:304.A” is residue 304 on chain A (the “chain” is 

derived from the original PDB file). 

Hover the cursor over Thr 304 to confirm that the name has been changed to “UK2.” 
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4. Geometry optimization of the cyclic peptide inhibitor 

Since the bond lengths, angles, and dihedral angles of the newly built cyclic peptide are 

not optimal, we want to perform geometry optimization (structural minimization) to clean 

up the structure. 

4.1. Changing the VDW radii used to create the surface 

When minimizing, UCSF Chimera will be adding hydrogen atoms to both the cyclic 

peptide inhibitor as well as the protein. When hydrogens are added to a protein displayed 

in a surface representation, the following error message often pops up reflecting numerical 

failure of the embedded MSMS code in UCSF Chimera:5 
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To avoid this error message, before adding hydrogens to the protein, we will slightly 

increase the van der Waals radii of all atoms. To do so: 

Select → Clear Selection 

Ctrl+LMB on any part of the surface to select the protein (you will see a green outline 

when the protein is selected). 
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In the currently open command line at the bottom of the workspace, type "vdwdefine +.05", 

then press Enter.5  
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4.2. Minimize the cyclic peptide inhibitor while fixing the protein 

We want to fix the protein and allow the cyclic peptide inhibitor to move freely during 

minimization. To do so: 

Select → Clear Selection 

Ctrl+LMB on any part of the cyclic peptide inhibitor, then press the up arrow key twice 

to select the entire cyclic peptide inhibitor.  

 

Open the “Minimize Structure” window using: 

Tools → Structure Editing → Minimize Structure 

The following window will appear. Make sure that both “5B6O-S.pdb (#0.1)” and “5B6O-

S.pdb (#0.2)” are highlighted so both the cyclic peptide inhibitor and the protein will be 

included in the minimization process. 
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Under the drop-down menu “Fixed atoms”, change from “none” to “unselected.” Doing so 

will fix the protein and allow the cyclic peptide inhibitor to move freely during 

minimization. 

Select the radio button for “Neither memorize nor use memorized options” to prevent 

accidentally changing the upcoming minimization options. 

 

Click Minimize. The “Dock Prep” window will appear. Make sure that both “5B6O-S.pdb 

(#0.1)” and “5B6O-S.pdb (#0.2)” are highlighted, but leave the other settings as their 

defaults.6  
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Click OK. The “Add Hydrogens for Dock Prep” window will appear. As before, make sure 

that both “5B6O-S.pdb (#0.1)” and “5B6O-S.pdb (#0.2)” are highlighted, but leave the 

other settings as their defaults. 
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Click OK. Hydrogens have now been added to both the protein and the substrate. Note 

some of the newly added hydrogens on the substrate are not selected. In the UCSF Chimera 

window, press up arrow once to select the entire cyclic peptide substrate. In the “Assign 

Charges for Dock Prep” window, make sure that both “5B6O-S.pdb (#0.1)” and “5B6O-

S.pdb (#0.2)” are highlighted, but leave the other settings as their defaults.  

 

 

Click OK. The “Specify Net Charges” window will appear. The non-canonical amino acids 

UNK and UK2 that we built are not charged, so we use the default setting of net charge = 

0. Leave the charge method as default: AM1-BCC.7 
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The following figure illustrates the cyclic peptide inhibitor structure before minimization. 

 

Click OK in the “Specify Net Charges” window, and the minimization process will proceed 

in two steps: The first is “Steepest Descent”, during which you will be able to see subtle 

movements of the cyclic peptide inhibitor in increments of 10 steps. The second is 

“Conjugate Gradient”, which takes longer than “Steepest Descent”. “Finished 10 of 10 
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conjugate gradient minimization steps” will show at the bottom when the minimization is 

finished. The minimization should be complete in 2-5 minutes. 

 

4.3. Mutating Gly 307 to Ser 307 

We want to mutate Gly 307 to Ser to make the cyclic peptide inhibitor less flexible (i.e. 

more conformationally rigid). To do so, in the currently open command line at the bottom 

of the window, type 

swapaa ser :307.a 

Then press Enter. 

Gly 307 has now been mutated to Ser, and the name of that residue has also been changed 

to “Ser 307”. 
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4.4. The second-round of minimization after mutating Gly 307 to Ser 307 

The side chain of Ser 307 is not selected. Press up arrow once to select the entire cyclic 

peptide inhibitor including the side chain of Ser 307. 
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Open the “Minimize Structure” window using Tools → Structure Editing →  Minimize 

Structure. 

The following window will appear. Make sure that both “5B6O-S.pdb (#0.1)” and “5B6O-

S.pdb (#0.2)” are highlighted so both the cyclic peptide inhibitor and the protein will be 

included in the minimization processes. 

Under the drop-down menu “Fixed atoms”, change from “none” to “unselected.” This way 

we fix the protein and allow the cyclic peptide inhibitor to move freely during 

minimization. 

Select the radio button for “Neither memorize nor use memorized options” to prevent 

accidentally changing the upcoming minimization options. 
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Click Minimize. The “Dock Prep” window will appear. Make sure that both “5B6O-S.pdb 

(#0.1)” and “5B6O-S.pdb (#0.2)” are highlighted, but leave the other settings as their 

defaults.6  

 

Click OK. The “Add Hydrogens for Dock Prep” window will appear. As before, make sure 

that both “5B6O-S.pdb (#0.1)” and “5B6O-S.pdb (#0.2)” are highlighted, but leave the 

other settings as their defaults. 
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Click OK. Hydrogens have now been added to both the protein and the ligand.  

 

The hydrogens that just added to Ser 307 are not selected. Press up arrow once to select 

the entire cyclic peptide inhibitor including the hydrogens that was just added to Ser 307. 
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The “Assign Charges for Dock Prep” window will appear. Again, make sure that both 

“5B6O-S.pdb (#0.1)” and “5B6O-S.pdb (#0.2)” are highlighted, but leave the other settings 

as their defaults. 

 

Click OK. The “Specify Net Charges” window will appear. The non-canonical amino acids 

UNK and UK2 are not charged, so we use the default setting of net charge = 0. Leave the 

charge method as default: AM1-BCC.7 
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The following figure illustrates the cyclic peptide inhibitor structure before minimization. 

 

Click OK in the “Specify Net Charges” window, and the minimization process will proceed 

in two steps: The first is “Steepest Descent”, during which you will be able to see subtle 

movements of the cyclic peptide inhibitor in increments of 10 steps. The second is 

“Conjugate Gradient”, which takes longer than “Steepest Descent”. “Finished 10 of 10 

conjugate gradient minimization steps” will show at the bottom when the minimization is 

finished. The minimization should be complete in 2-5 minutes. 
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5. Docking the inhibitor to SARS-CoV Mpro  

To evaluate the ability of the minimized cyclic peptide inhibitor binds to the SARS-CoV 

Mpro, we will dock the cyclic peptide inhibitor to the SARS-CoV Mpro structure (5B6O-

S.pdb) using the AutoDock Vina plugin in UCSF Chimera.8–10 

5.1. Saving the cyclic peptide inhibitor and the protein as separate PDB files  

This step follows the “4. geometry optimization of the cyclic peptide inhibitor” section. 

We want to save the cyclic peptide inhibitor and the protein as separate PDB files for 

AutoDock Vina to perform molecular docking. 

To save the cyclic peptide inhibitor as a PDB file, we first make sure the cyclic peptide 

inhibitor is selected. Then in the menu bar, select File → Save PDB. In the pop-up window, 

select save models “5B6O-S.pdb (#0.1)”, select “save selected atoms only”, select “save 

relative to model “5B6O-S.pdb (#0.1)”, give a valid file name (example “ligand”) and click 

save. 
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To save the protein (SARS-CoV Mpro) as a PDB file: 

Select → invert (all models); actions → surface → hide; actions → atoms/bonds → show 

 

File → Save PDB; select save models “5B6O-S.pdb (#0.2)”, select “save selected atoms 

only”, select “save relative to model “5B6O-S.pdb (#0.2)”, give a valid file name (example 

“protein”), click save. 
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5.2. Installing AutoDock Vina and creating a folder for docking files 

5.2.1. Download and install AutoDock Vina (http://vina.scripps.edu/download.html). 

5.2.2. Create a new folder on your desktop or a location you prefer and call it “docking” or a 

name you prefer. 

5.2.3. Copy and paste both the ligand.pdb and protein.pdb that you just saved in the folder that 

you created on the desktop. Additionally, copy and paste vina.exe in this folder; Vina.exe 

can be found in your Program Files (X86) in the folder called “The Scripps Research 

Institute”. 

For MacOS users, copy and paste vina linux executable file in this folder that you created 

on the desktop. The AutoDock Vina Unix executable file is located in the extracted folder 

that you downloaded from the AutoDock Vina website. Note for MacOS users: this may 

not happen to all MacOS users, but you might have to unlock permissions to run the 

AutoDock Vina Unix executable file. To do this, double click the Unix executable file, and 
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a pop-up window may show up stating that the software could be malware. If this window 

pops up, click on the “?” button, and then a help guide should load up. Click on the blue 

link and it should bring you to Security and Privacy preferences. Unlock permissions by 

entering your password to enable AutoDock Vina. 

5.3. Opening the saved ligand and protein PDB files in the same view 

File → close session to close the current session in UCSF Chimera (make sure that you 

have saved the important sessions).  

File → Open, find the protein.pdb file from the docking folder on your desktop and click 

open. 

File → Open, find the ligand.pdb file from the docking folder on your desktop and click 

open.  
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5.4. Highlighting the active site of the protein 

Select the protein by Ctrl+LMB any part of the protein, press up arrow twice.  

 

We want to change the preset to “stick” so we can locate the active site (binding pocket) 

easier. Actions → Ribbon → Hide; Actions → Atoms/Bonds → stick; Actions → 

Atoms/bonds → show 
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Actions → color → dark grey; Select → clear selection.  

 

Locate the active site in the protein. It can most easily be found by looking for several 

residues in the active site, such as Cys 44, Cys 38, Met 49, Met 165, His 41. For example, 

to find Met 165, Favorite → sequence. The following “Show Model Sequence” window 

will show up.  
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Highlight “protein 07072020.pdb (#0) chain A” only, click Show. The following “chain A: 

3CLPRO” window will show up.  

 

Find position 165, use LMB to click and drag to highlight the letter “M” representing Met 

165. Click Quit to close the window. 

 

In the UCSF Chimera workspace, Met 165 is selected.  

 

To color Met 165 in red, Actions → color → red.  
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Repeat the steps for Cys 44, Cys 38, Met 49, His 41. After that, select → clear selection. 

 

After highlighting several residues in the active site, we can show the protein as a van der 

Waals surface in order to better visualize the binding pockets in the active site. Ctrl+LMB 

on any part of the protein, press up arrow three times, actions → surface → show; actions 

→ atoms/bonds → hide; actions → surface → transparency → 30%.  
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5.5. Running AutoDock Vina  

Tools → Surface/Binding Analysis → AutoDock Vina (a new window will pop up).  
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Click on Browse next to “Output file” and find the folder that you created on the desktop. 

Under file name type “docking” or a name you prefer and press enter on your keyboard. 

 

Select “protein.pdb” as the receptor and select “ligand.pdb” as the ligand. 
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You will now have to define the receptor search grid box (area where docking will be done) 

by typing in certain numbers in “Center” and “Size”. You have to play around with this so 

that your box engulfs all of the active site. The box must encompass all of the active site, 

but must not exceed 30 Å on an edge. You can also try to maneuver the box with your 

mouse by selecting the “Resize search volume using” and then selecting the mouse button 

that you want to use. Start off by typing 1, 1, 1 (x, y, z coordinates) for the center, and 30, 

30, 30 (Å) for the size. Then, reposition the box so that the active site residues (Cys 44, 

Cys 38, Met 49, Met 165, His 41; colored in red) are in the center of the box. Do not make 

the box larger than 30, 30, 30. Rotate around to make sure the box is covering the active 

site. In this case, we use 42, 20, 12 for the center and 30, 30, 30 for the size. 

  

Once you have the receptor search grid box with appropriate size and position, you have 

to check that everything is set up for docking. Click on “Receptor options” and make sure 

that all of the options are set to “true” except for “Ignore chains of non-standard residues” 

and “Ignore all non-standard residues” which should be set to “false”.  
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Click on “ligand options” and make sure that both options are set to “true”.  

Click on “Advanced options” and make sure that the “Number of binding modes” is set to 

10 (this is the maximum number of outputs that you will get per docking), “Exhaustiveness 

of search” is set to 8 (this determines how much of your CPU will be used and how good 

the search will be), and the “Maximum energy difference (kcal/mol) is set to 3.  

Under “Executable location”, select “Local”, click Browse, and find the location of 

vina.exe in the folder that you created on the desktop. 

 

Click OK and wait. “Running” will show at the bottom. The docking will take 

approximately 2 minutes. Once the docking is done a new window will pop up called 

“ViewDock” and it will allow you to examine all of your docked structures. A 

“docking.pdbqt” file containing all of the docking results will be generated in your folder 

on the desktop. 
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5.6. Viewing the docking results  

Rotate until you find the binding pocket with key residues in red. You should find the 

docked cyclic peptide inhibitor (green) with the lowest energy structure (#3.1) falls into 

the binding pocket. 
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Ctrl+LMB on any part of the undocked inhibitor (blue), press up arrow twice; actions → 

atoms/bonds → hide. 

 

Note that in the docked inhibitor (green), the previously built C-C bond is missing. The 

docked ligand is created by reading the AutoDock Vina output, and that output is missing 

the ring-closing bond.10 You can easily re-establish the bond with the following command: 

Tools → general control → command line 

In the command line, type: 

 bond #3.1:304@c:309@c1 

Press Enter 
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For other structures, use “bond #3.2:304@c:309@c1”, “bond #3.3:304@c:309@c1”, etc., 

to fix the missing bond issue. 

To better view the lowest energy structure of the docked inhibitor (#3.1), we want to add 

hydrogens back to it. To do so, Ctrl+LMB on any part of the docked inhibitor, press up 

arrow twice. Tools → Structure Editing → AddH. 

The “Add Hydrogens” window will appear. Make sure the lowest energy structure “docked 

ligand.pdb (#3.1)” is highlighted, and leave the other settings as their defaults. Click OK.  



261 
 

 

 

Select → clear selection. Use LMB to rotate view, MMB to translate view across screen, 

and RMB to zoom in.  
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6. Docking the inhibitor to SARS-CoV-2 Mpro  

To evaluate the ability of the minimized cyclic peptide inhibitor binds to the 

SARS-CoV-2 Mpro, we will dock the cyclic peptide inhibitor to the SARS-

CoV-2 Mpro structure (PDB ID: 6YB7) using the AutoDock Vina plugin in 

UCSF Chimera.8–11 

6.1. Saving the cyclic peptide inhibitor as a PDB file  

This step follows the “4. geometry optimization of the cyclic peptide 

inhibitor” section. 

To save the cyclic peptide inhibitor as a PDB file, we first make sure the cyclic peptide 

inhibitor is selected. Then in the menu bar, select File → Save PDB. In the pop-up window, 
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select save models “5B6O-S.pdb (#0.1)”, select “save selected atoms only”, select “save 

relative to model “5B6O-S.pdb (#0.1)”, give a valid file name (example “ligand”) and click 

save. 

 

6.2. Loading and modifying the SARS-COV-2 Mpro structure  

File → close session to close the current session in UCSF Chimera (make sure that you 

have saved the important sessions).  

Protein X-ray crystallographic structure files can be retrieved from Protein Data Bank 

(PDB) and opened in UCSF Chimera with the “Fetch by ID” function. In the menu bar, 

select File → fetch by ID → select “PDB” → type in “6YB7” → click Fetch.11 
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We want to delete the solvents (water, DMSO) in SARS-COV-2 Mpro structure (PDB 

6YB7) as they are not necessary in the molecular docking process. Ctrl+LMB on any part 

of the protein, press up arrow twice to select the protein. 

 

Select → invert (all models) 
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 Actions → atoms/bond → delete 

 

Now we want to save the solvent-deleted PDB file. File → save PDB; give a valid file 

name (example “protein”), click save. 
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6.3. Installing AutoDock Vina and creating a folder for docking files  

6.3.1. Download and install AutoDock Vina (http://vina.scripps.edu/download.html). 

6.3.2. Create a new folder on your desktop or a location you prefer and call it “docking” or a 

name you prefer. 

6.3.3. Copy and paste both the ligand.pdb and protein.pdb that you just saved in the folder that 

you created on the desktop. Additionally, copy and paste vina.exe in this folder; Vina.exe 

can be found in your Program Files (X86) in the folder called “The Scripps Research 

Institute”. 

For MacOS users, copy and paste vina linux executable file in this folder that you created 

on the desktop. The AutoDock Vina Unix executable file is located in the extracted folder 

that you downloaded from the AutoDock Vina website. Note for MacOS users: this may 

not happen to all MacOS users, but you might have to unlock permissions to run the 

AutoDock Vina Unix executable file. To do this, double click the Unix executable file, and 

a pop-up window may show up stating that the software could be malware. If this window 
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pops up, click on the “?” button, and then a help guide should load up. Click on the blue 

link and it should bring you to Security and Privacy preferences. Unlock permissions by 

entering your password to enable AutoDock Vina. 

6.4. Opening the saved ligand and protein PDB files in the same view 

File → close session to close the current session in UCSF Chimera (make sure that you 

have saved the important sessions). 

File → Open, find the protein.pdb file from the docking folder on your desktop and click 

open. 

File → Open, find the ligand.pdb file from the docking folder on your desktop and click 

open.   

 

6.5. Highlighting the active site of the protein 

Select the protein by Ctrl+LMB any part of the protein, press up arrow twice.  
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We want to change the preset to “stick” so we can locate the active site (binding pocket) 

easier. Actions → Ribbon → Hide; Actions → Atoms/Bonds → stick; Actions → 

Atoms/bonds → show 

 

Actions → color → dark grey; Select → clear selection.  
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Locate the active site in the protein. It can most easily be found by looking for several 

residues in the active site, such as Cys 145, Met 165, His 164. For example, to find Met 

165, Favorite → sequence. The following “Show Model Sequence” window will show up. 

 

Highlight “protein-2 07092020.pdb (#0) chain A” only, click Show. The following “chain 

A: replicase polyprotein 1AB” window will show up.  
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Find position 165, use LMB to click and drag to highlight the letter “M” representing Met 

165. Click Quit to close the window. 

 

In the UCSF Chimera workspace, Met 165 is selected. 

 

To color Met 165 in red, Actions → color → red.  
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Repeat the steps for His 164 and Cys 145. After that, select → clear selection. 

 

After highlighting several residues in the active site, we can show the protein as a van der 

Waals surface in order to better visualize the binding pockets in the active site. Ctrl+LMB 

on any part of the protein, press up arrow three times to select the entire protein, actions 
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→ surface → show; actions → atoms/bonds → hide; actions → surface → transparency 

→ 30%.  

 

6.6. Running AutoDock Vina 

Tools → Surface/Binding Analysis → AutoDock Vina (a new window will pop up).  
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Click on Browse next to “Output file” and find the folder that you created on the desktop. 

Under file name type “docking” or a name you presser and press enter on your keyboard. 

 

Select “protein.pdb” as the receptor and select “ligand.pdb” as the ligand. 
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You will now have to define the receptor search grid box (area where docking will be done) 

by typing in certain numbers in “Center” and “Size”. You have to play around with this so 

that your box engulfs all of the active site. The box must encompass all of the active site, 

but must not exceed 30 Å on an edge. You can also try to maneuver the box with your 

mouse by selecting the “Resize search volume using” and then selecting the mouse button 

that you want to use. Start off by typing 1, 1, 1 (x, y, z coordinates) for the center, and 30, 

30, 30 (Å) for the size. Then, reposition the box so that the active site residues (Cys 145, 

Met 165, His 164; colored in red) are in the center of the box. Do not make the box larger 

than 30, 30, 30. Rotate around to make sure the box is covering the active site. In this case, 

we use 13, 4, 18 for the center and 30, 30, 30 for the size. 
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Once you have the box of the size and position that you would like you have to check that 

everything is set up for docking. Click on “Receptor options” and make sure that all of the 

options are set to “true” except for “Ignore chains of non-standard residues” and “Ignore 

all non-standard residues” which should be set to “false”.  

Click on “ligand options” and make sure that both options are set to “true”.  

Click on “Advanced options” and make sure that the “Number of binding modes” is set to 

10 (this is the maximum number of outputs that you will get per docking), “Exhaustiveness 

of search” is set to 8 (this determines how much of your CPU will be used and how good 

the search will be), and the “Maximum energy difference (kcal/mol) is set to 3.  

Under “Executable location”, select “Local”, click Browse, and find the location of 

vina.exe in the folder that you created on the desktop. 
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Click OK and wait. “Running” will show at the bottom. The docking will take 

approximately 3 minutes. Once the docking is done a new window will pop up called 

“ViewDock” and it will allow you to examine all of your docked structures. A 

“docking.pdbqt” file containing all of the docking results will be generated in your folder 

on the desktop. 
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6.7. Viewing the docking results  

Rotate until you find the binding pocket with key residues in red. You should find the 

docked cyclic peptide inhibitor (green) with the second lowest energy (#3.2) falls into the 

binding pocket. (Alternatively, it may be the lowest energy structure, depending on how 

the docking was performed.) 

Ctrl+LMB on any part of the undocked inhibitor (blue), press up arrow twice; actions → 

atoms/bonds → hide. 

 

Note that in the green inhibitor (docked inhibitor), the previously built C-C bond is missing. 

The docked ligand is created by reading the AutoDock Vina output, and that output is 

missing the ring-closing bond.10 You can easily re-establish the bond with the following 

command: 

Tools → general control → command line 

In the command line, type: 



279 
 

 bond #3.2:304@c:309@c1 

Press Enter 

 

For other structures, use “bond #3.3:304@c:309@c1”, “bond #3.4:304@c:309@c1”, etc., 

to fix the missing bond issue. 

To better view the second lowest energy structure of the docked inhibitor (#3.2), we want 

to add hydrogens back to it. To do so, Ctrl+LMB on any part of the docked inhibitor, press 

up arrow twice. Tools → Structure Editing → AddH. 

The “Add Hydrogens” window will appear. Make sure the docked inhibitor structure with 

the second lowest energy structure “docked ligand.pdb (#3.2)” is highlighted, and leave the 

other settings as their defaults. Click OK.  
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Select → clear selection. Use LMB to rotate view, MMB to translate view across screen, 

and RMB to zoom in.  
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7. Appendix: Generating a structure of SARS-CoV Mpro bound to the C-terminal 

substrate (5B6O-S.pdb) 

In this appendix, we will generate a structure of SARS-CoV Mpro bound to the C-terminal 

fragment of an Mpro molecule within the active site. We have already provided this file as 

“5B6O-S.pdb” as a separate Supporting Information document. Here we will go through 

the operations needed to generate 5B6O-S.pdb file from the publicly available PDB file 

5B6O.  

7.1. Loading the SARS-CoV Mpro crystal structure in UCSF Chimera 

Protein X-ray crystallographic structure files can be retrieved from Protein Data Bank 

(PDB) and opened in UCSF Chimera with the “Fetch by ID” function. In the menu bar, 

select File → fetch by ID → select “PDB” → type in “5B6O” → click fetch 
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7.2. Generating symmetry mates in the crystal lattice 

To visualize how the C-terminal fragment (substrate) interacts with the active site of the 

Mpro, we have to generate the symmetry mates in the crystal lattice. Doing so will allow us 

to see the C-terminal part of one Mpro molecule extending into the active site of another 

Mpro molecule in the adjacent asymmetric unit.  

To do so, Tools → Higher-order structure → unit cell. A window will pop up: click options 

→ check "use crystal symmetries from file" → uncheck "use space group if symmetries 

are missing", "use non-crystallographic symmetry", and "pack molecules in unit cell" → 

click make copies.  
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7.3. Deleting unnecessary parts 

Close the “unit cell” window. Now we can see the C-terminus of the newly generated blue 

dimer extends into the binding pocket of the newly generated green dimer. To make the 

subsequent minimization and docking steps easier, we will only use the monomer of the 

green dimer containing the binding pocket and the C-terminus of the blue dimer in the 

exercise.  

To delete the tan dimer, we Ctrl+LMB on any part of the tan dimer, press up arrow four 

times. Now we selected the tan dimer. 
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Actions → atoms/bonds → delete. Now we have deleted the selected tan dimer.  



287 
 

 

To delete the pink dimer, we Ctrl+LMB on any part of the pink dimer, press up arrow four 

times. Now we selected the pink dimer. Actions → atoms/bonds → delete. 

To delete the monomer of the green dimer that does not interact with the blue dimer, we 

Ctrl+LMB on any part of the monomer of the green dimer that does not interact with the 

blue dimer, press up arrow twice. Now we selected the monomer of the green dimer that 

does not interact with the blue dimer. Actions → atoms/bonds → delete. 

Now we want to keep the C-terminus substrate of the blue dimer and delete the rest parts 

of the blue dimer. First, we select the substrate. To select the substrate, find C-terminal 

lysine 310 on the blue dimer, Ctrl+LMB on the terminal Nitrogen, press up arrow once. 
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Select → invert (selected models). This way you selected the non-substrate part of the blue 

dimer. 
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Actions → atoms/bonds → delete. 
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Now we should only have the monomer of the green dimer containing the binding pocket 

and C-terminal substrate of the blue dimer left. We can see the C-terminus of the blue 

dimer is interacting with the binding pocket of the green monomer. 

7.4. Saving the modified PDB file 

File → save PDB → select “save multiple models in a single file” → give the PDB file a 

valid file name (e.g., 5B6O-S) → save 
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